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Style conventions used in this document:

Ul Text: Text that represents elements of the Ul such as button names, menu
options etc. is presented with a grey background and border, in Tahoma
font which is traditionally used in Windows Uls. For example:

Ok

Standard Terms (Jargon): Text that is not English Language but instead refers to
industry standard concepts such as Strategy, BACnet, or Analog Input is
represents in slightly condensed font. For example:

BACnet

Code: Text that represents File paths, Code snippets or text file configuration
settings is presented in fixed-width font, with a grey background and
border. For example:

$config file = c:\CYLON\settings\config.txt

Parameter values: Text that represents values to be entered into Ul fields or
displayed in dialogs is represented in fixed-width font with a shaded
background. For example

10°C

Product Names: Text that represents a product name is represented in bold
colored text. For example

INTEGRA™

Company Brand names: Brands that are not product names are represented by
bold slightly compressed text:

ABB Active Energy

PC Keyboard keys: Text representing an instruction to press a particular key on
the keyboard is enclosed in square brackets and in bold font. For
example:

[Ctri]+[1]
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ABB Cylon® Building Management System

The ABB Cylon® BACnet Building Management System is made up of several components, which fall into two
main categories:

e Hardware - the products that monitor and control a building's environment.
e Software - the interface which allows users to configure and monitor ABB Cylon® Hardware.

HARDWARE COMPONENTS

ABB Cylon® BACnet uses the following main hardware components:
e Routers.

e |/0O Field Controllers.

e Keypad

e PC

There may also be other supplementary hardware components such as printers, modems, pagers, etc., but
these are not essential to the basic system.

ROUTERS

CBR devices route communications between BACnet IP and BACnet MS/TP networks.

Aspect® MATRIX Series and NEXUS Series devices are programmable communications controllers, which
provide supervision of ABB Cylon® BACnet networks and route communications between BACnet IP and
BACnet MS/TP networks.

3rd-party BACnet Routers can also be used with the ABB Cylon® BACnet system.
1/0O FIELD CONTROLLERS

CBM and CBT Field Controllers take inputs from sensors and Building Control plant and send output to
Building Control plant in response. They are available as programmable or unitary controllers, with various
input/output configurations.

These 1/0 controllers can be programmed with strategies, which configure them to send specific outputs to
connected devices in response to events occurring on their inputs. For example, you can create a Strategy in
CXprotP and download it to a Field Controller specifying that a valve is opened if the temperature being input
to the controller rises above a predetermined level.

ABB Cylon® Field controllers are networked together using RS485 by BACnet Routers, which in turn are
networked by Ethernet. A Field Controller can also be linked directly to a PC, as well as to a modem or a
printer.

PC

The PCis connected to an ABB Cylon® network by Ethernet, RS232, or modem connection. The PC can also be
connected directly to a Field Controller for small installations with stand-alone controllers.

CXprotD software - which is used to configure the controllers, schedule events, and extract reports - is run on
the PC., which must have Windows 10 Professional 64-bit and Windows 7 Professional / Enterprise / Ultimate
64-bit installed and running.

The minimum configuration to run this application is: Core 2 Duo E6300, 1Gb RAM, 80Gb hard drive.
The recommended configuration is: Core 2 Duo E6600, 2Gb RAM, 160Gb hard drive.

CONNECTIONS BETWEEN HARDWARE COMPONENTS

The following types of connections exist between the hardware components:

e Fast Ethernet bus connecting CBR routers and Aspect® devices with the CXproHP PC.

e AnRS485 fieldbus, using shielded twisted pair cables, connecting the BACnet Router to the I/O
controllers.
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SOFTWARE COMPONENTS

The CXprotD suite of software applications is used to set up, maintain, and control the ABB Cylon® system in
operation.

CXPROHD MODULES

The following applications are available from CXproHP group in the Windows Start menu:

Database Interface

The Database Interface program allows you access to the database that contains details of all the point
values on each Field Controller in the network. You can set point values graphically in CXprotP, or you can
enter or delete them in the Database Interface program.

Datalog Manager

A datalog in CXprotP logs the value of a specified point in a Field Controller at a specified interval so that
it contains a record of the changes in that point value over a period of time. The Datalog Manager
program allows you to display the contents of a datalog in either graphic or tabular form. (see also
MANO136 Datalog Manager User's Guide)

Engineering Tool

CXprotD is a graphical interface created for programming the ABB Cylon® product range. In CXprotD,
strategies (which tell a controller how its outputs should respond to conditions on its inputs) can be
designed, edited and downloaded to, or uploaded from, Field Controllers. CXpro could be described as
the most important of all the ABB Cylon® applications, as it is the application that programs the ABB
Cylon® controllers. This manual describes how to carry out a variety of tasks in CXproHP.

Manage Software Licence

Site Organiser

The Site Organiser is an easy way to configure and examine a complete site or part of a site. Instead of
downloading strategies individually to all the controllers on a site, this can be done in one simple task.
Any combination of strategies can be downloaded to any combination of controllers or to one type of
controller in a .ins batch file. (See also MANO135 Site Organiser manual)

Start CXprotP
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CXPROHD — OVERVIEW

CXprotD provides all of the tools required to design, configure, test, commission, and maintain ABB Cylon®
BACnet systems automatically.

You can use CXprotP to:

e Graphically create strategies that implement solutions to conditions on site.

e Save those strategies for future editing, testing, or reference.

e Test the operation of strategies.

e Debug and edit strategies.

e Download strategies to the appropriate controllers.

e Define and assign 3rd party blocks to carry data across a Fieldbus.

e Define and assign wide 3rd party blocks to carry data between Fieldbusses and across the network of a
site.

e Upload existing strategies from controllers.

e Upload analog and digital point values from controllers.

e Upload statistical and reference information from controllers.

e Record changes that occur on a site as they happen and save the record to a file.
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CXproHP | Basic tasks

Basic tasks
STARTING CXPROHD

Open the CXprotP section on the Windows Start menu or start screen, or search for “CXproH” in the Application
search box.

Click on the Start CXprotP icon. The CXproP interface will open:

Quick-Access Toolbar {F[pEE TSP = B
®

[0 e O G CdDs
Configuration Database Datalog Site Backup MEBE-Pro

Interface Manager Organiser
Utilities

2o BACnet IP

To BACnet Serial

Io Sample Apps BACnet

£ 5B 001 - Wet Systems
E, 1111 - CT Single P
@, 1112 - CT Single P
S, 1113 - CT Single P

Right-Hand Pane
For Modules, Module Properties,
Page Navigation etc.

@,, 1114 - CT Dual Pui
@,, 1115 - CT Dual Pui
@,, 1116 - CT Dual Pul
=, 1121 - VT Single Py
&=, 1122 - VT Single P
@,, 1123 - VT Single P
@# 1124 - VT Dual Pur
@,, 1125 - VT Dual Pur
-, 1126 - VT Dual Pur
-2, 1131 - Four Bailers
&%, 1132 - Four Boilers
B, 1133 - Two Boilers
=), 1134 - Four Boilers
=, 1135 - Four Boilers
E,, 1136 - Two Boilers v

Rl aaa4 Gwase s o

< I 3

Connected to: Sample Apps BACnet (3), R R .l R ,

If other ABB Cylon® Engineering Software, e.g. CEC7 is installed on the same PC, then instead of the
CXproHP interface opening directly, a “Chooser” dialog opens first allowing the user to select the software
to be opened.
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THE CXPROHD INTERFACE

The CXprotP User Interface consists of the following sections:

THE SITE LIST -
o) Sites 2]
25 BACnet P
-5 001 - Metwork
.. B0 001 - 001 - UCU3Z
-B 001 - 002 - CBM24
o BACnet Serial
o Sample Apps BACnet
B =2 001 - wet Systems
E, 1111 - CT Single P
@’, 1112 - CT Single P
&, 1113 - CT Single P
E} 1114 - CT Dual Pul
&, 1115 - CT Dual Pui
&, 1116 - CT Dual Puy
@’, 1121 - VT Single P
-, 1122 - VT Single Py
E} 1123 - VT Single Py
-y 1124 - VT Dual Pur
-, 1125 - VT Dual Pur
@', 1126 - VT Dual Pur
E,, 1131 - Four Boilers
-, 1132 - Four Boilers
-y 1133 - Two Boilers v

M aana - o

This gives an overview of the BMS Sites
that are accessible from this PC

rlnrln

0O

THE STRATEGY DRAWING e -

Far
AREA . () ewesagane e
This part of the Ul shows the modules T 2
and points in the current strategy, and o T —ow -
. eP Room Temperature = &l
the connections between them, - =2 e 5.
= o ==
ol [ Derate N
eRl Z
ePr 1oc
" T i

u P ©
. =5~ 3
- o =
lers v|[e 0
B < > | Tem

THE RIGHT-HAND PANE S -

(INSPECTOR) o y
Controls »

On the right-hand side of the Ul there Fancins -
27 Analog Gate

is an area that displays the Modules

library, a Module Property editor, a - e
BACnet properties inspector and Page th‘ ;t
navigation panels. 2 Uit at Min and ax

7 Limitto 0 or 100
By default, these panels are displayed I~ e e

one-by-one in a tabbed interface,

~ . Rescale Custom
.7, Rescale from 0 to 100
v || -
Page Nam... Properties Modules
st
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bUt the IayOUt can be Page Mames 2 B Properties 2 B Modules L x |
Conﬁgured by + X [ ShowPageNumbersOn € > ? Tuneable Forward PID j =
. = Favorites
dragg]ng the tabs (Yo Page Number | Page Name | 4
[ Lo RS Tunesble Forward PD  Constants =
that the panels can be Senvice Order 1 ¢ 1
displayed a” together Synchronised Stat... Disconnected o] Digital Constant
=] Int
. Integer Constant
as Shown here' Setpoint Analog 1 Room Setpo.. = g
Process Variable Analeg (1) Room Te.. ’5.1 Real Constant
o Gai .
E Gain Analeg T =
Enable Digital | |
Integration time | Analeg ‘FUHC'E\DHE |
Derivative time | Analeg Math »
g Schedules, Timers, and L. »
Integration time 900 ‘S N noutTand O 1
Derivative time 0 (B =, NOURE ACE b
Service time 1 ‘Sta“t‘cs » |
(=] vay »
Qutput Analeg (9) Heating V... ‘Vlrtuals N 1
{ I
Integration time
Peried of integration of difference between the
Setpoint and the Process Variable. Set to zero to
te - BACnet ; = } = ©100% NUM

THE RIBBON

At the top of the CXproHP User Interface, there is a palette similar to many Windows applications called the
Ribbon. The Ribbon allows access to the majority of CXprotP features.

File - Home Contrgller Strategy ®
A Connect *& Communications | 4 Download [R, compare T 1 1 =R B2 =
“a' Disconnect I%Controller )‘BWipe Controller Eshow Compare % '-1 O‘ ® f |_E|é f 0
¥ . oo Scan  Override Livelog ™ Interface Configure
# BACnet 4 Auto Online a Point % | Builder
Site Configuration Operations Testing Keypad

The feature options are grouped into tabs each of which contains a different set of options.

THE QUICK ACCESS TOOLBAR

If there are specific Ribbon feature options that you use often, you can add them to the Quick Access Toolbar
where they will be accessible at all times:

2 REG G-

Fila - Hrma

Tambrallar

To do this, right-click on the feature in the Ribbon and select Add to Quick Access Toobar:

(] r — 1 = —_— —
I.:" (i Ad&to Quick Access Toolbar

“ul

rli = Customize Quick Access Toalbar...

Show Quick Access Toolbar Below the Ribbon

Minimize the Ribbon

~
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CONNECTING TO A FIELD CONTROLLER

Work in CXproHP can be done on-line or off-line. When on-line, the PC can communicate directly to the
controller. When off-line, there is no direct link between the PC and the controller. For tasks that involve direct
communication between the PC and the controller, e.g. uploading or downloading information, it is necessary
to work on-line.

e To work online, you must connect to the controller by clicking on the Connect button in the Home tab of

the Ribbon:
==
File - Home Controller Strategy

’ Co§e¢ m Copy Properties | Modules |EZ| Strategy
nnect

L”Disc- LﬁPaite : Navigation Macros D Reopen
V' Select All Lis: IE Page Mames @ Search

Site. Clipboard View

Site List L Strategy1

E--O Sites
2o BACnetIP

B =2 001 - Network
° - 001 - 001 - UCU3213V

e To work off-line, click the Disconnect button.

OPENING STRATEGY FILES

To open a strategy file in CXproH, you can
e Create a new strategy

or

e Open an existing strategy file.

It is possible to open multiple files: multiple new strategies in different controllers, multiple existing files, or a
mixture of both (see page 16)

To create a new strategy, either double-click on a Field Controller in the Site List that does not already have a
strategy associated with it or select New from the File menu

a =

File - Home Controller Strategy

Dﬂ“" Recent Documents
[=7 Open

mgave

@ Save As

Save All

@ Footers

@I Page Size

jl Printer Scaling

B, Print Setun

Site List z @ Properties 2 E Modules LN - |
- Sites x
5o BACnet P Favarites »
= -
B2 001 - Network Constants »
= 001 - 001 - UCU3213V
B 001 - 002 - CBM24 — Controls 3
B-2g BAChet Serial Engineering Centre Fanclions R
= 001 - Network
£} orl
EH -S.a-m le Apps BACnet - ] L
T Samplefep \ There is no Associated Strategy with this controller. Create a new Schedules, Timers, andL. »
Y Strategy? L d
Setpoints, Inputs, and 0. »
Statistics »
Yes No VAV »
Virtuals »

You will be asked if you want to create a new strategy - click Yes.
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To open an existing strategy file, double-click on a Field Controller that has an associated strategy, or select
Open from the File menu:

File - Home Controller Strategy

[ New Recent Documents E r BAChet P
[=r Open e bl 'l= BAChet Ut
B Save ules DE'.? Strategy D
[¥F) save As tegy

save All

@ Footers

NAVIGATING A MULTI-PAGE STRATEGY

For clarity, many strategies are drawn over several print-pages. To facilitate navigation through these pages,
CXprotP provides a Page Navigation panel.

To open it, select Navigation on the Home Ribbon.

File - Home Controller Strategy
’ Connect @ Copy fE| Properties | Mudulesl Strategy Help r‘] D [
;” Disconnect L?j Paste MNavigation Macros |:| Reapen Strategies O =
— Site: Configuration Database Di
1 _iSelect All List IE Page Names @ Search Interface M:
Site Clipboard View L
Site List n g |« 001_01.532 [ % | Properties
- ) Sites ~

5-Zo BACnet IP
558 001 - Network
.., 001 - 001 - UCU3213V
.= 001 - 002 - CBM24
&-2p BACnet Serial
E 001 - Network
EE Sample Apps BACnet

The button turns green to indicate the panel is currently displayed:

File - Home Controller Strategy

" Connect @ Copy [ Properties | Modules [?] Strategy Help r‘] D [
g’ Disconnect Lﬁpasle Nawgatiun ‘ Macros |:| Reopen Strategies ¢ =
— Configuration Database Di

e
i_iselect All List Page Names @ Search Interface M:
Site Clipboard View L

Site List n B Mavigation o E Properties

- 0 Sites

o
E-Ig BACnetIP -

{522 001 - Network -
o -
=, 001 - 001 - UCUZA3V -

] L. 001 - 002 - CBM24
B--Fo BACnet Serial

@52 001 - Network

EE Sample Apps BACnet

The Navigation panel appears by default as a docked panel within the CXpro® window, but by dragging its title
bar it can be repositioned within the window or even ‘popped out’ as an independent window that you can
position anywhere on your monitor:

©ABB 2025 All Rights Reserved.
Subject to change without notice
SOLUTIONS.ABB/HVAC-BUILDING-AUTOMATION 16

MANO133 rev 29


https://solutions.abb/HVAC-Building-Automation

Mavigation H

B

The Navigation panel shows black rectangles to indicate strategy blocks and a red rectangle to indicate the
current Strategy Drawing Pane. Dragging the red rectangle moves the display within the Strategy Drawing Pane:

Site [— Configuration Database Datalog Site Backug
ct Al | List [ Page Names @Search Interface Manager Organiser
ard View Utilities

L x (R 001_01.532 I: % | Properties

Bralg
Al poomTer

ork E
n-vcunw || ... o oo

)2 - CEM24

ork
ACnet
Analog Set
(A ReoTe
Setpoin
Navigation ﬂ

LN

Analog !
I’;\ Room Tén

LABELING THE PAGES WITHIN A STRATEGY DRAWING
An alternative method for navigating a large strategy is to use page names. A pane is available for this, to
open it click on the Page Names button in the Home ribbon:

[
File - Home Controller Strategy

"Connect @Copy Praperties |. Modules|Ez|Str

”’r Disconnect IZE Paste Mavigation | ||E Macros |:| Re

Site [
Select All List Fage Names @ Search
Site Clipboard View

Site List og | 001_01.532

=-§) Sites | )

=-fa BACnet IP
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2=

Fie - | Home | Cortoler Sty

#eaweat | Qcomy Modules [F)strategy Help D EROOD

o Oiscomneet | (ByPaste ] eopen Shaegies o E Ly Ly Ls o
Coigurston Goabse Dotaing _ Ske. _ Sackup WB.frs

[seeaan Interface Manager Organiser
see | oboms view s
Site List ag ¢ 001 01532 boX Pageames s@
) Sees |+ % 7 Show Page Numbers On Drawing
Gy tacan M T

| B-22 001 - Network

| = oot -0 - uCuB2IIV
| 01 - 002 - COM24

&-§g BaCnd Senal T
.

5 5a sempe e BACre:

There are no items ta show in this view. !

The Page Names panel appears by default as a docked panel within the CXproH® window, but by dragging its
title bar it can be repositioned within the window or even ‘popped out’ as an independent window that you
can position anywhere on your monitor.

The Page Names pane allows you to hide the page number on the strategy drawing:

2 .
Fle - | Home  Comtroller  Strategy

#comned | (Fcopy E]m’dﬂme 2] strategy Helo r& rl. m rrl"n Q r|.
Backun

o Disconneat | [Fypaste |[@navigavon [ Macros ] Reopen strateies

A = Configuration Database Datalog _ Site neFro
Ciseectan | gt |[5Page Names ] search Intertace Manager Organiser
sine Cipboara View Utities
Site List. 2 1 001_01.532 b x| [FageMames 0
=) Stes & | 4 X [ Show Page Numbers On Drawing
B-%a BACEt P

PageNumber | Page Name
| BB 001 - Network

% 001 - 001 - UCUZ13V
L 001 - 002 - CBM24

&8 BACnet Serisl

T 52 001 - Network

B-50 Ssmple Apps BACnet

‘There sre no items ta show in this view, |

And allows you to add names for pages instead numbers:

[ ¥ | Page Names o B
- » [ Show Page Numbers On Drawing
Page Mumber | Page Mame |

Mew Page Name
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5

T e |
o I(_v.n ﬂ-m;m.m-
o E] e B oo 8 C8 G2 D EE
Clsenasn w—u Ei earen T e Mara Oraamis
- s
o e = — wa |
=0 IR T S Pt g
B e ) :
SR e
-
G

[y aa—
8 2 o1t
g Sompe g e

Double-click on the name in the Page Names pane to edit it:

Page Mames [ |
+ X [ Show Page Numbers On Drawing
Page Number | Page Name |

_ Inputs| |

and the new name is displayed on the strategy drawing:

0.
- | Home | Controter smw
’f,nrwzn copy [ eoperics | [Mosutes [T] srstesy ein QD EDD o)
o Disconnedt am Mevgation | Maceos (] Reopen stategies s B OQORE
Contgurton Dtsbme Dutsog _ e Sackus NP
"} Select Al m [l Psge Homes &) searen interface Manager Organiser
{Ilﬁﬁllﬂ View Utilities.
SiteList 4@ 0 oo osn b % | PageMames a@
58 stes ~ + X [ ShowPage Numbers On Drowing
&-fg BAChat P Page bumber | Page Name
= g L1 Ntk h
) - vcwzay

-= 001002 - CBM2S
a B BACoet Serial

| @32 000 - Hetwork
@-fg Semgle Apps BACnet

Click on a name in the Page Names pane to align the top left corner of that page in the top left corner of the

Strategy Drawing Pane:
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File - Home Controller Strategy
Connect Copy roperties Modules Strategy Help r‘] r’l r’l r“ r“ r1
B | o Do s B QG
E'Dwsc-jnnect Lﬂ Paste [3 Mavigation ‘ Macros D Reopen Strategies
= Site | — Configuration Database Datalog Site Backup NB-Pro
L} select All List Page Names ‘@ search Interface Manager Organiser
Site Clipboard View Utilities
Site List LN = [ 001_01.532 b % | Page Names L - I
=) Sites ~ |+ X [ ShowPage Numbers On Drai
=)
Iz BACnet [P i 1 R L L L . L Page Number Page Name
&2 001 - Network O 7 Inputs
s el

| .= 001 - 002 - CBM24
2 BACnet Serial

- 001 - Network

Sample Apps BACnet

E. Tunszble Hysterssis
7 © Input Active High [0
T
=& on Level Active Low
T © OF Lavel
On level: 2.00; OF feveli 4,00

FINDING AN ELEMENT IN A STRATEGY
CXprotPl’s Find pane is a facility for locating specific objects in a strategy,

It is opened by either pressing [Ctrl]+[F], or by selecting the search window from the Home tab of the Ribbon.

Search Results

J MNumber l:l QFind 9\ g

X Delete [ Select Al |M0du|e j Type |Boo|ean j Name |
- [T Search results for "subtype: Boolean,type: Module” in strategy BACnet IP: 001 - Network: 001 - 002 - CBM24 (2 matches)

Boolean

Boolean

This pane contains a number of lists in which you can specify a number of filters to reduce the kinds of items
that will be located - for example in the screenshot above, only Boolean modules are shown.

You can then step through all of the matching items in the strategy drawing using the mouse or arrow keys
and selecting the module discovered in the search results. The current match will be highlighted in the

drawing:
gb Boolean 1 % Boolean 2
[T Input A Output [§ T [T Inpat A OQutput [
[ Input B Complement [ [ Input B Complement [
[ Input C [ Input €
[ Input D [ Input D

| <

Search Results

X Delete ™ Select All [Module ~| Type [Boolean v Name Number [ | QUFind Q Q

- [T Search results for "subtype: Boolean,type: Module” in strategy BACnet IP: 001 - Networke: 001 - 002 - CBM24 (2 matches)

-- Boolean

i.- Boolean

ZOOMING AND NAVIGATING THE DRAWING AREA

The drawing area can be displayed in an enlarged or reduced view. The default view is 100 %, i.e. full size.
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With a mouse, zoom in and out by rotating your mouse wheel with the control button pressed on your
keyboard.

If you do not have a mouse with a mouse wheel or are using a trackpad, you may use the zoom slider at the
bottom of the drawing area to zoom in and out.

F A3
Enable
Integration time: %¥; Dervative... LY
>
} 100%

For navigating around the drawing area, you can use the scrolls located on the right and bottom of the
drawing area.

The mouse wheel may also be used to move around the drawing. Scrolling up and down with the
mousewheel will move the drawing up and down. Scrolling up and down with the Shift button pressed on
your keyboard, you may move right and left.

You may also use the right mouse button to drag the strategy around in the drawing area.

If you are using a trackpad, the Navigation Pane makes it easy to get around your strategy.

CHANGING THE DISPLAY

The following features of CXproP can be customized:

e Drawing Area (Grid Settings). To simplify positioning modules on the drawing area, you can choose a
grid of either lines or dots. You can also customize the size of the grid from 8-pixel to 56-pixel squares
(see page 22).

e Colours. The colour of either the background or the grid can be customized using the Colour menu
option from the Display menu. In addition to the standard colours available, custom colours can also be
defined (see page 22).

e Macros. If the work you do in CXprotP involves repetitive strategies or parts of the strategies, you can
create macros (see page 133)to automate much of that work. You can arrange those macros in groups
and, using an art tool, such as Microsoft Paint, you can draw icons to represent the macro groups and
individual macros you have created.
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MODIFYING THE DRAWING AREA (GRID SETTINGS)

From the Strategy tab on the Ribbon, choose Grid.

This opens the Grid dialog box, where you can
specify whether or not to show the grid, and if
itis shown, whether you prefer lines or dots.
You can also set the spacing of the grid.

E%;Grid "+ MNew Connections
E}Grid Colour
DBackgrnund Colour
Display
Grid x

¥ Show Grid on Strategy

Style

Spacing

™ Lines
16 hd
= Dots

Cancel |

MODIFYING DISPLAY COLOUR SETTINGS

From the Strategy tab on the Ribbon, choose
Grid Colour or Background Colour.

In both cases, the Colour dialog box is called.
This allows you to select from a range of
colours. You can also make custom colours,
by clicking on the Define Custom Colours button.
When you have selected the colour you
require, click OK. The colour is applied
immediately.

%Grid lNew Connections
?)’Grid Colour

U"'Background Colour

Display

X

11T HEEENEF
1T "THEEEF

Define Custom Calors =3

OK | Cancel |
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SAVING FILES

CXprotD allows you store files on disc by:
e Saving a new file

e Saving changes to an existing file

e Saving multiple files at once

Files will be saved in the "strat5" folder of the relevant site directory, under a numbered directory. The
number of the directory matches the number of the BACnet Router to which the targeted controller is
attached - for example:

C:\CXproHD\Lan\strat5\001\001 OlFanCoil.stg

would be a strategy in a controller on the first BACnet Router of the site called "LAN".

SAVING A NEW FILE

If a file is being saved for the first time, press [Ctrl]+[s] on your keyboard or choose Save from the File drop-

down.

[=

File - Home Controller Strategy

D New Recent Documents

Open

= oe 1001_01.532

[ save

%] sayat 2001 02,532

- [ save (Ctri+S)

= Save the strategy.

E Foarers

QIPageSi;e
jl Frinter Scaling
%PrintSetgp
=8 Print
@glose
@telp Dabout K Exit
: JE_ESampIeAppsBACnet ] S
S0 Sample Apps Unitron

This produces the Save As dialog box allowing you to specify how the file is to be saved:

8 Save As “

4 |} < strat5 » 001 v & Search 001 0

Organise + Mew folder B= - (7]

.. CAMPBLOR " Name
.. ARCHIVE
. dbase

. DRAWINGS

. KEYPAD

. MACROS

. strats
L o0

. Upload

.. Upload
L] 001_01.s32

File name: | [LAMIE=R "

Save as type: | V6 Strategy (*.532) v

< Hide Folders save | | Cancel
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SAVING CHANGES TO AN EXISTING FILE

If you have made changes to an existing file and wish to save those changes, but do not wish to rename the
file, nor save it to a different location on the PC, you can save the file in two ways:

e Press [Ctrl]+[s] from the keyboard or
e choose Save from the File drop-down.

@
File - Home Controller Strategy
D New Recent Documents
Open
= 1001_01.532
B Save
m Save As 2001_02.532

[]
53 &N Save As

g Fo Save the strategy with a new name.
QI Page Size

EI Printer Scaling
‘F& Print Setup
= Print

@ Close

@ﬂelp (D
° | "'JE-E Sample Apps BACnet '[ S
SAVING MORE THAN ONE FILE

If you have a number of files open and wish to save them all, choose Save All from the File drop-down. This
saves each of the files.

File - Home Contraller Strategy

[ new Recent Documents Eli
Open
= 1001_01.532 rd
[ save ul
%) save s 2 C\CKproHD\..\D0T\001_01.532 ate
- E
0

|| save T\\, 3 CACXProHD\...\001_03VAV.532 L

Q Footers

QI Page Size

j] Printer Scaling
T-a Print Setup
= Print

® Licence Details

@glose

@Help (D About K Exit
= 00T - Wet Systems |
---@,, 1111 - CT Single Pump DPS

POl 1117 o T Ol P T

If one of the open files is being saved for the first time, CXprotP will prompt you to specify a drive, directory,
name, and file extension for that file by calling the Save As dialog box.
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CXproHP | Basic tasks

PRINTING

CXprotD can generate a hard-copy printout of the current strategy.

INCLUDING A FOOTER IN A PRINTED STRATEGY

When you print files created in CXprot, they include additional information at the end of the printed page in
the form of a footer. The footer includes the name of the site, as well as the BACnet Router and Field Controller
for which the strategy is designed. You can edit the footer to include your name, your company’s name, the
name of the project to which the file belongs, the number of the drawing if any, and the date and details of
any revisions made to the drawing.

How to edit the footer that will appear with the strategy when it is printed:
Choose Footers from the File tab of the Ribbon.

This opens the Footers Details dialog box:

Footer Details >

Company Mame I Cylon Controls Ltd.

Company Address Clonshaugh Business and Technology Park.

Clonshaugh
Dublin 17
D17 ABG2
—Project
Project Title | Open-Plan Office User IE' Peela
File | 001_01.532 Project No. | 14
Drawing Mo. |5
—RBevision
Rev Date Drawing Checked FREemarks
A |zporns |3 | e [oH
5 ! | !
e ! | !
EN | | |

Save I Cancel

Enter the required details and click Save.

©ABB 2025 All Rights Reserved.
Subject to change without notice
SOLUTIONS.ABB/HVAC-BUILDING-AUTOMATION 25

MANO133 rev 29


https://solutions.abb/HVAC-Building-Automation

CXproHP | Basic tasks

ALTERING THE PRINT SET-UP

To define how the strategy is to be printed, choose Print Setup from the File Tab of the Ribbon to open the
standard MSWindows Print Setup dialog box, where you can specify the required printer, paper, etc.

Print Setup >
— Printer
Mame: Properties. .. |

Status: Ready

Type: Brother HL-2170W

Where:  WS5D-63b62ecc-9045-4af 1-b52e-Befadb 0681 1. 006
Comment:

— Paper Qrientation
Size: I Letter ;I ™ Portrait

Source: | Automatically Select | * Landscape

Metworl... | QK I Cancel
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PRINTING A FILE

CXproHP | Basic tasks

To print a file, choose the Print option from the File tab of the Ribbon. This opens the standard MSWindows
Print dialog box to specify the required printer, pages to be printed, and the number of copies.

@ -

File ~ Home Controller Strategy

[ ew Recent Documents
[=r Open
E] Save

[%] save As 2001_02.532

1001_01532

Print

[~ Printer

*

Name: Brother HL-2170W series Printer

Status: Ready
Type: Brother HL-2170W

Properties |

Save All
IE Footers

QI Page Size
gl Printer Scaling

% Print Setup
= Print

() Close & Print (Ctri=P)
Print the strategy. delp @

| '%E Sample Apps BACnet

Where:  WSD-63b62ecc-9045-4af1-b52e-8efa8b006811.0067
Commert: I~ Print to file
— Print range Copies
« Al Number of copies |1 3:
" Pages from IT Lo.|12
e[ S| b3 ™ Callate
" Selection lb—l 2'—' 3'—‘

Cancel

CHANGING THE SIZE OF A PRINTOUT

If a strategy is large, it may not be possible to view enough modules on each page with a standard printout.
CXprofD has a Printer Scaling option, which allows you to decrease the printed size of the strategy so that

more of it is visible per page.

Also, if you have set a strategy up for printing on a particular printer, you may find that if you try printing on a
different printer it may not fit properly on the page. The Printer Scaling option allows you to adjust the

printout size to compensate for this.

To resize a printout, select Printer Scaling... from the File menu

This opens the Printer Scale dialog box:

Printer Scale

Printer Scale | 100

v Apply to all open documents

%

Cancel |

Enter a scaling factor between 20% and 300%.

e Factors from 20% to 99% will decrease the size of the modules in the printout.
e Factors from 101% to 300% will increase the size of the modules in the printout.

Ticking the Apply to all open documents box will set all currently-open strategies to print with the same scale.
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FITTING A STRATEGY TO A PAGE SIZE WHEN PRINTING.

The strategy drawing indicates where Modules will appear on the printed page, by drawing gray borders on
the strategy drawing. In this example, the printer scaling is 100%

The Printer scale setting will change the size of the pages relative to the modules. Below shows an example of
the printer scale of 200%

e e e
The physical page size represented by the gray borders is set by selecting Page Size from the File tab of the
Ribbon. This opens the Page Size dialog:

Page Size x

" Use Custom Page Size

= -
30 = o« [ =

e |
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CLOSING FILES

You can close an open strategy file in two ways:

Click the Close button at the top right-hand corner of the file window,

(=27 CKproHD - .00.00-304

File - Home Controller Strategy

& connect | [Hcopy Properties |[J] Modules|[7] strateay Help r| r. rﬂ r| r| rﬂ
#¥ Disconnect | [§]Paste [ Navigation [[§] Macros [ Reopen Strategies e = o h < L8
— Site (——— Configuration Database Datalog  Site  Backup NB-Pro
i} Select All List |[E Page Nam““ﬁ Search Interface Manager Organiser
site Clipboard View Utilities
Site List o g |4 001_01.532 3 )& Properties
B-§) Sites ~
B--2g BACnet P o
E-22 001 - Network R
’
=}, 001 - 001 - UCU32I3VAV L] R o
=}, 001 - 002 - CBM24 | Cutpet A0
o Output B[] Output B ()
S BACnet Serial e —rre =
2o DLLStuff Outp 0 OupaD ©
JE_E fred |Gonstant A: 0; Constant B 1; |Gonstant A: 1; Gonstant B: 2;
|Constant C: 0; Constant D: 1 |Constant C: 3; Constant D: 4

S Local Network

S Sample Apps BACnet
S Sample Apps Unitron
S Sample Strategies v0.1

5. Test BAChet Y A Cooling Optmzer A 7| B Goolng Optmz=r B 5|

B-Fa A - R . b
| [OSmnwme | semee@|  [@Mera | Snme | |@ sepo
S T Eew v

CESE=T Semp@| [ Testy | Shtomn )

< > Page Names
Strategy saved successfully. Connected to: BACnet IP (3], Remote -E ~ / 100% NUM
or
Select Close from the File tab of the o =
Ribbon. File = Home Contraller Strategy
D New Recent Documents

[=r Open

m Save

%] save As 2001_02.532
Save All

E Footers

QI Page Size

QI Printer Scaling

P Print Setup

= Print

@ Close

1001_01.532

E Close

Close the strategy.

Io sample Apps Unitron
EE Sample Strategies v0.1
G-Tg Test BACnet

If changes have been made to the file since the last save, CXprot® will prompt you to save it before closing.

If more than one file is open, selecting Close from the FileTab of the Ribbon closes the active window.
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System Configuration

SYSTEM CONFIGURATION DEFINITIONS

In order to properly communicate with and engineer ABB Cylon® BACnet Sites, the CXprotP software installed
on a PC must be given specific configuration information describing the sites to which the Software will
connect, and the methods of connection to each of those sites.

What is meant by “System” during configuration?

The “System” is the current installation of CXprotP software.

What is a “Site”?

A physical BMS Site in the ABB Cylon® system is either a single Field Controller acting on its own, or a collection
of Field Controllers grouped into fieldbusses, co-ordinated by one or more Networks.

In CXprofD, a “Site” is the virtual representation of such a physical BMS installation.

What is meant by “Network”?

There are 2 distinct types of channels through which CXproHP can connect to a physical BMS installation:
e Serial Connection (RS232)
e BACnetIP

Each of these channels can be enabled or disabled, whether or not Sites have been configured to use them.
Disabling channels can prevent delays when connecting to or disconnecting sites, by avoiding ‘auto
detection’ being carried out through unused channels.

CONFIGURING SITES

When you set up a Site, you need to provide the following information:

e The method that the supervisor PC will use to communicate with the Site
e  The name of the Site

e Thedirectory on the PC where the site information is stored

e The number and type of controllers on the site

e  The controller names
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DEFINING THE CONTENTS OF A SITE

The CXproHP system must be able to communicate directly with individual controllers within a Site. In order to
do this, the software system must know how many controllers a Site contains and must be able to identify

individual controllers.

The following information must be specified for each Site:

e  The number of Networks on the Site
e  The number of Field Controllers that are attached to each Network

e  The names of the Field Controllers on the Site

This information is specified when adding a Site to the system by right-click on the root node of the Site Tree
(i.e. the Sites node) and selecting Add Site

R ey [k
¥ Disconnect | [ Paste I—I—
..... Site
i !Select All List
Site Clipboard
Site List i |

Discover Site

Import V7 Sites

Restore Site

Add Site

I =T T

to open the Add Site dialog:

Add Site x

Neme: ||

Directory: |

Type of Connection for this Site:
" Serial Connection
@ BACnetIP

Enable BBMD - Site Level

IPAddrESsI 0.0 .0 .0 47808

Time to Live 60 seconds

™ Enable BAChet NAT

OF Cancel I

or when editing an existing Site by right-clicking on its node in the Site Tree and selecting Properties

= @ Sites
G1-2a 10020801
G1-2a BACnet P
S0 BACnet Serial

EE ‘Campus block B
)

Discover Site

Backup Site

Export ASPECT/INTEGRA Data
Create BACnet EDE Data

EE Sample Apps

Pog
Io Stores

Commission BACnet Devices

Edit Controllers
Delete Site
| Site Properties

to open the Site Properties dialog:

Site Properties X

Name:

Directory: | CAMPBLOR

Type of Connection for this Site:
" Serial Connection
& BACnetIP

Enable BBMD - Site Level

IP Address | 0.0 .0 .0 47808

Time tolive | &0 seconds

™ Enable BaCnet NAT
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Site Properties / Add Site Dialogs : Site Information section
Each site on the system is given a unique name to identify it to the user and CXprotP programs.
+ Name

The Site Name is used to identify the site >t Information

at all places throughout the CXproHP Mame | PL Office |
system. The Site name is entered in the

Name field of the Add Site dialog box and
can be edited in the Site Properties dialog
when editing an existing Site.

Nirartan: | Pl FFICF |

R/

% Directory

You use the Directory field to specify the Mame | FL Uttice |

directory that will contain the site Directory | PLOFFICE |
information.

When adding a new Site, enter the name of the directory to contain the files for this Site. The name that you
input here will be assigned to a subfolder of the cxpro#® directory that will be created to contain the site
information.

e The software will suggest a directory name as you type the Site name in the Add Site dialog.

e The Directory name is limited to eighty characters.

e Giving two sites the same Directory name will cause the system to malfunction.

e The Directory cannot be edited in the Site Properties dialog when editing an existing Site.

Site Properties / Add Site Dialogs: Selecting the Network for connection to a site (Type

of Connection)
Type of Connection far this Site

I:::l Serial Connection
(@ BAChet IP

«+» Serial Connection (RS232)

If the Supervisor PC will connect to the Site by Serial communication (RS232), select Serial Connection

<+ BACnetIP

Editing the number and names of controllers on a site

There are several reasons why you may wish to edit the information about the controllers on a particular site.
For example:

e Anew CXprotD site has been set up

e A CXprofDsite connected to the PC has changed, (so the system information has to be changed to match)
e You want to change the description of a controller

CXprotP programs must contain accurate information about the number and types of controllers that each
site contains. This allows the supervisor PC to communicate accurately with the system sites.

You must specify the number and names of Networks on a site, and the number and names of Field
Controllers attached to each Network.
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To edit the controllers on a Site, right-click on the Site in the Site Tree and select Edit Controllers:

%BACmet @Compare
Site. Configuration
site List A |
Sites
-5 10020801
5o BACnet IP

Io BACnet Serial

(B Campus block R

- 001 - Netw Discover Site
Backup Site

Export ASPECT/INTEGRA Data
Create BACnet EDE Data

Commission BACnet Devices

Edit Controllers |}
Delete Site

%.E Sample Apps B
[E3] %.E Stores Site Properties

"
=

Which opens the Edit Controllers dialog, showing all of the Networks on the site.

Edit Controllers X
B2 Campus block R Sites
= 001 - Network There are 1routers for  Campus block R
Address | Name [ Type [ Metwork [ Device In... [ Dupiicate | No. Parts [
1 001 - Netnark CER 1 1

Add Edit Delete Add Multiple
s

When a Network is selected in the Tree in the left-hand pane, the dialog displays the Controllers connected to
the selected Network.

Edit Controllers X
2o Campus block R Netwark
-4 001 - Nitwnrk There are 2 controllers for 001 - Network of type CBR
Address | Name [ Type | Device In... | MS/TP Network
1 001-001-CBMDS  CBMOS a1 1
2 001-002-CBV-2U.. CBY-2U4-3TN 65644 L

Add Edit Delete Add Multiple
s

Note: You can also select a Network by opening the Edit Controllers dialog directly from that Network in the Site Tree:

site List 2 8 £t Controlers x
=5 Sites 5-Hg Samele tops BaChet Hetwork
5o 10020801 P — There e 1 ool for 003 O of e G
g B 5 o

E-1n BACnet P = e adgem [rme [ [oescein. [ /mretmon |
- BACnet Serial T8 oo vedtng vasn |2 0500 MoASE CAXSRE s
-85 Campus block R - oa-vav
m-Eg PL Office -5 o5 -y
B35 Sample Apps BACnet BB

B3 001 - et Systems

B2 002 - AHU

-2

e Export ASPECT/INTEGRA Data

B 00:  Update BACnet EDE Data

= o

= 00t Commission BACnet Devices

F
B39 SO ey contraliers e e e

Router Properties :I
< > = ot
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The Edit Controllers dialog box is used to specify the Network and Field Controller numbers and names.

By default, Networks are assigned sequentially numbered names in the format @01 -Network, and Field
Controllers are assigned names in the format ee1 - ee1 - CBM24, with the Network or Field Controller number
increasing in line with the number of controllers on the site.

The Field Controller name must be unique in the Site, so the Router address is included - e.g. on Router
address 1, and Field Controller address 2 it can be either @01 - 002 - CBM24, or CBM24 - 002 - 001.

The default names are automatically assigned but can be edited as necessary.

The dialog box allows you to specify the types of Networks and Field Controllers contained in the site, and the
number of Field Controllers that are attached to each Network.

The left-hand pane of the dialog lists the Networks on the site. At the top of this pane, the Site Name and
total number of Networks are displayed:

ks

g MNetwaork(s) for Site:  PL Office

& Mame Type Device In.., Duplicate
001 - Metwork CEBR

]

The right-hand pane of the dialog lists the Field Controllers connected to the Network that is currently
selected in the left-hand pane. At the top of this pane the name of the selected controller and the total
number of Field Controllers attached to the selected Network are displayed:

Contrallers
0 Controller(s} for Metwork: 001 - Network

Ad.. & Mame Type Device In...

*,

% Adding Networks to a Site

Before adding Field Controllers, one or more Networks (fieldbusses or Subnets) must be defined. The
fieldbusses can be MS/TP or Modbus.

To add a new Network to the site, click the Add button underneath the Network list.

The New Router dialog will appear:

New Router X

Netwark Number
Name | 002 - Netwark

(001 - Network' or "Network - 0017)

Contraller Type |CBR -

Device Instance (0to 4194302)

IP Address [ . . . |

Enable BEMD - Router Level

P address | 5 . . |

Time to Live seconds

[ Enable BACnet NAT
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The next available Network Number is automatically assigned, but you can manually enter a different value in
the Network Number field.

e Enter a name for the Network in the Name field.

e Select the Router type from the Controller Type drop down list.
e Enter a BACnet Device Instance Number.

e Optionally enter an IP address and Port Number for the Router.

If the BACnet Device Instance Number is valid, then CXprotP will read the IP address and automatically populate
the Router IP address and HTTPS Port fields.

e |f the Router is to be used as a BBMD, to transfer communications to a different BACnet network, check
the Use as BBMD checkbox.

Click the OK button to confirm your choice.

Additional tabs are displayed if a Modbus-enabled router is selected, to allow different Address and Name to
be set for each fieldbus.

Edit Comms Controller Details Edit Comms Controller Details
MSTP1 | Modbus |
Address: |1 Address: |1
Name: 001 - Nehwerk Name: 001 - Nehwerk
Mame format: 007 - U Caxxx’ or 'UCxxxs - 001" Mame format: 007 - U Caxxx’ or 'UCxxxs - 001"

Default Type: IEBR LI Default Type: IEBR;MDD LI
Device Instance I— Device Instance I—
Mumnber: [0 to 4194302) 5321 Mumnber: [0 to 4194302) 5E161|

Cancel | Cancel |

If the router type is an extendable controller (FBXi, CBXi etc.), then additional fields are displayed in the Edit
Router dialog that matches the Field Controller dialog described in Edliting Controller information on page
36 and FLX /O modules on page 36

Edit Router X

Hetwork Number
Name | P02 - Network

(001 - Network' or 'Netwaork - 0017)

Controller Type | CBXi ¥

Device Instance Number | 354231 0 to 4194302)
IPAddress:Port | 192 . 168 . 85 . 146 | :[&7 |

Maodules
Addr.. Type Dipswitch Add

1 FLX-BR8 i Delete
2 FLX-4R4-H H

If the router is set to a type that does not support routing BACnet traffic to MS/TP networks, the right-hand
section of the Edit Controllers dialog will be disabled.
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% Adding Field Controllers to a Site

To add a new Field Controller to the currently selected Network, click the Add button underneath the Field
Controller list. The New Controller dialog will appear.

New Controller “

Address

Name | o01-001 - CBM24 |
MName format: "001 - 001 - CBoot’ or 'CBixcoc - 001 - 001"

Controller Type |CBM24 e |

[] view All Contrallers

Device Instance Mumber 553‘1 (0 to 4194302)

The next available controller address is automatically assigned, but you can manually enter a different value
in the Address field.

Enter a name for the Field Controller in the Name field.

Note: A controller name cannot be more than forty characters long.

Select the Field Controller type from the Type drop down list. By default, only controller types from the
current product range are listed. However, if the 'View All Controllers box is ticked, all supported controllers will
be listed. Click the OK button to confirm the choices that you made in the dialog.

Set the Device Instance Number. This must be an ID for this controller that is unique within the ABB Cylon®
BACnet Site.

Note: The number set here in the CXprot must match the Device Instance Number set in the Field Controller.

% Editing Controller information

Clicking the relevant Edit button while a Network or Field Controller is selected causes an Edit dialog to open,
which has identical parameters to the corresponding ‘New’ dialogs above. If you change the values of any of
the parameters in an Edit dialog and click the OK button then the parameters of the selected Controller will

be updated to match the dialog.

< FLX1/0 modules

If the site includes FBXi-X256, CBXi-8R8, or CBX-8R8 devices, their I/O capabilities can be expanded by adding
FLX devices. The expanded I/0 must be configured on each FBXi/CBXi/CBX device as follows:

In the New Field Controller Details dialog change the Controller Type to FBXi-X256, CBXi-8R8, Or CBX-8R8 :

X

Network

There are 2 controllers for 001 - Network of type CBR
™ 001-001 - CBMO3
= 001-002 - cav-204-37- | New Controller

agdress [2
Name [ 001 - 002 - CBMos.

Name format: ‘001 - 001 - CBox or CBioat - 001 - 001

Contrller Type [cBMOS S

Device Instance

ok Cancel
Add Ml
e
(& le=
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An I/0 Modules table will become visible in the New Controller dialog:

New Controller

Address | 2

Name | 001 - 002 - CBX-8R8
Name format: ‘001 - 001 - CBioor or 'CBiao - 001 - 001"

Controller Type |CBX-8RS v

[#] view All Controllers

Device Instance Number (0 to 4194302)
Modules
Addr..  Type Dipswitch Add
Delete
There are no items to show in this view.
oK Cancel

Device Instance Number must not be empty!

If the FBXi/CBXi/CBX device has one or more FLX modules connected to it, add the same number of entries
in the 1I/O Modules table:

1¢0 Modules 1/0 M odules 10 Modules
Address Type Dipswitch % d Address  Type Dipswitch 4 d Address Type Dipswitch i
1 FLXaRS i oL 1 FLXaRS i
Thete: ate i iems to show i this view. || (055 Dty
2 FLXaRS

Device Instance Number must ot be [Devics Instance Number must not be Device Instance Number must ot be
jempiy! 0K Cancel jempiy! 0K Cancel jempiy! 0K Cancel

Note: On FBXi devices, the first FLX can be set to address 0. On CBXi and CBX devices, address 0 is reserved for
onboard |/O

If you attempt to add more modules than the FBXi/CBXi/CBX can support, an error message will be
displayed:

ccconfig

(/_“‘) The maximum |0 modules allowed for this controller have already
&Y been added.

When the correct number of FLX modules have been configured, enter a Device Instance number and click OK.

Edit Controllers x

B-fa Campus block R Netwark
52 001 - Hetwork There are 3 controllers for 001 - Network of type CBR
= 001 - 001 - cBMOE
= 001 -003 - cBX-8RE
= 001-004- CBY-204-3TN

[Address [ iame [ Device In.... | MS/TF Network_|
4

Edit Delete Add Multile
oK Cancel

In the strategy drawing, 10 blocks can be added up to the total on the configured FLX modules plus the CBX
onboard IO.

Note:  If a FLX module is deleted from a FBXi/CBXi/CBX configuration after the strategy drawing has been set up,
the blocks associated with that FLX's 10 will be ‘greyed out’ to indicate that they are inactive.
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« Modbus devices
A CBX controller can communicate with up to 4 Modbus devices connected to its Modbus RTU port.
IP Controllers (CBXi, FBXi, FBVi etc.) can communicate with

e Up to 247 devices per RTU port
e Up to 1280 devices via Modbus Router
e Up to6ee Modbus IP devices

These devices are configured in CXproP in a similar way to FLX modules.

To configure Modbus devices,

1. open the strategy of the FBXi, CBX or CBXi to which the Modbus devices are connected
2. inthe Site Tree right-click on the FBXi, CBX or CBXi, and

3. select Configure Modbus Devices from the context menu

Site List 2l |4 (i e e
I}; = — [EM==R003 - FEXi- X2 5 i - -
= Sites ) pen ‘003 00532 =
2_ 10020201 T Metwork 3 :
T ‘?‘ Metwork 4 Configure Modbus Devices
o BAChet P
L0

1 .-
fo Sample Apps BACr Break Association
To BACnet Serial A

=
1o Campys block R o EE Stores
-To PL Office S

H B8 001 - Network

=, 001 - 001 - CEMOS

1
fg Sample Appsv1.1 Copy Strategy To

Strategy Operations

= o[>

Export ASPECT/INTEGRA Data (router only)
Export ASPECT/INTEGRA Data (entire network)

Update BACnet EDE Data
% 002 -1 Configure Modw; Devices
JE_E Sample A Commission M5/TP Network
= EBreak
ig Sample A| Commission this controller

Io Stores Copy Strategy To

Edit Controllers

Note: The Configure Modbus Devices option will not be available unless the controller has an associated saved

strategy that is currently open.

This will open a dialog that allows you to configure the FBXi/CBXi/CBX’s Modbus RTU port to match the
attached devices and to add an Address and Name for each of those Modbus devices.

Configuring the FBXi, CBX or CBXi’s Modbus RTU port

Configure Modbus Devices X
RTU1 Configuration
Baud 9600 b
Parity None v
Stop bit 1 Y.
Inter-packet delay 200 ms (40-10000)
Communication Timeout 200 ms (200-10000)
Deleting a device will disable any assodiated point in the strategy.

RTU Devices used: 0 / 494
Router Devices used: 0 / 1280
IP Devices used: 0 / 600

add | Delete |

o ] con |

Note: When configuring Modbus on FBXi two separate RTU networks are available:

Configure Modbus Devices

Lk Configura
LLRTU 1
Baud

When the RTU node of the Device Tree is selected, you can specify the Baud, Parity, and Stop bit settings that all
devices on the RTU network will use to communicate.
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Note: With Modbus, all devices on an RTU network must be configured with the same communication parameters
for the network to function properly.

Set an Inter-packet delay value that is reasonable for the devices on your network. Modbus devices commonly
need time for the RS-485 transceivers to switch from a writing mode to a reading mode. Some Modbus
devices will write to their flash or perform similar operation before being ready for the next Modbus
command to be sent. Set the Inter-packet delay to a value that allows for the worst-case operation.

The Communication Timeout is the time the CBX will wait before giving up on one request and moving on to
sending the next request.

Note: The status output of a Modbus Analog or Modbus Digital module will display a value that is non-zero for any
failing Modbus transmission.

Adding and Removing Modbus Devices

Before an FBXi, CBX or CBXi can access Modbus points, it must be configured with a list of Modbus devices
that is available to the Modbus Analog or Modbus Digital modules.

To add a device, click the “Add” button

Configure Modbus Devices X

=

e
- [15] Electricity Meter =
- [1] Lighting Offices Baud 9600 A
- [1] Lighting Production
1] Ligntng Parity MNone -
Stop bit 1 =

Inter-packet delay 200 ms {40-500)
Communication Timeout 200 ms (200-10000)

Deleting a device wil disable any associated point in the strateqy.

Devices used: 3 / 4

Add Delete Cancel

For CBX products, the device is automatically added the single RTU port.

For FBXi and CBXi products, you will be offered the choice of channel to which the Modbus device will be
connected: RTU port, Modbus Router or IP port:

Select type X
* RTU port
© Modbus Router

1P port

|

If you choose RTU port on an FBXi, you will be offered a further choice -RTU O or RTU 1
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Select type X
Address Name
0 RTUO
1 RTU1
< >
o
When the channel has been selected, a new device will be added to the tree. Select it:
Configure Modbus Devices s
ERTU
- [15] Electricity Meter Configuration
- [1] Lighting Offices Name Device 4
[1] Lighting Production e ll—
Deleting a device will disable any assodated paint in the strategy.
Devices used: 4/ 4
Delete ok Cancel

and then edit the Name and Modbus Address of the Modbus device.
The Address must be one of the following:
e Modbus RTU - A number between 1 and 255.

e Modbus TCP - An IP address with optional port, in the format nnn . nnn . nnn . nnn : pppp. The port (pppp) is
separated by a semicolon. The port is optional, and if omitted the default Modbus port of 502 will be used.

e Modbus RTU device behind a Modbus Router - An IP address with an optional port and RTU address in the
format nnn . nnn . nnn . nnn : pppp / zzz The port (pppp) is separated by a semicolon. The RTU address for
routing (zzz) is separated by a ‘/’ character. The port is optional and if omitted, the default Modbus port
of 502 will be used. For routing, the RTU address is required.

Note: The Modbus Addresses do not need to be sequential.
To delete a Modbus device from the list, choose the device, and click the “Delete” button.

At any time later, the Address of the Modbus device can be updated without any change to the Modbus Analog or
Modbus Digital modules in your strategy.

Accessing Modbus points in the Strategy

To access a point within any of the Modbus devices configured for a specific CBX, add a Modbus Analog module
or Modbus Digital module (whichever is appropriate for the point) to that CBX’s strategy.
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Modules

Favorites
Constants

Controls

Functions

Math

Schedules, Timers, and Logic

Setpoints, Inputs, and Outputs
Al analog Tnput

AO  analog output

{?’ Analog Setpoint

BACnet Analog

BACnet Analog Priority Aay
BACnet Binary

BACnet Binary Priority Aray

Digital Input
DO pigital Output

£ pigital setpoint

9;‘_; Modbus Analog

23 modbus pigital

Modbus modules are displayed as follows:

4

Modbus Anzlog 1

Madbus Digital 1

Vahse out £

Vahe out [

[ Wirit= control Status 6

Wiite control

Status )

Devicet Device 1 Register: 0

Devicz: Device 1; Coilfinput: 0

[Pevice: Ecory v

Madules

Favorites

Constants

Controls

Functions

Math

Schedules, Timers, and Logic
Setpoints, Inputs, and Outputs
Al analog tnput

AQ  analog Output

(2) analog setpoint
23 sacnet analog
@B Bacnet analog priorty Array
2e BACnet Binary
9B sacnet sinary priorty amay

D

Digital Input
DO pigital Output

21 pigital setpoint

23 modbus analog
23 Modbus Digital

Ll

In the module Properties, specify which of the CBX’s configured Modbus devices contains the required point:

I X | Properties

= a

A < > ?IModbusAna\og

=]
Type Modbus Analog
Service Order 1
Synchronised Status  Disconnected
=]
luein Analog
Write control Digital
=]
Read Frequency 30
Medbus device Electricity Meter E
Data type
Q4 Modbus Anakg T
Lot Data format
Owiein | wheox| Endian
[ Witz control Stztus O Word swap No swap
[Device: Eledicity Meter; = . Register address 0
Default Value 0.0000
COV Value 0.1000
Min COV Time 30
Write Frequency 30
=]
Value out Analog
Modbus device

This is the Modbus device this module will
communicate with,

]

-

> Macros  Properties Page Names Modules
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The modules are capable of interacting with the following Modbus entities:

Module Action Modbus Entity
Modbus Analog Reading Input Register
Modbus Analog Reading and Writing Holding Register
Modbus Digital Reading Discrete Input
Modbus Digital Reading and Writing Coil

For writing to occur, the “Value in” input of the module must be connected. For reading to occur, the “Value
out” output of the module must be connected.

If Write Control is connected, then the input value must be a 1 before COV or other timers are evaluated.
Reading data from a Modbus device is done periodically and controlled by the “Read Frequency” constant.

Writing can be performed either periodically or be triggered by a change of value. For a Change Of Value, if
the input value to the module changes (or, in the case of a Modbus Analog module, changes by a predetermined
amount), then a write is performed.

The Modbus Analog module can handle endian differences, word swapping, and interpretation of the value read
from the Modbus device.

K/

% Removing a Controller from a Site

Clicking the relevant Delete button while a Network or Field Controller is selected, will remove the selected
Controller from the list.

+ Adding Multiple Controllers
At certain times you may find it convenient to add several controllers to the site at once.
The Edit Controllers dialog contains an Add Multiple button underneath each of the Network and Field Controller
lists.

B If you click the button under the Network list, you can automatically add several Networks to the
Site.

B If you click the button under the Field Controller list, you can add several Field Controllers to the
currently selected Network.

When you click either of the two Add Multiple buttons, the relevant Generate Default Names dialog will appear.

Add Multiple Controllers “ Add Multiple Controllers
Number of Controllers HNumber of Controllers
Controller Type Controller Type  CBMO2 v
[#] view All Controllers [#] view All Controllers
Name Format | 002 - CBR Name Format | 002 - CBMOB
(001 - <Text>" or '<Text> - 001 where 001 will be the incremented,) (001 - <Text>" or '<Text> - 001" where 001 will be the incremented.)
Starting Device Instance Number || (0to 4194302) Starting Device Instance Number l:| (0o 4194302)
A valid Device Instance Number is required! e

These dialogs are similar to the Add dialogs for single Comms and Field Controllers, with the exception that
the Address parameter is replaced with a Number of controllers parameter.
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This parameter specifies the maximum address that will be used to generate controller entries. What that
means is that controller entries are generated starting at the next available controller address and continuing
as far as the address specified in the Number of controllers box.

For example, if controllers exist for the current Network up to address 5, and the Generate Default Names facility
is used with 10 in the Number of controllers box, then Controllers will be generated for addresses 6, 7, 8,9 and 10.

Note: The Number of controllers parameter does not represent the total number of items that will be added
automatically. Instead, it represents the maximum address that will be generated.

°,

% Sorting the Controller List

The Network and Field Controller lists can be sorted based on:
e Address

e Name

e Type

By default, the controllers in the list are sorted by address. To sort by any of these columns, click the column
header at the top of the controller list.

°,

% Saving the changes made in the Edit Controllers dialog
When you click OK from the Edit Controllers dialog, the changes are immediately validated.

CONFIGURING SERIAL PORT CONNECTION

In order to modify Serial Port settings, or to choose between serial ports if your PC has multiple ports, open
the Application Settings dialog by clicking on the Settings icon in the Settings group of the Home ribbon:

fle - Home Contraller Strategy

ﬁConned @Copy Pmperties Page Names| Search r‘l r‘l r‘] r“ i '3 BACnet
‘e’ Disconnect LE Paste BACnet Properties Modules E Strategy Help g w Fh . ) E& Strategies

= Site L Database Datalog Site MBE-Pro | Settings X
i _!Select All List Mavigation Macros Interface Manager Organiser |:| Reopen Strategies

Site Clipboard View Utilities Settings

In the Application Settings dialog, select Serial Port Connection :

Application Settings Pas

Download Options
¥ Enable Serial Connection
Scan Options

Detected |3
Strateqy Settings
BACnet Configuration A ICOM1 j‘
seretpon Comecion (|| Potdpesd [o0 ]

Commands

Livelog

’TI Cancel Apply
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CONFIGURING STRATEGY DEFAULTS

By selecting the Strategy Settings option in the Application Settings dialog, you can set several default values for
new strategies:

Application Settings X
Download Options Strategy files
Scan Options ™ Reopen Strategies
[ I Enable auto-backup
‘ Strategy Settings | |
W Autosave every |10 | minutes
BACnet Configuration
Serial Port Connection Analog inputs default
Commands Temperature to: ,m
Livelog Mate: this value apply only to new analog inputs. Existing inputs will
keep their values.

Analog value precision

Show this number of decimal places |2 ﬂ

oK Cancel ‘ |

This can be opened directly by clicking on the Strategies icon in the Settings group of the Home ribbon:
le = Home Contraller Strategy
/G/C-:unnect @Capy Properties | Page Names|Search r‘l r‘] r‘] r‘] . "o BAChet
& i e = " 5 E Fh . ' "
&' Disconnect LﬂPaste BACnet Properties Modules |E5trategy Help E&Strateg 25

. Site o [T P Database Datalog Site MNE-Pro | Settings % .

! Select All List Na\ﬂgatlon Macros Interface Manager Organiser [1 rReoperiStrategies

Site Clipboard View Litilities Settings

Also in the Settings group of the Home ribbon, there is a checkbox that defines whether or not strategies that
were open when CXprotP was closed will be automatically opened when CXproP next starts.

v E% Strategies

Settings
Reopen Strategies

N

settinas

CONFIGURING BACNET COMMUNICATIONS

In order to connect CXprofP to a specific BACnet Site, you must set its system-wide BACnet Properties in the
Application Settings dialog.

These properties are the identity of the Network Adapter that will be used to connect the PC to the BACnet
System, and the Device Instance Number of that Network Adapter in the BACnet system.

Open the BACnet Configuration option in the Application Settings dialog by clicking on the BACnet icon in the Settings
group of the Home ribbon:

le = Home Controller Strategy

/G/C-:unnect @Capy Properties | Page Namesl Search D E r1 G o 'Q BAC”&
= L4 h

ﬂ’ Disconnect LT‘jPaste BACnet Properties | Modules |Ez|5trategy Help ' E&Strategles

e Site L Database Datalog Site MB-Pro | Settings X
LI Select All List Navigation Macros Interface Manager Organiser [] Reopen Strategies
Site Clipboard View Utilities Settings

This opens the Application Settings dialog with BACnet Configuration selected
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Application Settings
Download Options
Scan Options

Strategy Settings

i~ Device Instance Number for this Computer

Device Instance Number {Oto 4194302y

r IP Address

BACnet Confi i

Serial Port Connection
Commands

Livelog

[192.168.000.073 : Intel(R) Ethemet Connection (2) 1219-LM

Fort Id?BDB
Subnet Mask |255 255 2550

=

r— Retry Settings
MNumber of Retriss

ID
Time Qut IZD seconds

¥ Enable BEMD - System Level

IPMdressl 192 168 6 35

Time to Live ISD seconds

[~ Enable BACnet NAT

47308

oK | Cancel |

Apply |

The Device Instance Number will be set to “-1”. This must be changed to a unique Device Instance Number.

In the IP Address drop-down list, select one of the PC’s network adapters to be used as the channel for all
BACnet communication. Set the Subnet mask in accordance with the local network policy — if in doubt ask your
local Network Administrator. The default is 255.255.255.0.

It is recommended that the Number of Retries is left at @ unless there is a clear reason for changing it.

Note:  In order to avoid conflicts with Command settings for set and get, the BACnet Timeout should be set to
Number of retries = 8 and Time out = 26 seconds.

If you wish to connect to a remote BACnet site, enter that site’s IP address in the BBMD settings — System Level

section.

Click OK to save these settings.
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CONFIGURING BBMD

If you wish to connect to a remote BACnet Site, you must set a Network, a Site or the CXprotP system to act as
a BBMD.

What is BBMD?

Some BACnet services (e.g. “who-T1s”) use ‘broadcasts’. These broadcasts are blocked by standard Ethernet
routers so that BACnet broadcasts are limited to the IP subnet of the BACnet device. A BACnet/IP Broadcast
Management Device (BBMD) is one way to get around this limitation on a BACnet/IP network of 2 or more IP
subnets.

How a BBMD operates

A BBMD located on an IP subnet monitors broadcast messages on that subnet and constructs a “peer to
peer” message for each broadcast to pass it through any IP router. This “peer to peer” message is received by
other BBMDs on other IP subnets and transmitted as a broadcast on their attached subnets.

Since the BBMD messages are ‘directed’, individual messages must be sent to each BBMD. Each BBMD device
maintains a Broadcast Distribution Table (BDT), the content of which is usually the same for all BBMDs within
the network. Each BBMD must know the IP address of every other BBMD in the network.

Setting a BBMD in CXprotP

BBMD properties can be set at the System Level, on a Site or a Network, and if more than one is set then it
‘cascades’ upwards. This means that if a controller attempts to communicate with a remote BACnet Site, it
will use the Network-level BBMD settings if any have been defined. If the Network to which the Controller is
attached does not have BBMD settings configured for it, then the Controller will use Site-level BBMD settings
if any have been defined. If the Site containing the Controller also does not have BBMD settings configured
for it, then the Controller will use the System-level settings.

BBMD Parameters
In the CXprotP system, the following BBMD parameters can be set:

e IP Address

e Port Number

e Time to Live (not available in Site-level parameters)

e Enable NAT (Override "I am”) (not available in Site-level parameters)
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Note: If a BACnet device must be accessed through VPN, and the VPN is not on the same network as the BMS, then
a NAT rule can be used on the internal router connecting the two internal networks. This maps a port
number on the Network 1 IP Address to an IP Address + Port Number on Network 2. The IP Address and Port
Number must correspond to that of the BBMD router.

Internal
Firewall Router BACHet 1P
etz nef
& | mme Secure VPN | mmm
<
/ \ BBMD Router ) Router
CXpro"P Network 1 1P address Network 2 IP address

[ [

In the diagram above, the internal router is set up to map a port number on its Network 2 address to the
internal BBMD router address. The CXproHP BBMD settings are then set to the internal router’s Network 1
address & port.

In this scenario Discovery and the I-am messages reach CXprotP, but when CXprot reads a property for one
of the discovered devices, it would by default use the source IP Address found by Discovery (a network 1 IP
address) instead of the actual BBMD address.

The Enable NAT (Override "I am”) checkbox on the BBMD settings in CXprotP forces it to always use the BBMD
address for all communications.

% System-level BBMD parameters

To set the BBMD parameters for the whole CXprotP system, click on the BACnet icon in the Settings group
within the Home ribbon:

le ~ Home Controller Strategy

ﬁ’ Connect @ Copy Properties | Page Namesl Search r“ r‘l r‘] r‘] o 'g BACnﬁ
_@' Disconnect LT‘j Paste BACnhet Properties Modules Ezl Strategy Help g w Fh . ' E& Strategies

o Database Datalog Site  MB-Pro | Settings i
..... Navigation Macras Interface Manager Crganiser [[] reopen Strategies

Site Clipboard View Utilities Settings

This opens the Application Settings dialog with BACnet Configuration selected. The BBMD - System Lev settings are at
the bottom of the dialog:

lime ILU seconas |

W Enable BBMD - System Level
IF‘MdressI 192 168 . 6 35 47808

Time to Live IGD seconds

[~ Enable BACnet NAT

’TI Cancel Apply
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To set the BBMD parameters for a specific Site, right-click on that Site and select Site Properties

- Sites

-2 10020801
S BACnetIP
S0 BACnet Serial

=f Campus block B

PL Office

rnlnrln r

Discover Site

Backup Site

Export ASPECT/INTEGRA Data
Create BACnet EDE Data

E5 002 - New _ :
EE Sample Apps Commission BACnet Devices
o
ig Storss Edit Controllers

Delete Site

| Site Properties

to open the Site Properties dialog:

The Site BBMD settings parameters are at the bottom of the dialog.

+* Network-level BBMD parameters

Site Properties ®

Name: | Campus block R

Directory: | CAMPBLOR

Type of Connection for this Site:
" Serial Connection
% BACnetIP

Enable BEMD - Site Level

IPAddressI 0 .0 .0 .0 47808

Time to Live 60 seconds

™ Enable BACTEL MAT

Ok Cancel

To set the BBMD parameters for a specific Network, right-click on that Network and select Router Properties

B-§) Sites
2o 10020801
25 BAChet P
Io BACnet Serial
25 Campus blockR
=2 001 - Network

o

Edit Router X

Network Number [ B
Name [ 002 - Network

E-Ig PL Office (001 - Network' or Netwark - 001)
222 001 - Network
-=J, 001 - 001 - CEMD2 Controler Type [ o |
B 001 - 002 - CBX-8RE
= 01 - 010 - CBT13W/ Device Instance | 554231 (0o 4194302}
©-2g sample A Open Sk \Paddress [ 152 . 168 . 85 . 146 |67
-5 001 -1 " .
&= onz- to open the Edit Router dialog: 1 Enable BN - Router Level
@, 21 Break paddress [ 0 . 0 . 0 . 0o Jo
=, 2 Copy Strategy To Time ta Live |60 seconds
=2
& I Enabie BACHet NAT
-E; 21 Strategy operations
= 21 Export ASPECT/INTEGRA Data (CEXi Only) Modules
= 21 Addr... | Type [ Dipswiten [ Add
= 5,  EXport ASPECT/INTEGRA Data (Entire Network]
1 FLX-BR8
@’ 2 Update BACnet EDE Data _ peiete |
1 e
2 FLX-4R4-H
=21 ommission BAChet Devices
-2 003- |
- _E_ 004 -1 Edit Controllers
= - "
5= 003-1  Router Properties pve Cancel
e [ o ] oo
r-Fn Stores
The IP settings in this dialog include a checkbox to allow the router to be used as a BBMD.
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CONFIGURING SITE COMMUNICATIONS (COMMANDS)

The commands that CXprotP uses to communicate with ABB Cylon® controllers can be adjusted from the
Application Settings dialog.

This can be useful in troubleshooting connection failures. It can be useful to tell the system to give the
connection more time to become established.

On the other hand, if you have a reliable fast connection it can be of more benefit to reduce the time taken to
establish connections, and so increase the speed and responsiveness of the system.

Command Settings

To adjust the Commands settings, open the Application Settings dialog by clicking on the Settings icon in the
Settings group of the Home ribbon:

ile = Home Controller Strategy

ﬁCDnned @Copy Ploperties PageNames|Search E E r‘] E ! 'QBAC”“
& —rh

‘@' Disconnect L?j Paste EACnet Properties Modules EE Strategy Help ! - E& Strategies
..... Database Datalog Site ME-Pro | Settings
i_iSelect Al Mavigation Macros Interface Manager Organiser [] reopen strategies
Site Clipboard View Utilities Settings

In the Application Settings dialog, select Commands:

Application Settings X
Download Optians Commands Time out (1-20s) | Retries (0-25)
Cortroller Detect 5 ]
Scan Options Get Block 20 n
Get Point 5 2
Strati Setti
rategy Settings Router Detect 5 0
BACnet Configuration Set Block 20 2
Set Point 5 2
Serial Port Connection
Commands
Livelog
Reload
Number of Relries for Command NACKS (Falures)  [3 S

OK | Cancel | appb |

To edit a value, double-click on it in the Port Handler Command Settings dialog.

Clicking the ‘Reload’ button will cause all of the values to revert to their previous settings, and any changes
made will be lost.

Each command has a Retries setting:

e Number of Retries for Command NACKs (failures)

The retries in the main list apply to Timeouts, where no response is received. This parameter sets the
number of retries when a response is received, and the response is NACK, indicating a failure.

When the OK button is pressed, each edited value is checked to see if it is valid.
If a command Time Out is greater than 20 seconds then it will be reduced to 20 seconds, and if a Time Out value
is less than zero seconds, then zero seconds will be used.

If a command Retries value is greater than 25 then it will be set to 25, and if a Retries value is less than zero
then it will be set to zero.

Profiles:

The following profiles provide advisory settings that may be helpful when requests from a site and its
controllers, or manipulation of data, results in failures.
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Command Time Out Retry

Get Point 2000 1

Set Point 2000 1

Get Block 2000 1

Set Block 5000 1

Router Detect 2000

Controller detect 2000 -
< Default Profile:

Command Time Out Retry

Get Point 2000 0

Set Point 2000

Get Block 2000

Set Block 5000

Router Detect 10000

Controller detect 10000
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Using Modules

MODULES - OVERVIEW

Modules are the building blocks from which strategies are constructed. They are the basic units of operation
in CXprotp,

Modules perform tasks within a strategy such as

e bringing controller inputs into the strategy

e changing the values of points in the strategy according to mathematical rules
e comparing the values of points in the strategy

e recording the values of points in the strategy

¢ sending point values to the controller’s outputs.

Modules can be grouped and saved as in order to avoid repetitive tasks, i.e. if you use a particular strategy or

part of a strategy frequently, you can save it as a macro and reuse it without having to repeatedly re-create it.

ACCESSING MODULES
By default, Modules are available from the right-hand pane, by clicking the Modules tab at the bottom of the
Pane:

S (== ABA — -

ition Database Datalog Site Backup MNEB-Pro
Interface Manager Organiser

Utilities
I x| Modules i x |

~
. . Favarites

Constants

H

Cantrols

Functions

‘Math

LScheduIes, Timers, and...
' Setpoints, Inputs, and...
IStatisiticsi

VAV

:Virtuals

v | v |V | v | ¥rF| v\ v v\ v \w

> Page Mam... Properties Mowes

iample Apps BACnet (3), : ! ; .
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The Modules Pane groups the available modules into Constants, Controls, Functions, Math, Schedules/Timers,
Setpoints/1/0, Statistics, VAV, and Virtuals. To access individual modules, click on one of the groups:
g e e o —w

onfiguration Database Datalog site  Backup MNE-Pri
Interface Manager Organiser

Utilities

X | Modules

Favorites

Constants
L

|-(|:J Digital Constant

I_',E Integer Constant

’E; Real Constant
Contrals

Functions

Math

Schedules, Timers, and...

Setpoints, Inputs, and..

Statistics
VAV
Virtuals
v
> Page Mam... Properties Mod
ted to: Sample Apps BACnet [3), '—l—

There is also a “Favourites” group, where you can set up a custom list of modules that you use frequently or
want to be able to access quickly.

To add a module to the Favourites group, right-click on the module in the Modules Pane and select Pin to favorites:

Setpoints, Inputs, an... -
L
Al Analog Input

AO Analog Output

(3) pugien ot

) Add to Strat

Sa o Strategy
L& B‘&| Pin to Favorites |

L’

BACnet 2 Help

0B
;.: BACnet Binary

To remove a module from the Favourites Group, right-click on it and select Unpin from Favourites:

Modules n @

®
Favorites |
L
@ Analon Setnnint )i |

Add to Strategy
A>B (o . =
| v | Unpin f&)m Favorites
LI'_I"E Inte Removlé\grom list
i

Al anal Help
lConstants N |
IControIs >
_Funct\ons »
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PLACING A MODULE ON THE DRAWING AREA
In order to use a module in a strategy, you must place it in the strategy’s ‘drawing area’.
To do this, click on the module name in the Modules pane:

File = Home Controller Strategy @

’Cannect @Can}-‘ FE Properties Modules Estrategy Help m D m Dﬂ; m F.
=

’f Disconnect L‘a Paste Mavigation Macros D Reopen Strategies

= ite Configuration Database Datalog Site Backup NE-Pro
elect All List Page Names @Search Interface Manager Organiser
Site Clipboard View Utilities
Site List 2 B [« Strategy1 P X | Modules L~ |
E--@ Sites -~ A *
-5 BAChetIP Favorites y [
B2 001 - Network T
B 007 - 001 - UCU32' o o o e r
= 001 - 002 - CBM24 F F FE Contrals »
20 BAChet Serial A A o e )
-5 001 - Wet Systems 3 4
.....EJ’ 1111 - CT Single P o o oo Schedules, Timers, a... »
@, 1112 - CT Single P Setpoints, Inputs, an.. -
@, 1113 - CT Single P
&, 1114- CT Dual Pui o o o Al analog tput
.0, 1115 - CT Dual Pui F F FE
W
&, 1116 - CT Dual Pur o o S AO  analog Output
=, 1121 - VT Single Pr L L S
¢ g (A nalog Setpoint
=], 1122 VT Single P o o o {l g Setp
-, 1123 - VT Single Pr o S S E: BACnet Analog
-, 1124 - VT Dual Pur
@, 1123 - VT Dual Pur BACnet Analog Priority...
E', 1126 - VT Dual Pur P P FE T
.=, 1131 - Four Boilers L L S s @ BACnet Binary
=], 1132 - Four Boilers L L S ; o v
&= . . S DAZC b Dinsns Doosib A
'_( 1133 - Two Boilers v v L€ >
< > < > Page Mam... Properties Modules
Connected to: Sample Apps BACnet (3], IiJi

Then click on the strategy drawing area at the position where the module is to be placed (note the cursor
changes to the “Module Cursor” | during this process):

File ~ Home Cantroller Strategy ®

"Cannect @Cany odules Estrategy Help Fﬂ E m D[h m F.

b”’ Disconnect LE Paste Mavigation Macros D Reopen Strategies
. Site Configuration Database Datalog Site Backup NE-Pro
elect All List Page Names @593"”‘ Interface Manager Organiser
Site Clipboard View Utilities
Site List aH| |« Strategy1 - %X | [Modules L3 x |
= @ Sites -~ A ®
El-$a BACnetIP o o o Favorites y | A
E-52 001 - Network =
& 001 - 001 - UCU32' . o o o " 4
= 001 - 002 - CBM24. Lo Lo Lo Controls »
Functions »
Math »
@, 1111 - CT Single P Schedules, Timers, a._ »
&, 1112- CT Single P Setpoints, Inputs, an... -
=, 1113 - CT Single P P P P
=) 1114 - CT Dual Puy L L o Al analog Input
... ™. 1115 - CT Dual Pul Lo Lo Lo
W+
&, 1116 - CT Dual Pui o o S AO  analog Output
[, 1121 - VT Single Pr P P P 7
’ [ 7] Analog Setpoint
=, 122 VT Single Pr o o o o g Setp
&), 1123 - VT Single Pt g: BACnet Analog
@f 1124 - VT Dual Pur S S F
=, 1125 - VT Dual Pur o o T BACnet Analog Priority..
E',ﬂZE-WDuaIPur P P FE B
.....@’ 1131 - Four Boilers Lo Lo Lo i@ BACnet Binary
&, 1132 - Four Boilers P P P _ . v
DAfnat Dinans Neindhe A
E” 1133 - Two Boilers - o v || € >
< 3 < > Page Mam... Properties Modules
Connected to: Sample Apps BACnet (3), .—.Jf

Some modules (e.g. Analog Input) prompt for basic configuration information when they are first placed.
When this happens, fill in the dialog and click OK
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File - Home Controller Strategy

’ Connect @ Copy E

g‘Disc-:mnect LEPaste

Mavigation Macros
Sit:
L:s: Page Mames @ Search

Properties Maodules E Strategy Help

[] reopen Strategies

@
(o [ Cu Ll DG

Configuration Database Datalog Site Backup MNE-Pro
Interface Manager Organiser

Site Clipboard View Utilities
Site List o B (4 Strategy1 I X | Modules » 2
B8 Sites ~ ~ %
3-2g BACnet 1P Favorites |~
-2 001 - Network e
= 001- 001 - UCU32 . . S ’
& 001 - 002 - CBM24 Point Name Controls N
JE_E BACnet Serial Functions »
--JE_E Sample Apps BACnet I 1
-2 001 - Wet Systems Foint Name |Ruum Temperature _Math &
@; 1111 - CT Single P Schedules, Timers, a.. »
@ 1112 - CT Single P Setpoints, Inputs, an... -
&), 1113 - CT Single P E
i
), 1114 - CT Dual Puy &= =ncel Al analag mput
.=, 1115 - CT Dual Pui
&
.=, 1116 - CT Dual Pui AO  analog Output
.=, 1121 - VT Single Py m
¥ () Analog Setpoint
™), 1122 VT Single P i LB ESE
B, 1123 - VT Single P O BACnet Anzlog
.=}, 1124 - VT Dual Pur
.=, 1125 - VT Dual Pur BACnet Analog Priority.
q 1126 - VT Dual Pur B+ .
&), 1131 - Four Boilers t-g BACnet Binary
E,¢ 1132 - Four Boilers v
= : DAFnrt Dinns Nrinrit &
---'_f1133-Tw0 Bol.\ersv v || € >
< > < > Page Mam... Properties Modules
Setup block updated. Connected to: Sample Apps BACnet (3}, 3

The module is displayed on the strategy drawing, and as it has just been placed it is automatically selected.

This is indicated by a green outline:

File - Home Controller Strategy

’Conne:t @Copy E Properties
;" Disconnect L'a Paste MNavigation Macras

- Site
_iSelect All List Page Mames @Search
Site Clipboard View

Site List o H Strategy1

Modules EE Strategy Help

["] Reopen strategies

@
o S lu OGS

Configuration Database Datalog Site Backup NEB-Pro
Interface Manager Organiser

Utilities
I X | Modules L = |

=8 0 Sites -

o

2o BACNetIP

=22 001 - Network Anslog Input
1 001 - 001 - UCU32

Al foom remperature

.= 001 - 002 - CBM24

To BACnet Serial
Io Sample Apps BAChet
222 001 - Wet Systems
= 1111 - CT Single P
@J 1112 - CT Single P
q 1113 - CT Single P
& 1114 - CT Dual Pui
.2, 1115 - CT Dual Pur
=, 1116 - CT Dual Pui
-, 1121 - VT Single P1
.=, 1122 - VT Single P\
q 1123 - VT Single P
=, 1124 - VT Dual Pur
.=}, 1125 - VT Dual Pur
=, 1126 - VT Dual Pur
S‘ 1131 - Four Boilers
&=, 1132 - Four Boilers
Eg 1133 - Two Boilers v

M aama o onoa

< > <

Setup block updated.

It is possible to examine and edit the properties of the selected module by clicking on the Properties tab at the

bottom of the Right-Hand pane:

Connected to: Sample Apps BACnet (3},

- ®
Favorites
Constants
Controls
Functions
Math

v v v v v w

Schedules, Timers, a.

Setpoints, Inputs, an... -
Al Analog Input
AO Analog Output

f}\l Analog Setpoint

8: BACnet Analog

BACnet Analog Priority..

o BAChetBinary

BACnet Binary Priority A..
w w

> Page Mam... Properties Maodules
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File - Home Contraller Strategy

" Connedt m Copy

fDismnned Lﬁpasta

roperties |[|E| Modules ‘Ezl Strategy Help

Navigatmn Ma{ms D Reopen Strategies

®
[0 [ Cw OG0

Configuration Database Datalog Site Backup ME-Pro

[T} select AN 'age Names ‘@ Search Interface Manager Organiser
Site. Clipboard View Utilities
Site List a g« Strategy1 I X | Properties > a
=] @ Sites ~ A ? ’—_|
5-2g BACnet P - 5 N "
H ‘Anzlog Input B -
=2 ;1 ;ml‘;lert\;;f;rlcr T Al poom TE-'HD:rature Type Analog Input
Point €| Service Order 1
= 001002 - CBM24 Override [ Name Reom Tem...
BACnet Senal - -
Sample Apps BACnet Synchronis... Disconnect...
-5 001 - Wet Systems S
____@’ 1111 - CT Single P Pointty... Input Anal...
., 1112 - CT Single P Low thresh... |0
B, 1113 - CT Single P High thres... 0
B, 1114 - CT Dual Pui Lower sens.. 0
=, 1115 - CT Dual Puy Upper sens... 0
& 1116 - CT Dual Puy Inputerror  0.0000
.., 1121 - VT Single Pr Exponential... 60
&, 1122 - VT Single P1 Sensortype  PT1000
&, 1123 - VT Single P Unit C
-, 1124 - VT Dual Pur Aversging 0
-, 1125 - VT Dual Pur =] -

&, 1126 - VT Dual Pur
&, 1131 - Four Boilers
E, 1132 - Four Boilers

B aams e

< >

Setup block updated.

You can edit the properties of the selected module by clicking in the property's value in the right-hand pane.
Help text relevant to the property being edited is displayed in the lower portion of the Right-Hand pane

....@, 1133 - Two Boilers
v

> Page Nam... Propert'Es Modules
Connected to: Sample Apps BACnet (3],

Fil Fr | Home Cantraller Strategy @
’ H @ C 5 |E A
Connect Copy Properties Modules Strategy Help
¥ Disconnect | [Paste [H Navigation Macros || Reopen Strategies e = v th s L8
Site ——— Configuration Database Datalog Site Backup NEB-Pro
Select All List Page Namei“ﬂ Search Interface Manager Organiser
Site Clipboard View Utilities
Site List o g |4 Strategy I X | Properties L |
= 6) Sites ~ o~ ? |Analog Input[1] -
B-Tg BACnet P _ = =
5= - Analog Input B =
-2 001 - Network Al
n Type Analog Input
= 001 - 001 - UCU3Z Room Temperature ¥p g Inp!
H Paint (3 Service Order 1
L. 001 - D02 - CBM24. —
o Override [ Mame Room Tenm...
Io BACnet Serial Sunch o ot
&85 Sample Apps BAChet ynchronis... Disconnect...
2-52 001 - Wet Systems El
E, 1111 - CT Single P Point ty... Input Anal..
-, 1112 - CT Single P Low thresh... 0
B, 1113 - CT Single P High thres... 0
-8, 1174~ CT Dual Pur Lower sens... (]
-~ 1115 - CT Dual Pui Upper sens... 0
E’, 1116 - CT Dual Pui Input error 00000
---@f 1121 - VT Single P Exponential... 60
B, 1122 - VT Single P1 Sensortype  PT1000 =
-, 1123 - VT Single P1 Unit °C
-, 1124 - VT Dual Pur Averaging 0
&, 1125 - VT Dual Pur =) =

-, 1126 - VT Dual Pur

B, 1131 - Four Boilers
-, 1132 - Four Boilers
-, 1133 - Two Boilers

[ PP

< >
Setup block updated.

Note: If you have multiple strategies open at once, ensure that you select the strategy into which you would like to

~

Lower sensor range
The settings specify the range of
the input, after analog-to-digital

> Page Mam... Properties Modules
Connected to: Sample Apps BACnet (3], t

place the module before you select the module from the modules bar.

The module can now be selected, and edited, moved, copied, cut, or joined to other modules.
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SELECTING MODULES ON THE DRAWING AREA

Before you can move, copy, cut, or delete a module, you must first select it. This can be done by:

Clicking on the module symbol,

Al .

Analog Input 1
m Temperature

Analog Input

1

Al ..

m Tem peratu re

m

Point £
N

Ovemide [

Paint £
s

Cvemidz [

Or by clicking and dragging from the top left to the bottom right of the module symbol(s) as shown. When

you release the mouse button, the module will be selected

[

Analog Input 1 Analog Input 1 Analog Input 1
AI Room Temperature AI Room Tem perature AI Room Temperature
Poim@m Point £ 7T Point £ 7
Ovemide [ Cvemide [ Crvemide [
i

To select more than one module on the drawing area:
You can select multiple modules at once by the following methods:

4. Press and hold down the [Ctrl] button while clicking the modules required.

5. if you want to select every item in the drawing simultaneously, click on Select All in the Strategy tab.

atroller Strategy

£ copy _|:

] IE Paste

= W
sﬂgﬂ Al Mo
oller Clipbtard

[ ]
6. Clickand drag a box around all the modules you want to select. When you release the mouse button, all the
modules within the box will have been selected.

~ ~ ~

E Tuneable Foward PID 2 > Tuneabe Forward PID 2 E Tuneabie Forward PID 2

Braiog Topt

raig gt
Al goom remperature

Al goom remperature

Al

Selected modules (and points, which are represented by lines) are surrounded by coloured borders. Most
modules will have a red border, but one will be green. This is the module (or point/line) whose properties are
currently displayed in the Properties Pane —i.e. the module that is “in focus”.
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You can change which of the selected modules is “in focus” by using the navigation controls at the top of the
Properties pane, with the arrows:

4 Strategy1 I X | Properties e x|
& £ ﬁ ? IAnang Setpoint [ VI
> o — =
() e Serpoint L Value 0.000000
I ) IR o
—— } Tuneable Forward PID 2 = PointD.. Analog 1 Roo..
. MNu... 1
€ Satpoint Output € T
‘Analog Input T pr— Y ) :l'ype f":flog
Al Room Temperature 1  I9cn . Value  0.00
Port el Enable ) Mame Room Setpoint
oveme=@] = [© imegeten ) Unit  *C
N Y )
’ IIEmﬁon time: 900; Dervative... |

Or the drop-down, which lists the currently selected modules and points:

q Strategy1 I X | Properties L |
o~ < » ? |TuneableForward YI
(}\ e - . Analog Input [‘I]
o "o Room Setpoint
[ Poin: (o e
1 } Tuneable Forward PID 2 | :
R © Setpaint Oup © : Setpoint  Analog 1 R...
Araloeg Input : EL
Al Roam Temperature 1 "= . Process... Analog (1) ..
Port O Enable : Gain Analog
Ovemidz [ " |© integration ' Enable Digital
| © Dervative _ Integrat... Analog
Integration time: $00; Derivative... . L

MOVE, DELETE, CUT OR COPY A MODULE OR MODULES ON THE STRATEGY
DRAWING AREA

In order to Move, Delete, Cut, or Copy a module or modules, you must first select the module(s) as described
above. Then:

Moving modules

To move the selected module(s) on the drawing area, drag any one of the selected modules. The modules
and their connected points (lines) will move together. Alternatively, you can also use the arrow keys on the
PC’s keyboard to move all of the selected modules at the same time.

Deleting modules

To delete the selected module(s) from the drawing area press the [Delete] button on the PC’s keyboard.

Copying modules on the drawing area

To copy the selected module(s) to the PC’s clipboard, so that they can be pasted to another part of the
drawing area or to a different strategy, either

e Press [Ctrl]+[c] on the PC’s keyboard, or
e Click on Copy in the Home tab:

Home Controller

nnect @Cup}-
sconnect IEPaste

{71 select All

Site Clipboard
[ ]

A copy of the module(s) will be saved on the Clipboard until placed (pasted) elsewhere.
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Then, paste the module(s) to a specific point within the same strategy, or to another strategy, by first either

e pressing [Ctrl]+[v] on the PC’s keyboard, or
e clicking on Paste in the Home tab:

Hame Controller

nnect ﬁ Copy

sconnect EP&S’::&
I

site Clipboard

then click on the drawing area in the target strategy with the mouse. The top left-hand corner of the
module(s) will be positioned on the point where the mouse was clicked.

Note: Pasted hardware point modules may adapt some parameters to the destination point but retain others. For
example, an analog input configured as PT1000 when pasted to a UniPut will change to a voltage input but
retain the max and min limits (in the Advanced button) which for PT1000 could be min 0 and max 0O, leading
to incorrect operation of the UniPut.

TOOL TIP DATA ON MODULES

To view details of a specific Module, hover the mouse pointer over the Block in the strategy drawing.

Analog Cutput 13
=] AO Heating Valve
; W‘}O Type: Output
TST Analog/Digital Type: Analog
* |8 bit range: 0-255
| Type of Input Sensor: Volts
- |Lower actuator: 0
- |Higher actuator: 10000
- - . . |Strategy lower: 0
— - - . . . |Strategy upper: 100
= |Output error: 0.00
. |3ensor Type: 0-10Kohms
. |3equence on period: 0
~ [Wnit: °C

@]
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JOINING MODULES IN A STRATEGY

Modules in a strategy must be joined together to allow information to flow from input to output. The flow is
from left to right, so that controller input connection points are on the left of the drawing area, controller
outputs are on the right, and the modules are positioned between the inputs and outputs in the center of the

drawing area.

Notes on joining modules

e A connection is possible only if both the input and the output are of the same type (analog or digital).
e An output of a module can be linked as often as required with inputs of other modules.
¢ Aninput of a module can be linked with only one output of a module.

MODULE CONNECTION POINTS

Connection points are marked on module symbols as blue circles or squares on the left and right edges of
the module. When the mouse pointer is placed over a connection point, it changes to a cross-hair.

e Circular connection points are analog.
e Square connection points are digital

If you want to connect two points, make sure they are both either digital or analog. You cannot connect

analog to digital or vice versa.

HOW TO JOIN MODULES

Place the mouse pointer over the required
output of the first module so that it changes
to a crosshair.

Click and drag the mouse from the output to
the required input of the other module. You
will see that the crosshair changes back to a
mouse pointer once you have left the blue
connection point and return to cross-hair
format when you reach the next blue
connection point.

Release the mouse when you have reached
the required input. The two modules are now
joined. The connection between the two
modules is marked by a coloured line. The
default colour is black, but this can be
customized by clicking on the connection line
with the right mouse button.

Analeg Satpoint 1
Room Setpoint

[ Poit 5|

Analog Setpoint [
Room Setpoint

[ Point €

Analog Satpoint 1
Room Setpoint

[ Point £
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HOW CONNECTIONS ARE REPRESENTED

By default, the connection between 2 modules is represented by a black line with the numbers of the points
at each end of the connection also displayed (as in the above example).

You can customize the way in which all connections are represented by right-clicking on the Drawing Area to
open the Display Options menu:

Display Options ,

B Tursat
7{® sempoint
st [ o — — il
Paint O] [ Gsin
rice ] EEED
€3 Incegration
atie
[ivtegraton fime
. =
Paint
mice [

This gives access to the following options:

Hide All Lines :
< ®,
| Display Options »| Display Lines | ShowAllLines | |
B | Osplaylabdls  » | HieAlLines I
P Tuneable Forward PID T
R 1| Setpeine 0maBly
| wl@
m@m [ Gain
o) I Eratie
[ Integration
e
Show All Lines B
P el
| Display Options » | Display Lines » || ShowpilLines | ] S S
=N | DisplayLabels »‘ Hide Ail Lines | : o o
W‘
R T|© Setpoint Output €3
B e — 2™
n@m‘ | &ain
= S R R ee
S R R St
=

Hide Labels

o DisplayOptions  »|  Displaylines v
0T Display Labels B e
T shéw Number Tuneable Forvard PID. 1
B o P
j usl y fsi ) €2 Setpoint Output
I e 1 T T T S
@—I @ Gain
5] I Erabie
[ Integration
o ——
Show Number S
- )
|| Display Options v Display Lines v 1 - E
T I Display Labels 3 Hide R EEEE R T oD T
—— I R ™S
I\—O‘T&i%w e S S S < 5
T Shaw Value Only (simulation) K]
— T
= = ' ) 5 cain
=0 L A =
€ Int=gration
o N ———
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Show Name ’
- T e o o
_|  Display Options D Display Lines vl . L Lo
= == =R W‘
—1‘ - . . gzl sm‘ Va\ueOn\y(f\rr:u\almn) ! @gﬁwm Output @

1) : FET

=0 5 Ensbe

(€ Integration

Show Value Only (Simulation) ]

i

Display Lines v

E(  Display Options v
— Display Labels ~ » Hide
..... Show Number
: Show Name
j |2 | Show Value Only (simulation)
T T Te e = ; T

L2l

B Tunezble Formard PID 1

) S=tpoint Output )

El

FED
Enable

You can customize the line and label visibility of a single point (line) in the properties panel:

Properties - |

<)?| 'l

= Point Details Analog 1 Room 5.
MNumber 1
Type Analog
Value 0.00
Name Room Setpoint
Unit “C
=
Show Line True
Labels Show value onIyE

Show number

Show name k
Show value only (si

You can also change the default visibility using the New Connections option on the Strategy tab of the Ribbon:

Strategy
Hcopy E T figEacnet Points EE [ Create
E Paste ']= BACnet Units Manager
— View | Add o Reorder Strategy | View _
iselect All | |Modules| Text Terminals Modules & Strategy Details Help Macros [f¥ Save Mew
Clipboard Strategy Macros
2> ] Stratenwd

This opens the New Connections dialog, where you can set the appearance of new module connections:

New Connections “
v Display lines on newly created connections.

Configure how point information is display on newly
created connedtions,

IShow value anly [simulation;l

Show value only (simulation

.n ﬁ. % :‘u Logging 3% Grid DL MNew Cgnnections
» [ | & configuration | B Grid Colour
Start/Pause Stop Reset
- I,_'/Background Colour
Simulation Display

box Modules

©ABB 2025 All Rights Reserved.
Subject to change without notice
SOLUTIONS.ABB/HVAC-BUILDING-AUTOMATION

61

MANO133 rev 29


https://solutions.abb/HVAC-Building-Automation

MOVE EXISTING LINES

The lines that connect modules on a strategy drawing can be moved from one module to another without
deleting and re-adding them. To do it, right-click on the output or input node on the module to which the line
is connected, and select Move Line(s)... from the context menu:

Int  [meger Corsant g
g
ey R
Output BE Hide Lines
| OapacE Show Point Route
Output D &
A: 1; B: 59; C: 0; D: 0 Add Source Connector

...... Convert Lines to Connectors

: ‘ Move Line(s)... ‘

""" Simulation Properties

The line(s) can then be moved by clicking the new module node:

u)m Resake o 0and 10 7|

L ]
1€ Lower Limit A Output €
) Upp=r Limit B
@ Real Time Clack g € Input
‘ear 63 [E 100 RescaletoDand 100 E|
Month €3 A=y
Day 3 ) Lower Limit A Outpatt £
Hour @ @ Upper Limit B
Mirute € € Input
Szconds £
Decimal time € L 100 Rescalzofand 100 %
Time 6 A0

3 Lower Lmit A Outpet 9|
(€ Uppar Limit B
[ Input

‘Reconnect the lines by simply -~ -
_clicking the new module node
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CONNECTORS

Lines are a convenient and intuitive way to connect modules that are close together in the strategy drawing.
However, clicking and dragging to connect modules that are far apart in the drawing can be impractical. To
overcome this, CXproHP provides an alternative way to connect modules using named Connectors.

0 Input i
wTemp .
S <@ MWsHowTene_| [wsronTemn 6 Sl T
o :
&
.
T —
WSHILimit
| Paint 0 m_m(W]
Override £ Analog Selpoint g
o wo  HWSTempDB
I Pokk O 1)

A Connector creates an invisible channel of information between a single Source and multiple Destinations.

Add a Source Connector

To set up a Source Connector, right-click on any output on any module and select Add Source Connector .

Maximum 4
fax
JinptA amum Gr—
I Input B Show lines
3 Input C
gD | | Add Source Connector
3 Input E Convert Lii}sto Connectors
3 Input F
3 Inpuit G Simulation Properties
3 Input H

In the dialog that opens, enter a name for the point that will be exposed by the Source Connector you are
creating.

Point Name

Point Mame I MaxHWaterI

OK I Cancel |

The Source Connector is now created.

Mzstmom -
lax

VInp A Maximum (2 oy
VInp B

) Input €

Note: Points exposed by Source Connectors must be named.
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Adding a Destination Connector

To connect a module to a point exposed by a Source Connector you must create a Destination Connector as
follows: Right-click on any input of any module and select Add Destination Connector .

A B Comparatar 1
SipxaA |  Owpa[y
&I.nu.rt_ﬂ_Lﬁau.nlen'lemmrl '

] Show lines

) | Add Destination Connector
Cnrl&rt Lines to Connectors

Simulation Properties

Alist of Source Connectors will be displayed.

Select Source Connector H

Name

MaxHWWater

Adder/Scaler Block 19 Output
WeatherCom Block 2001 Inpu

OK ﬂ Cancel

Choose the appropriate Source Connector and click OK to complete the connection. The new destination
connector is added to the input of the module.

MaxHilzter ) 3

Deleting Connectors
The rules for deleting connectors are as follows:

Source: If a Source Connector is deleted, all Destination Connectors connected to the Source Connector will also be
deleted.

Destination: If a Destination Connector is deleted, it is the same as disconnecting an input from any output.

If the Destination Connector is the last one connected to the source, a dialog will be displayed asking the user if
they want to delete the source. If they decide to do so, then the Source Connector will also be deleted. If the
user does not delete the Source Connector, that point will be available for new Destination Connectors.
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Quick Searching for Connectors

Jumping from a Destination Connector

Right-click on the Destination Connector and choose either Jump to Source or Jump To Other Destination .
Ny it

MarHViater () S ) Inpit | comp

Jump to Source

. Jﬂp to Other Destination | .

If you choose Jump to Source you will immediately be taken to that Connector.

If you choose Jump To Other Destination and there is only one available, you will immediately be taken to that
Connector.

If you choose Jump To Other Destination and there is more than one available Destination, then the Search Results
window (below the Strategy Drawing window) will display them as a list so that you can select which one to

View.
2 imaa

MaHViater @ —I@ o8 Gomp

8
p=r T
B Ve Ve
imp DPS = 1 [ ) = e
1mp Trip < >
mp Speed Search Results =)
np DPS
np Trip X Delete | Select All [Module | Type
”ps‘[';? [ <] Neme | ] Mumber
imp
mie ] ames
Speed

e e = [ Search results for "MaxHWater Destination Connectors” in strategy PL Office: |
'\zTrip . Source Connector: MaxHWater

‘- Destination Connector 1: MaxHWater
.- Destination Connector 2 : MaxHWater
.. Destination Connector 3 : MaxHWater

p Speed
OnOff
Modulating

Jumping from a Source Connector
Right-click on the source connector and choose Jump to Destination.

£3 MasHWater

I MR,

| Jump to Destination . ||

If there is only one Destination Connector, then that Connector will immediately be displayed. If there is more
than one, then the Search Results window (below the Strategy Drawing window) will display them as a list so that
you can select which one to view.

Des : Maximum @ € MaxiViater
Trip T

Speed n 2
Ps < >

g Search Results (x|
peed

ops X Delete [ Select All |M0m,|E j Type | j
Trip Name l—L[ Number

e [ ] QFnd Q Q

P &1 [ Search results for "MaxHWater Destination Connectors” in strategy PL Office: 001 - Netwe
ip - Source Connector : MaxHWater

seed . Destination Connector 1: MaxHWater

o - Destination Connecter 2: MaxHWater

Julating i Destination Connector 3: MaxHWater

Convert Lines to Connectors
It is possible to quickly convert an existing Line to a set of Connectors (one Source and one Destination).

Right-click on a Line and choose Convert Line to Connector.

: Com,.:ert Line te Connector =

Simtln?ati on properties

If the point is not named, you will be given the option to name it.
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VIEWING POINT PROPERTIES

The Properties panel in the CXproHP Right-hand pane can be used to examine points and routing. To do this,
select a line (representing a connection between two modules, usually meaning a point). The properties of
the point are displayed in the Properties panel:

Properties il x |

<> ?] =l

= Point Details Analog (9) Heati...

Number 9
Type Analog
Value 0.00
Name Heating Valve
Unit °C
=]
Show Line True
Labels Show value anly ..
Number

The point number that represents a
path of data in a strategy. Therearea

Properties Page Mames Modules
Some attributes of a point (such as Name or Unit) are editable and can be changed directly in the Properties panel.

VIEWING BACnet PROPERTIES
If the BACnet Properties option is enabled in the Home tab of the Ribbon,

Home Controller Strategy
anect @C-pr [| Properties |PageNames @Search
connect E Paste e BACnet PropertE| Modules EE Strategy Help
i. Select All List Mavigation Macros [] Reopen Strat
ite Clipboard View

then in the right-hand pane, alongside the Properties panel, there is a BACnet Properties panel:

- ) Input £
Bt —=— _
> Properties BACnewroperties
!

When a BACnet-exposed point (the line representing the point has hexagon indicators near each end) is

selected
Analog Input £l Hystzresis
Al Temperature o ﬁ-

Paint f ﬂ’_r.n. 2 Input At
e .o
Overnidz [ Act
o 7 [one2.00: off 4.00

and the controller is connected in CXprotP

File - Home C

/G/C-Jr%ect the
5‘ Disconnect L?j

e

Site Cli
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then CXpro™ will interrogate the BACnet network in real-time, and live BACnet property values for the
selected point will be displayed in the BACnet Properties panel.

BACnet Properties LA x |

[ Device properties

=
cbject-name (77)  Temperature
object-type (79) 0
object-identifier (... Analog Input (0], ...
present-value (83)  1000.000000
status-flags (1...
event-state (36) normal
reliability (103} Mo Fault Detected
out-of-service (81)  False
units (117) 62
min-pres-value (.. 73000000
max-pres-value (.. 120.000000
cov-increment (22 0.100000
tirme-delay (113) 0 —
notification-class.. 0
high-lirmit (43) 0.000000
low-limit (59) 0.000000
deadband (23) 0.000000
limit-enable (...
event-enable ...

Y

acked-transiti... to-offnormal, to-..

notify-type (72) Alarm ;I

Properties BACnet Properties

Viewing Module BACnet Properties

The BACnet Properties panel can also be used to view and edit BACnet information related to certain modules as
well as points.

The following modules are supported:
e Binary input/output

e Analoginput/output

e Setpoints

e BACnet Schedules

e  Unitron Schedules

e Broadcast transmit and receive

e Modbus Analog and Digital

e Accumulator

e BACnet Trendlogs

Viewing Device BACnet Properties
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At the top of the BACnet Properties panel there is a Device Properties checkbox:

BACnet Properties

I~ Device properties
=]

Alhicct s TTTY

Checking this box changes the contents of the panel from the properties of the selected point or module, to

T ks

the BACnet properties of the device that contains that point or module:

BACnet Properties

[ Device properties

=
object-name (77)
object-type (79)
object-identifier (...
present-value (83)
status-flags (1...
event-state (36)
reliability (103)
out-of-service (81)
units (117}
min-pres-value (...
max-pres-value (...
cov-increment (22)
time-delay (113)
notification-class...
high-limit (43)
low-limit (39)
deadband (23)
limit-enable (...
event-enable ...

acked-transiti...

notify-type (72)

L |

Temperature

0

Analog Input (0), ...
1000.000000

nermal

Mo Fault Detected
False

62

78.000000
120.000000
0.100000

0 —
0

0.000000

0.000000

0.000000

to-offnormal, to-..

Alarm j
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HOW TO ADD TEXT TO A STRATEGY

You can add text comments to a strategy drawing by selecting Add Text from the Strategy tab on the Ribbon:

Strategy

o= [B B
?j Paste

View | Adi e
.iselecdt Al Mmodules Text  Termir

Clipboard
Click the drawing area at the point where you want the text to be displayed.

a4 Strategy1
LY

If}\ Analog Setpaint
o o Room Setpoint

Point

’ Anzlog Input B
: |AI Room Temperature

The Add Text dialog box will be displayed:
g Add Text | < | EE—

ialog Setpoint
'om Setpaint

Font | Cancel |

[ Al RoomTemperature |

To select the type of font in which the text should be displayed, click Font. The standard Windows Font dialog
box will be displayed in which you can choose a font, style, point size, etc. Once you have chosen the required
font, click the OK button.

Font

Font Font style

lm |Hegular

\Arial Unicode MS
BANKGOTHIC LT B
BANKGOTHIC MD

- Effects Sample
I~ Strikeout
AaBbYyZ;
I™ Underine ashyes

Colour.

I Ci=ck - Script
Westem -

Note: Itis recommended that you always use "True-type" fonts. When the printing is scaled, non true-type fonts
do not scale properly.

©ABB 2025 All Rights Reserved.
Subject to change without notice
SOLUTIONS.ABB/HVAC-BUILDING-AUTOMATION 69

MANO133 rev 29


https://solutions.abb/HVAC-Building-Automation

CXprot? | Using Modules

In the Add Text dialog box, type the text that you would like to include in the strategy

F
; Add Text B
E1 D5 floor temp sensors|
@log Setpoint
om Setpoint
Paoiimt
Font | 0K Cancel |
I ' |AI Room Temperature | '
And click OK.

The text will then be displayed on the drawing area on the point at which you clicked the mouse.

3 |4 Strategy1
A

BiDSToor temp sensors:

m Anzlog Satpoint
o “wn  Room Setpoint

| Point

Analog Input 1
AI Room Temperature

HOW TO CHANGE TEXT THAT HAS BEEN ADDED TO THE STRATEGY DRAWING

To change text, select the text, and edit its content or font directly in the Properties pane.

1.832 [ ¥ Properties L x|
_ < > 2 =
iOutput =1 1f Input < 18 degC :
Output=0iflnput =23 degC: - - - - - - =
o Text Output = 1if Input < 18 degC...
Font Arial(8)
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VIRTUAL MODULES

Virtual modules are so-called because they do not result in point values being downloaded to the ABB Cylon®
controllers, i.e. they do not represent real points. The basic function of a virtual module is to allow for greater
flexibility in connecting modules, e.g. backward connection of modules. Virtual modules are also used when
creating macros, as they allow one external point of a macro to be connected, via a virtual module, to many
internal macro points. There are two virtual modules on a floating toolbar — one analog and one digital.

Analog Virtual Module: |®| |®|
Digital Virtual Module: [ 5]

PLACING VIRTUAL MODULES ON THE DRAWING AREA

The procedure for placing virtual modules on the drawing area is similar to that for any other module.

Select the required module from the Virtuals LI5S = a
group in the Moules panel: = ]
Constants »
Controls » |
Functions »
| Math =
Schedules, Timers, and Logic »
Setpoints, Inputs, and Qutputs »
Statistics b
vay 3
Virtuals - |
V Analog Virtual L\\’
V Digital virtual
Properties Page Mames Modules
. . . | | e A |
And click in the drawing area (note the cursor S | | E
changes to the “Module Cursor” during this - oF
process) ture &
Part &) =X
emce [ p— [SE
_ E=
g . .
Point €3
verndeﬁujl )
) T L men ) _
The top left-hand corner of the module’s [ | B
symbol will be placed on the point where the e L
. 1 [l
mouse was clicked. =K
ture 31
Fort ] EX
el o] =l
31
=X
[int=
_ =
g . .
Foint €3
\rerndeﬁml .
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RULES FOR CONNECTING TO VIRTUAL MODULES

1. If the point being connected to the virtual module has a point number, then this becomes the number of
all the inputs and outputs of the virtual module. Any modules that are then connected will have the same

point number.

2. If the point being connected to the virtual module does not have a point number, CXprotP chooses a new
number and this becomes the number of all the inputs and outputs of the virtual module.

e Rules 1and 2 describe how the inputs and outputs of the virtual module are numbered once a
connection has been made. This is why CXproHP will not allow you, once the first connection has been
made, to connect another module that has a number. You can, however, connect a module if its point

number box is blank.

NUMBERING VIRTUAL MODULES

Since virtual modules are not downloaded, they do not use any memory in the controller and do not need to
be numbered in the Block Manager like other modules.

CXprot? | Using Modules

Virtual modules have their own numbering system. The first virtual module used in a strategy is numbered
V1, the second V2, etc.

VIRTUAL MODULES IN MACROS

Virtual modules are useful when creating macros as they allow one input to be used several times.

For example, to create a macro from the strategy shown, it would be necessary to include two inputs in the

macro.
Digital Input 3
DI e ||
— m .....
—

& Boolezn 2
| e & Cutput

Input B Complement

Input C

Input D

Digital Inpat
DI Trigger

o .m T
[ nput B Complement [

-m TInput A
Input B Complement [0

T et & Output
Input B Complemant
Tnput C
Input D

g} Boolsan

3

Ouput [

@ Input C
[ Input D

g'p Bookzan

3 nput C
5 Input D
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Points and Point Values
WHAT ARE POINTS?

A Point is an area in a Controller where data is collected and stored. The data stored by the point is referred to
as the Point’s “value”. Controllers in the ABB Cylon® system include input, output, set, and virtual Points.

Cylon’s Controllers are sometimes referred to as “universal controllers”, where “universal” means that they
can contain both analog and digital Points.

WHAT ARE BLOCKS?

Animportant aspect of CXprotP is the concept of blocks.

Blocks can be seen as units of measurement for the number of modules and points used in a strategy — one
block corresponds to one module, one hardware input Point, one hardware output Point, or one virtual point.

The Managers dialog, accessible from the View menu, allows you to see at a glance which of the blocks in the
controller are occupied and which are not.

When Points or strategies are downloaded to a Controller, the Controller must also be informed of how many
blocks are needed to store the required information.

e If you are using Automatic Download (see page 77), CXproP automatically recognizes how many blocks
are required and it sends this information to the Controller.

e If you are not using Automatic Download you must, when downloading Points and strategies, send
specific “Setup” information to the Controller, instructing it as to how many blocks it must serve in the
strategy. This procedure is called Sending Setup (see page 155).

BLOCK NUMBERS

Animportant aspect of CXprotP is the concept of blocks.
Blocks can be seen as units of measurement for the number of both modules and points used in a strategy.

In the CBM, CBV, and CBT controllers, the Hardware Point numbers are from 1 to 1024, and strategy blocks go
from 1 to 1024. Note however that only Hardware Points 1-24 are used on the CBM24, only Hardware points 1-16
are used on the CBM16, etc.

Block Allocation controller memory
in CBM, CBV and CBT controllers (CBM, CBV and CBT controllers)
In these controllers, there are a total of 1024
Strategy blocks. - -
Hardware points in these controllers do not use et | IS | I Strategy Blocks
strategy blocks, so that all 1024 blocks are available or Points Points
for strategy modules. 1024
1023
1022
1021
Point Numbering 26
in CBM, CBV and CBT controllers
In these controllers, 25
There are a total of 24 hardware points (inputs or 24
outputs), numbered 1 - 24. 23
There are a total of 1024 digital virtual points, 2
numbered 1 - 1024.
There are a total of 1024 digital virtual points,
numbered 1 - 1024.
3
2
1
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POINT NUMBERS

In CXprotD, the connections between modules are referred to as ‘Points’. These strategy Points can represent
physical inputs and outputs on a Controller, or Analog/Binary values (referred to in CXprotP as ‘Virtual Points’).

Each Analog Input, Analog Output, Binary Input, Binary Output, Analog Value, and Binary Value is assigned a
number, and how these points are numbered depends on the controller type.

In CBM, CBV, and CBT controllers, controller terminals (i.e. inputs and outputs) - “hardware points” in CXproP
- are assigned numbers between 1 and 24. Each terminal can be either an input or an output so that there
cannot be two hardware points with the same number. For example, if there is an Analog Input 3 there cannot
be an Analog Output 3 or Binary Input 3 at the same time.

In theory, hardware Point numbers could be up to 1024, but is limited by the Controller hardware so that the
current maximum is 24.

Analog Values (“Analog virtual points”) can be numbered 1-1024, and Binary Values (“Digital virtual points”) can
be numbered 1-1024, so that there could be for example both Analog Value 3 and Binary Value 3.

The combined number of Analog Values and Binary Values that can be exposed on a BACnet network by a
single CBM or CBT is 225. As a result, it is recommended to keep the total number of defined setpoints in a
strategy below this value.

However, it is possible to have up to 100 additional setpoints that are not exposed on BACnet. Such
setpoints in effect act as constants, because they cannot be changed by the strategy nor via BACnet, but
can be set using CXprotD.

In strategy drawings generated by CXprotP for CBM, CBV, and CBT controllers, it is possible to identify a
strategy Point’s nature as follows:

e If the number has brackets around it is a “hardware point” - Analog Input, Analog Output, Binary Input, or
Binary Output.

e If the number is not bracketed but is connected to a circular connection point, it is an Analog Value
(“analog virtual point”).

¢ If the number is not bracketed but is connected to a square connection point, it is a Binary Value (“digital
virtual point”).

e If the line representing the point has a hexagon near each end, then that point is exposed on the BACnet

network.
Analog Ing 4 BAvera 3 Analog Cut 10
Al m?;tpup?:.t Avg = AQ ﬁlw -
Paint € i3] e 2 Input A Average 63 m@ Paint | Override [0
Ovemidz [ R R=al Constant H & Input B
Y
Output A ) 1—' € Input D
}W = Inpt £
Constant A: 0.00; Constant B: 0, 63 Input F
Lot € Input G
bt 3 Input H
0
Digital Iy s Boclean 8 Digital Output 1
DI tighe suieeh e Do e
1] [ Inpur A Output Emﬁ Point Ovemid= [
o Widz Invarter 7 Input B Complement
o' 0 Input C
[ Inpur A {:n.rtpu.rtAE1 1EInp«.rtD
Tnput B Cutput B (5
Input C Outpr 0
3 Inpur D Output D [
Input E Output E [
Input F Output F [0
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Point exposed over BACnet:

[B 100 RescaletoOand 100 3|

A0
O T S <]
—_!-@UppelL'In'nE }
—7|© Inpua

DEFINING HARDWARE POINTS

Hardware points are the inputs and outputs of Field Controllers.
To define a hardware point it is necessary to define the following features:

e Point number

e Point name

e Point type (input, output, digital, analog)
e Unit of measurement

e Damping (for analog inputs only)

Once the required hardware points have been defined in CXproP, they are then downloaded to the Field
Controller for which they are intended.

HOW TO DEFINE HARDWARE POINTS

The procedure for defining hardware points is as follows:

e Specify (Target) the controller for which the hardware point is being defined
e Choose the module from the modules bar

¢ Place the module on the drawing area

e Complete the module dialog box

¢ Save the hardware point definition

e Login to the Field Controller

e Download the hardware point definition to the Field Controller

Defining Hardware points — Target the controller

in the Site List select the BACnet Router and Field Controller that you want to target. This specifies the Field
Controller on which the hardware point is being defined and the location in the database on the PC’s hard disk
in which the point definition will be stored.
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CXprotP | Points and Point Values

Defining Hardware points - Place the module on the drawing area

Once you have selected a module from the modules bar, place it on the drawing area by simply clicking the
drawing area. A dialog box will appear prompting you to enter a name for the hardware point.

Enter a name and click OK to close the dialog box.

The top left-hand corner of the module’s symbol, i.e. the graphical symbol for the analog input point, will be
placed on the point on the drawing area where the mouse was clicked.

Expandable 1/0 - Hardware Points on CBX + FLX devices
In the strategy drawing, IO blocks can be added up to the total on the configured FLX modules plus the CBX

onboard IO.

If a FLX module is deleted from a CBX configuration (in Controller Properties) after the strategy
drawing has been set up, the blocks associated with that FLX’s IO will be ‘greyed out’ to indicate that

they are inactive.

Note:

Comparatar T
A-B
- [Bwesr [ ome@
7| Input B
—— VAVFlw Gkt ¥
& OF pre= Fow 9]
3 Flow/K F-Factor
G C

i

| Complement [ C

@0 Enabi=

- |0%:00 - 17:00; Saturday: 09:00 -

- BACn=t Schedul z
@ ScheduleNo. 1
Ouput [
Complement [
Seconds €
Priority: 16; Monday: 05:00 -
17:00; Tussday: 09:00 - 17:00;

iyt 09100 - 17:00;
00 - 17:00; Fridsy:

17:00; Sunday: 09:00 - 17:00

Unlike CBM UniPuts, if UniPuts on CBX/CBXi devices are configured as Analog Inputs, they have all of
the parameters that are available in Universal inputs. Also, the “Operation Mode” parameters, which a
apply only to certain CBM UniPuts, are not used by CBX/CBXi.

Defining Hardware points - Save the hardware point definition

= Save As
4 L« BACNETIP » strat5 » 001 & | Searchool r
Organise = New folder = @
|, BACNETIP A Nam .
|| Archive
1 DBASE No items match your search.
|| DRAWINGS
I Keypad
|| Macros
| strats
) o0t
. Strategy v < >
File name: | [TIDERER] “]
Seve as type: | V6 Strategy (*532) v

Save the edited strategy by choosing Save or Save As... from the File menu. The Save As dialog box appears:
B

Enter a name under which the strategy should be saved. CXpro™ enters a default file name that identifies the
BACnet Router and Field Controller for which the strategy has been designed, e.g. if Field Controller #3 on
BACnet Router #1 was connected to a VAV, its strategy might be named: "901_03VAVv.s32".
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When the Save As dialog box is complete, click OK. The name of the strategy will appear in the Drawing tab:

4 7 001_03VAV.s32

Connect to the controller

Connect to the controller by clicking the Connect button on the Strategy tab of the Ribbon

File - Home Controller Strategy
’ Cummd * | @ Copy | [
_‘a' Disconnect u LT‘jPaste
Download | __, W
T select Al | g
Site Controller Clipboard

Download the hardware point definition.

You can download a strategy to a controller in just one step, by choosing Download from the Controller tab of
the Ribbon.

e o T T

ne Controller Strategy

| *ﬁCommunications | [i] Downlc:kald
ct %Contmller "S:EWipe ohtrolle
¥, BACnat 2 Auto Online

Configuration

CXprotD will automatically wipe the Field Controller’'s memory, download the hardware point, and send the
set-up to the UC, i.e. the number of blocks it is to serve. While it is doing this, it will display the Downloading
window. As the point is being downloaded, the Downloading window displays the progress and in the System
status section, it shows which of the 3 stages (wiping memory, downloading strategy, or sending set-up)
CXprotD is currently completing. If only one hardware point is being downloaded, the process will take place
so quickly that the downloading window will appear only for a brief moment.

It is more usual to download an entire

; Downloading X
strategy, with several hardware
points and other modules. In that Controller
case, the Downloading window will |—
e Harcware points | | -2

remain visible for longer and the arduare Faints =
progress of the download will be strategy Blocks | 2
measured in the progress bars. GO O TR A

Digital Setpoint Values

BACnet Point Config | |

Sending strategy to controller

Close | Abort I

©ABB 2025 All Rights Reserved.
Subject to change without notice
SOLUTIONS.ABB/HVAC-BUILDING-AUTOMATION 7

MANO133 rev 29


https://solutions.abb/HVAC-Building-Automation

CXprotP | Points and Point Values

SUMMARY OF PROCEDURE FOR DEFINING HARDWARE POINTS

In practice, the procedure for defining hardware points is as follows:

e Define all hardware points whose values are already known, in the module dialog boxes and place the
corresponding modules somewhere on the drawing area.

e Save the strategy.

e Click Communications Setup from the Communications menu and enable Automatic Download.

e Login

e Choose Download from the Communications menu.

POINT NUMBERS FOR INPUTS AND OUTPUTS

When another input module is selected, CXproHP automatically assigns it to it the next unused input, i.e. the
unused input with the smallest point number.

Defining digital and analog outputs follows the same principle. As outputs are numbered in the range 9 to 16,
CXprotD assigns point number 9 to the first output.

For CBX and CBXi devices, point numbers are defined by the I/O module in which they reside —internal I/O on
the CBX/CBXi device are I/O module “0”, any attached FLX devices are |/O modules 1,2 or 3

1/0 Module Terminal Number Type
CBX-8R8 1...8 Universal Input
9...16 UniPut™
FLX-8R8 adress 0 1..8 Universal Input
(FBXi only)
9...6 UniPut™
FLX-8R8 adress 1 101 ...108 Universal Input
109 ... 116 UniPut™
FLX-8R8 adress 2 201 ...208 Universal Input
209 ... 216 UniPut™
FLX-8R8 adress 3 301 ...308 Universal Input
309 ... 316 UniPut™
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A SHORT CUT TO DEFINING HARDWARE POINTS

To save time when defining the hardware points you can bring the definitions directly to the database by
using the Database Interface.

The types (“A” for analog, “D” for digital), point names, and point numbers and units can be written as
comma-separated or tab-separated lists in a word processing application, copied and pasted via the
clipboard to the Database Interface. This avoids unnecessary writing work and typing errors. Using external
applications for text handling also saves time because of their Copy, Search, Replace, and Pasting features.

The point list shown below was created in Microsoft Windows Notepad. Other software applications, such as
Excel and Word may also be used.

o

A Room Temperature 1 @ 1

A Room Temperature 2 °c 2

A Outair Temperature South-East °C 3

A Outair Temperature North-West °C 4

A Supply Water Temperature 1 °C 5

A Supply Water Temperature 2 °C 6

A Valve 1 % 9

A Valve 2 % 10
D Pump 1 ON/ OFF 11

D Pump 2 ON/ OFF 12

When preparing a hardware point definition list you must separate the values (type, point name, unit, point
number, etc.) by using tabs or commas, not spaces.

Note: This shortcut for defining hardware point values should only be used for UCs that do not already have
hardware point definitions in the database on the PC’s hard disk, since existing database entries are not
deleted. The Database Interface does not check for uniqueness. This means that there is a danger of
defining more than one entry per point, which will cause a lot of confusion in the later use of the point in
other programs.
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WHAT ARE UNIPUTS™?

A UniPut™ can act as an input or an output so that you can now have a controller that fits your BMS design
exactly - no need to use an extra controller to gain an extra output while leaving an input on the original
controller unused. BMS sites can make more efficient use of a smaller number of controllers, saving on cost
and complexity.

A UniPut™ can be configured as any one of the following:

e anActive Input, reading between e ... 16 V at 40 KQ, with 9-bit resolution.
e an Active Output, outputting @ ... 18 V at a maximum load of 26 mA
e a Digital Volt-Free contact.

e adigital input detecting the presence or absence of 24Vac
or
e arelay switched output.

The ABB Cylon® range of controllers has several different combinations of UniPuts™ and standard Universal
Inputs.

UniPuts™ are used in controller strategies through standard Analog and Digital Input and Output modules.
However, before it is possible to add a module for a UniPut™ to the strategy, the UniPut™ must be configured
using CXprotP's I/0 Terminals dialog box.

CONFIGURING THE FIELD CONTROLLER’S INPUTS AND OUTPUTS

Cylon® controllers can have a mixture of Universal Inputs and UniPuts™. The Universal Inputs are fixed as
inputs, but UniPuts™ may be configured as analog or digital inputs or outputs. Universal Inputs and UniPuts™
are configured using the I/O Terminals dialog.

HOW TO OPEN THE "I/O TERMINALS" DIALOG.
The I/O Terminals dialog can be opened by clicking the I/O Terminals button in the Strategy tab of the Ribbon:

raoller Strategy

{4 copy E T TgBacnetr
[# Paste & Bacnet L
ad | o, Add 1O Reorder
L) select All | Modules| Text Termi Madules 1 Strategy
ler Clipboard Strategy
r
1/0 Terminals
Analog Input Address | Type | Name I Sensor | Dither, Input ... | Temp... | Powe... | 10V ... I Temp I Low Val.. I High Va | Low Thr.. |
2 Universal Input Heating Water Temp PT1000 14Bts 0-10.. Centi. MNomal MNomal Pulsed 0 0 0
Digital Input 3 Universal Input Temperature PT1000 14Bts 010.. Centi. MNomal MNomal Pulsed 78 120 -50
Analog Qutput
Digital Output
All Assigned
< >
Unassigned
Address | Type | Can move to
1 Universal Input Analog Input Digital Input
4 Universal Input Analog Input Digital Input
18 Uniput with Relay Analog Input, Digital Input,Analog Output, Digital Output
19 Uniput with Relay Analog Input,Digital Input,Analog Output, Digital Output
20 Uniput with Relay Analog Input Digital Input,Analog Output, Digital Output
Crea_|
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The 1/0 terminals that have already been configured are listed in the top panel. The configuration of these
1/0 terminals can be adjusted directly in the top panel.

1/0 terminals that have not yet been configured are listed in the bottom Unassigned panel. For each of these,
the types of I/0O as which it can act are listed in the Can move to column.

In the left-hand panel there is a list of the /0 natures to which terminals can be assigned - Analog Input, Digital
Input, Analog Output, and Digital Output.

To assign an Unassigned terminal, first select an appropriate “nature” in the left-hand panel,

170 Terminals

Analog Input Address | Type | Mame | Outpu | Low Val I High V
Digital Input

Analog Output

Digital Output

All Assigned

There are no tems to
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then select the Terminal and drag it into the top panel.

/0 Terminals
Analog Ingut Address [ Type [ Name [ Outpu... | Low Val... [ High Va... | Sequen... [ Low Unit [ High Unt [ Exsti... [
Digital Input
Analog Output %;,
Digital Qutput
All Assigned
There are no items to show in this view.
Unassigned:
Address | Type | Canmove to [
1 Universal Input Analog Input Digtal Input
4 Universal Input Analog Input Digtal Input
Uniput with Relay Analog Input. Digital Input.Analog Qutput.Digital Outps
13 Uniput wih Relay Analog Input Digtal Input, Analog Output Digital Output
2 Uniput with Relay Analog Input Digtal Input Analog Output Digital Output
1/0 Terminals
Analog Input Address | Type | Name [ Outpu... [ Low Val... [ High Va... [ Sequen... [ Low Unit | High Unit [ Besti_. |
18 Uniput with Relay Nomal 0 255 0 off On [}
Digital Input
Analog Output
Digital Output
All Assigned
Unassigned
Address | Type [ Canmove to [
1 Universal Input Analog Input.Digtal Input
4 Universal Input Analog Input.Digtal Input
19 Uniput with Relay Analog Input.Digtal Input Analog Output Digital Output
20 Uniput with Relay Analog Input.Digtal Input Analog Output Digital Output

Note: Terminals marked Universal Input type are not UniPuts™, so they cannot be selected if Analog Output or Digital
Output is selected in the left-hand panel
Enter a Name for the new point:
1/0 Terminals
Analog Input Address | Type Name Outpu. Low Val High W Low Unit
—n——_m
Digital Input
Analog Output
Adjust the parameters of the I/0 terminal as required:
1/Q Terminals
Analog Input Mdress Type Name Outpu. Low Val High Va. S Low Unit H\ h
Digital Input w
Analog Output Helay/ Iriac
Ninital Notnnt
Repeat this process until all required UniPuts™ have been configured.
Note: When the I/O Terminals dialog is closed, point modules will be added to the strategy drawing for any newly-

configured terminals which were not already in the strategy.
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CHANGING THE CONFIGURATION OF A UNIPUT™ OR UNIVERSAL INPUT

Any editable parameter of a configured |/O terminal can be adjusted by selecting it in the I/O Terminals dialog:

Dither . | Input Tem) Powe 10V Tem Low Val High Va Low Thr

[ [ 12 Bis [0-10__ Centi ] Nomal [ Nomal [Pused DS [0 ]|
120 -50

14Bts  0-10 Centi Nomal  Momal Pulsed B

An 1/0 terminal’s behavior can be changed from one nature to another, e.g. from Digital Output to Analog
Output, by dragging the point to a different entry in the left-hand Pane:

1/0 Terminals

Analog Input Address | Type Name Outpu... | Low Val... | High Va... | Sequen... | Low Unit | High Unit | Exsti...
T v Ay | Water Pump Erbe MNomsl [0 125 [0 Jor _ Jon [0 |

Digital Input

Analog Outpu

e
Digital Output

All Assigned

1/Q Terminals

Analog Input Address | Type | Name | Outpu... | Low Val... | High Va... | Sequen... | Low Unit | High Unit | Existi... [

Digital Input

Analog O .-k

Digital Output

All Assigned

170 Terminals

Analog Input Mdressl Type | Name | Low Val... | High Va... | Lo Str. High Str... | Output ... | Sequen... | Lnit | Existi... |
17 Uniput with Relay  Chiller 0 10000 1} 100 0.000000 0 T 0
Digital Input 18 Uniput with Relay 0 10000 ] 100 0.000000 O T 0

Analog Cutput

Digital Output

All Assigned
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Example: Configuring Analog Input module properties

01_01.532 [ > | Properties n B2
A | < > 72 |AnalogInput [1] -]
=
Type Analog Input

General Information

Type

Service Order
Mame
Synchronised Status

Manual override

1
Outside Air Temperature
Checking...

=]
Analog Ino T Point type Input Analog
Al outside A Low threshold 78
emperature o
Paint ) TJ—l High threshold 120
Overide o Lower sensor range -50
Upper sensor range 150
Input error 0.0000
Exponential filter 20
Sensor type PT1000
N Unit <
Temp o Averaging 0
O ||®
Overnd=z '
C Point Analog (1): 0.00 Qutside Air T...

Digital

> Properties  Page Names

(not editable) shows that this is an Analog input.

Service Order

Modules

CXprotP | Points and Point Values

(not editable) indicates the order in which this block will be processed by the controller.
Name

Shows the text identifier for the point, which must be no more than 24 alphanumeric characters. Spaces,
commas, full stops may also be used. Each point in a Field Controller must have a point name that is unique
within that controller.

Synchronised Status

Shows whether the strategy drawing matches the strategy in the connected Controller.

Constants
Low Input Threshold / High Input Threshold / Low Strategy Value / Hight Strategy Value

The threshold settings specify the on/off turnover point on a digital input or output.
Input Error

A constant with the same unit as the input value, which is added to the input value to compensate for errors
ininput arising from factors such as resistance of long cables or positioning of sensors. Temperature values
(sensor type PT1000) are corrected in mv. To compensate for 1 °C, the input erroris 2.5 mv. For example, a
decrease in temperature of 2 °C requires an input error of -5.@ mV to be entered. This feature is only available
for analog passive inputs.
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Exp. Filter Constant

An individual time constant for the analog input., behaving as a damping filter. The measured input value will
be averaged over the time specified in seconds by the Exponential Filter constant, so that short-term variations
of the measured value can be filtered out if the Exponential Filter value is longer than the sensor response time.

Sensor Type
Select the required filter from the Sensor Type list. Some of the available options are:

e Pti1eee: This configures the analog input for reading temperatures from a standard Pt1000 sensor. The
Controller will convert the measured resistance (voltage) to a temperature signal.

e 0-10 V: This converts the hardware voltage signal e..1e Vv DC to a software value in the range 0..100 %. For
example, the voltage signal 6.7 v DC will be converted to 67.0 %.

e 0-20 mA: This converts the hardware current signal 0..20 mA to a software value in the range 0..160 %. For
example, a current of 15.0 mA gives the software a value of 75.0 %.

e Pulse(V/F): This is designed for reading voltage-free contacts, which can be operated at a frequency of
up to 12 Hz. The value of the input will be incremented by 1 after each detected pulse. Evaluation and
resetting of the counter will be done by using the Meter Module (module 63).

Additional sensor types can be allowed for by defining extra units of measurement - see Appendix :: Adding
units of measurement to the systemon page 207.

Unit

The Unit list box contains a collection of text strings, one of which will be displayed together with the point
value. Choose from the list the type of unit that corresponds to the type of input, e.g. if an analog input point
represents a temperature reading in degrees Celsius, you may choose DegC from the Units list box. If
necessary, additional units may be defined in the c:\cxproHD\ (SITENAME) \SYSTEM\site. ini file. Appendix :
Adding units of measurement to the system on page 207 contains details of how this is done.

Outputs
Point
The output of the Analog Point module assumes the type, name, and units of the point module. A point

number is automatically assigned (though this can be edited by selecting the connecting line, which
represents the point itself)

Point numbers 1...8 represent controller inputs 1...8.
Point numbers 9...16 represent controller outputs 1...8.
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VIEWING USED BLOCKS
To check which blocks have been used in a strategy, select Strategy Details from the Strategy tab of the Ribbon:

A T Panry

T E Wi BACnet Points E
&} BACnet Units

Add 1o Reorder | Strateqy

i 5elect All Text Terminals Modules DE‘_IE 5“5“KD“5“5 Help

Clipboard Strategy

Strategy

ﬁ Copy
E Paste

n P nnd Rl -3

This opens the Strategy Details dialog:

Strategy Details “

Strategy Blocks | Controller | Resources | Pairts Manager |

001 Comparater ~
002 BACnet Schedule

003 Absolute Value

004 Masimum

005 Analog Gate

006 Limit to Dor 100

007 Rounding

008 Integer Constant

003 Real Constart

010 VAV Dfferential Pressurs
011 Mot Used

012 Mot Used

013 Net Used

014 Not Used

015 Mot Used

016 Not Used

017 Mot Used

018 Not Used

019 Net Used

020 Mot Used

021 Net Used

022 Mot Used

023 Mot Used e

Viewing the list of blocks

Click on the Strategy Blocks tab to see which of the available blocks have been used in the active strategy and
which have not.

Strategy Details “

Strategy Blocks | Controller | Resources | Pairts Manager |

001 Comparater ~
002 BACnet Schedule

003 Absolute Value

004 Masimum

005 Analog Gate

006 Limit to Dor 100

007 Rounding

008 Integer Constant

003 Real Constart

010 VAV Dfferential Pressurs
011 Mot Used

012 Mot Used

013 Net Used

014 Not Used

015 Mot Used

016 Not Used

017 Mot Used

018 Not Used

019 Net Used

020 Mot Used

021 Net Used

022 Mot Used

023 Mot Used e

In the above example, the Strategy Blocks tab indicates that the first block (block no. @01) is being used as a
Comparator module.

Block 802 is an BACnet Schedule module, block 003 is an Absolute Value module etc.
Blocks 011 to 023 have not been used in the strategy.

To view the remaining blocks (in the above example, blocks 024 ... 1024), use the horizontal scroll bar to move
down the Strategy Blocks tab.
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Viewing the blocks associated with each point

The Points Manager tab allows you to examine points in a strategy, listing the strategy blocks to which each
point is connected.

Strategy Details u
Strategy Blocks | Controller | Resources  Points Manager
E
Hardware Analog Poirts
-3 Strategy Blocks
2

=] Strategy Blocks
Hardware Digital Poirts
Anzlog Paints

[#-#= Digital Pairts

In this example, Analog Point number 2 is connected to strategy blocks numbered 3 and 4.
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KEEPING CXPROHD AND CONTROLLER STRATEGIES IN SYNC
STRATEGY COMPARE

When connected to a site, it is possible to compare the strategy in CXpro with that in the Controller.
To compare CXproP and Controller strategies,

Connect to the Controller by clicking on the Connect button in the Home tab of the Ribbon:

==
File - Home Controller Strategy
’ CoEed: @ Copy [ Properties | Modules |Ez| Strategy
Q’Dlsc- nnect LﬁPaste Na\ugatlon Macros I:‘ Reopen
e ite
i _iSelect All List EPage MNames @Sear(h
Site Clipboard View
Site List o B 4 Strategy1

-5 001 - Metwork
=1 001 - 001 - UCU3213V

Right-click on the Field Controller in the Site List and select Strategy operations > Compare Strategy To Controller,

B-Za PL Office
-5 001 - Network
| O i
2, Sample Apps 7 T [ Eemim
E‘“"sg Empe pps A Analog Inpt
= 001 - Wet o Temperaty
Copy Strategy To
Strategy operations 3 I:‘C Reorder Module Blocks
Export Aspect Data
Update BACnet EDE Data Compare Stratelg\y To Controller
S, 1122 - romgrerormprge T L T

Alternatively, you can select Compare from the Controller tab of the Ribbon.

12 Controller Strategy
%Commumcations Ii"l Download @Co are E:';Version r.{B
t | GG controller '} Wipe Controller 7] show Compare | B Time and Date B} st
% BACnet ﬁ Auto Online Maximums :.' L
Configuration Operations

Only strategy modules are compared.

Note: Parts of the strategy that can be modified using tools other than the Engineering Tool (e.g. CCView) are not

compared. For example, the sample interval on a Datalog module is excluded from the comparison, but the
Type of datalog is included.
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Compare Process

When the Compare process is requested, the Select Items to Compare dialog is displayed:

Select tems to Compare

V¥ Hardware Blocks

[ Range IDD1-DZ4

[V strategy Block:

I~ Range |001-1024

v Analog Setpoint Values

™ Range IDD1-1[)2d

[v Digital Setpoint Values

I~ Range |001-1024

¥ BACnet Paints
I~ Range |001-224

[¥ select/ deselect all

Compare | Cancel |

This allows specific subsets of the strategy to be compared if required.

Clicking the Compare button starts the process, and shows the Uploading progress dialog:

Uploading *

Controller

7

Hardware Points ’i

Strategy Blocks ’i
Analog Setpoint Values
Digital Setpoint Values

BACnet Point Config li

Receiving analog setpoints...

=
I
)

1T

Close Abort

and when the upload is complete, a comparison report dialog is displayed

Site: BACnet Real Comms Controller Ne.: 2 Field Controller No. : 1

Select blocks to update

Type [ senvice or... [ Block Type | Difference

FLX Module 1 Configuration FLX Module at address <1+ is configured on cantroller but is not configure
Strategy Blocks 1 Boolean The Output *Complement” has address: - <Unconnected> on the Controlle
Strategy Blocks 3 Adder/Scaler The Input “Input B° has address: - <Unconnected> on the Controller - <2»
Strategy Blocks 6 Modbus analog The block of type Modbus analog at address 6 on the strategy is not presen
Strategy Blocks 1025 FLX port configurat.. The “Module at 1" value is: - <FL¥<4R4> on the Controller - <None> on the
< >

* Show only blocks with differences " show all blocks

-PC c

A | Jump o, ~

I~ Compare is complete, (Select to start a new upload.)

This dialog lists all of the differences between the PC version of the strategy and the Controller version, with a
facility to jump to each of the modules that contains a difference, so that the difference can be manually
resolved.

When the differences have been resolved, clicking on the Close button terminates the Compare process.
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STRATEGY SYNCHRONIZATION

CXproHP will evaluate whether its copy of the strategy and the Controller’s are fully synchronized at the
following times:

e When amodule is selected in the strategy drawing

e When a strategy is closed following a partial download
e When Scan Mode is enabled

If any potential discrepancy is found, the user will be prompted to run the Strategy Compare feature.

Modules in the drawing that do not match the controller strategy are marked with an icon showing a red
circle containing an “x” to indicate that it is no in sync:

A-B TR .
NS o A Output [y
) Input B Complement [

The user is not blocked or forced to take any action, and no changes take place in the background.

The checks apply to all strategy modules with the following exceptions:

» Macros

« DI Modules

« Set Point Modules

« |0 Modules (On UC16 controllers)
« Comment Modules

When a module properties are edited:

When a module is selected, its Synchronised Status is displayed in the properties inspector:

Synchronised Status Checking...

When a strategy is closed following a partial download:

A partial download takes place when the Automatic Download feature is disabled. In this case, selecting Compare
from the Controller tab of the Ribbon will open a Select items to Download dialog allowing different subsets of the
strategy to be downloaded individually.

This dialog is similar to the Select Items to Compare dialog used in the compare process (see Strateqy Compare
on page 88).
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However, if you carry out a partial download the setup block is not downloaded. The next time you close the
strategy, the Synchronisation process will register a discrepancy between PC and Controller strategies. When
this happens, a warning will be displayed stating that the “setup block was updated but not downloaded” and

suggesting that the setup is downloaded:

@ The setup block was updated but not downloaded to the controller.,
This may cause synchronization issues between the controller strategy
and PC strategy. It is strongly recommended that you download the

setup to the controller before continuing.

Do you want to continue anyway?

Yes | No I

Clicking on the No button will allow you to save the setup block. If you do not wish to do so, click the Yes
button and the strategy will be closed without updating the setup block on the Controller.

When Scan Mode is enabled

When Scan Mode is activated (see Activate scan mode on page 125) the PC version of the strategy is compared
to the Controller version and if any discrepancies are found, the mismatched modules will be identified by a
flashing ‘highlight box’ and a message in the status bar will inform the user
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READING LIVE POINT VALUES (LIVELOG)

The LivelLog feature in CXprotP allows you to read the values of points in the controllers on your site (i.e. it
reports “live” or in real-time from the site).

As well as reading point values, the LiveLog also scans time schedules, the BMS network, and its Fieldbusses,
and, if configured to do so, it will log those values to a text file. It can also show HOA values.

CONFIGURING LIVE LOG

Livelog can scan just one strategy, can either append to the log or wipe the log each time it starts and can write
the log to a file for later analysis.

To set up these options, select LiveLog Setup from the Controller tab of the Ribbon

Contraller | Strategy
& Communications |ty Download [, compare Bversion  BoardDiagrostis . 1 LA [ %wag Setup = =
3 Controller ¥} Wipe Controller [7] Show Compare | T} Time and Date G} statistics QU O It F3 LiveLog Report Z <
" = = Scan  Override Livelog Interface Config!
& BACnet & Auto Online B Maximums ‘& Lock and Unlock Point . Upload BACnet Points | guilder
Configuration Operations Testing Keypad
w0l [« 001_01.532 b x| |[Properties | B LiveLog Setup

This opens the Livelog Setup dialog.

Livelog Setup
Scan —————— [ Update
Al Opened Strategies [ Append
(+ Active Strategy ' Querwrite
Scan Interval [<60s) I 5

¥ LogTo File

| \s¥sTEMiowin.lag

|

In the Update section, select Append to cause the LivelLog to add new scan data to the end of the existing list, or
Overwrite to cause the Livelog list to be replaced each time a scan is completed.

Update
" Append
& Qverwrite

If you chose to scan the Active Strategy only, enter a number between 1 and 60 in the Scan Interval edit box. This
represents the number of seconds CXprotP will remain idle after scanning the strategy before it will scan the
strategy again. (The LiveLog continuously scans the strategy until you press the Stop Scan button on the Livelog
dialog)

If you would like the results of the LiveLog to be written to a text file and saved, click the Log to File checkbox.
By default, logs are saved to \SYSTEM\iowin. log

To view the contents of the LiveLog text file, click LiveLog Report in the Controller tab of the Ribbon:

Controller | Strategy

*& Communications | gt Download B, compare B version I3 BoardDiagnostis 1 [ [E5] B tivelog setup =1 [
3 Contraller '} Wipe Controller £ Show Compare | B Time and Date B2 statistics Q"o R LieLog Report 7
i = = Scan Override Livelog "[% Interface Cor
F BAChet  Auto Online B Maximums 3 Lock and Unlock Point ® upibad BACnet Points | guilder
Configuration Operations Testing Keypac
A |« 001_01.532 b % | |Properties

This will open the log file in your default text editor:

& iowinlog - Notepad = B
File Edit Format View Help

| Currently Scanning Scanning Real Points (1-16)

@e1_@1.s32 PL Office @gl - Network 081 - 8@l - CBM24

@e1_p1.s32 PL Office @81 - Network @81 - 881 - CBM24
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Select from the Site List the site the BACnet Router and Field Controller containing the point that is to be read.

Connect to the controller by clicking on the Connect button in the Home tab of the Ribbon:

== I
File = | Home Contraller Strateqy
’ aned @ Copy [| Properties Modules E Strategy
_é' Discdnnect L‘ﬁPaste Navigation Macros [] Reopen
o Site
[selectal | (it [ Page Names [&] search
Site Clioboard View

Activate LiveLog by clicking the LiveLog option in the Controller tab of the Ribbon

File ~  Home  Controller Strategy

& connect | ¥ Communieations | gy Download [, compare B version 2 Board Diagnostics "_'q rl@ = R Livelog Setup c
¥ Disconnect Controller Wipe Controller £ Show Compare Time and Date EJ Statistics 1. [ Livelog Report ‘
~ | B
e = = scan Override Livelolg, Intert
# BaCnet  Auto Online & Maximums ‘& Lock and Unlock Point . Upload BAChet Points | gyl
Site Configuration Operations Testing
Site List W | \i 001_01.532 Livelog (Shift+F3)
| E-§) Sites A H View Livelog output.

This opens the Livelog dialog:

Livelog

— Strategy Target
Hardware Foints ]

Hardware Analog Points

| Desk

|Cylon BACnet Router 43 ane

|CBx CCBXB30792F

 Filters
Hardware Digital Points

Analog Setpoint

Digital Setpoint

Point Name I

[~ Range I

Example: "3.7.5-16"

FLX Modules [ All 1/0s hd

Analog Points

Point Number | Paint Name

| Point Type | Walue

| Cvenide | Time

Digital Points

There are no items to show in this view.

View Report

Oweride |

Stop Scan I

Clear |

Cloze |
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LIVELOG - SCANNING DEFINITION

In the LiveLog dialog, you can view the following parameters for the LiveLog, and change them where it is
appropriate to do so:

e The type of points to be scanned
e Whether or not points will be overwritten

Strategy Target

Strategy Target [ pi Office | 001 - Network | 001 - 001 - CBM24

This window shows the target of the currently selected strategy. The values cannot be changed in the LivelLog
dialog.

Scanning definition

Scanning

* 10 Points
" Analogs
" Digitals

—

The Scanning section of the LiveLog window allows you to decide which values to scan.

To scan the values of the controller’s hardware points, click Hardware Points.

To scan analog points only, click Analogs in the scanning section. To scan a specific number of analog points,
enter a range of point numbers in the edit box under Digitals.

To scan digital points only, click Digitals in the scanning section. To scan a specific number of digital points,
enter a range of point numbers in the edit box under Digitals.

Override Status

When a scan has been stopped, you can change the override status of any point listed in the LiveLog window
by selecting the point from the list and clicking on the Override button at the bottom left of the window.

I Point Mo | Point Mame | Point Type | Value | Cwerride | Time
002 Heating Water Temp Analog 0.01 15:44:08

Qutside Air Temperature Analog 15:44:.09

O‘vet'de | Stop Scan | Clear |

This opens the Override Hardware Point dialog, where the current override status of the point is displayed and
can be changed if necessary.
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MANUALLY OVERRIDING POINT VALUES - THE OVERRIDE POINT
DIALOG

OVERRIDING POINTS

Point values can be overridden using the Override Hardware Point dialog, which allows you to set a pointin a
strategy to a particular value, regardless of conditions at a controller’s inputs or outputs, or conditions within
the strategy itself.

e When a hardware output is manually overridden (disabled), the modules in the strategy do not affect the
point value.

e When a hardware input is manually overridden (disabled), the hardware signal which is connected to the
input (PT1000, transmitter, dry contact, etc.) is ignored by the input.

In both cases, the overridden hardware point keeps the value that is assigned to it in the Override Point dialog.

The only way to change the value of a hardware point which has been manually overridden to another
specified value is to use the Override option again, assigning a new value in place of the first.

Some specific controllers, such as CBX-8R8-H and FLX-4R4-H, have “HOA” controls built-in to them. When
these HOA controls are active, CXprot cannot affect them but can display the overridden values, but not
affect them.

Removing manual override status from a hardware point (enabling) means that the point can now be
influenced by the connected hardware or strategy once again. The length of time that a hardware point will
remain in the overridden state can be set in CXprotP.

It is only possible to disable and enable hardware point values from CXproHP if the PC is connected to a
controller (either directly or via a BACnet Router) and CXprot Connect button is active.

Whether hardware points are overridden by the CXproP Override Point dialog, or by HOA switches on the
Controller itself, CXprotP is aware of the override state and value and displays it in the LiveLog window.

| Point Mo | Point Name | Point Type | Value | Override | Time | | Point Mo | Point Mame ‘ Point Type | Value | Override | Time

Anl Qutput 209 Analog 46.00 11:31:09 Anl Qutput 209 Analog 15.00 One Hour 11:32:50

| Point Mo | Paint Hame | Point Type | Value | Override | Time | | Point No Point Mame Point Type | Value Override Time

Anl Qutput 209 Analog 15.00 Continuous : 11:33:18 209 Anl Qutput 209 Analog 11:31:39

The point’s Strategy module has a digital output labeled Override, which is set to a value of 1 if an override is in
effect (i.e. the hardware point is ‘disabled’), or @ if the point is not overridden (i.e. the point is ‘enabled’).

Analog Output 17 Digital Output 20
AO Analog Output ‘ Dﬂ Bailer Enable
£ Paint | om0 [[ Point | [oveme[0)
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USING THE OVERRIDE POINT DIALOG:

To open the Override Point dialog, either:

1. Right-click on a line or module and select

o =

0 Show Point Route

Convert Line to Connector

Simulation properties

Override Hardware Point Value

Ohe— . . .

2. orclick on the Override button in the Livelog dialog

Livelog of St |

Serategy Teget  [primest [001 - Networr name

[001- 002 - cexens

Mose Pont No | Point Name Pown Type
001 Named pownt
& Pomts

[(Bremae ]

Stop Sgan Clear

Points and Point Values

Override Hardware Point Value from the context menu:

Analog Input 3 Sobtraction
Al Named point o A-B-C-D

Display Options ¥

Override Hardware Point Value

The relevant Override Hardware Point dialog (analog or digital) will open:

Owverride Hardware Point

Point Type I Analog

Point Mumber I i

" 1Hour
" Midnight ¢ Continuous

Override
Duration

Owerride Hardware Point

PointType | Digital

Point Mumber I 2

Override « D

1 Hour

value | 1000,000

Change I

Durati
Hraten " Midnight ¢ Continuous
Value IOF’F ;l Change I

Status
’V Received point value from controller

Close |

Status
’7 Received point value from controller

Close |

The Override Duration can be set to one of the following states:

e inactive at all times - Off

e active until the controller time passes 00:00 - Midnight
e active for one hour from the time at which it becomes active - 1 Hour

e active at all times — Continuous

e If the override is caused by a Controller’'s HOA switch, the override state is reported as “H0OA”

The "Midnight' and '1 hour' options are provided to conveniently avoid problems that could arise if the override

is not removed when it is no longer required.

Note: Even if 'off'is selected in the Override Duration for Hardware Point section, setting a value (analog) or state
(digital) for the point will still have an effect. When the Override button on the dialog is pressed, the value is
sent to the point in the controller strategy, which stays at that value until the next time that the controller

scans its strategy.
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Enter a value for the point.

In this instance, a value of 100 is being is being entered for an analog value [100 change |
point.

A value of off or 0n can be entered for digital points. vaive [off <] [chenee |
Select the length of time that the value of the point will be changed in Override & BE @ e

Bralimn . G

the Override Duration for Hardware Point section of the dialog.

The point will be set to the entered value when the Change button is value [100 Cha
pressed:

Click the Close button to close the dialog.

Notes about overriding BACnet points
Inputs
When an input is overridden via CXprotP, both the “out of service” and the “override” flags are
automatically set.
When an overridden input comes out of its CXprotP override both the “out of service” and the “override”
flags are reset. It will be put into service regardless of the state it was in prior to going into override.
To override an input via BACnet, the “out of service” flag is manually set by writing to the “out of service”
property. Then the desired value is written to the present-value. The OWS can clear any CXprotP override by
putting the point back into service and then back out again. From CXprotP side, the “override” flag will
disappear and be replaced with an “overridden” flag.
Putting an input in service will clear all overrides both CXprot2 and BACnet and will flag the change
appropriately on both protocols.
Outputs
When an output is overridden via CXprotD, both the “out of service” and the “override” flags are set. The
information in the present-value property will still be delivered to the hardware layer despite being out of
service.
When an overridden output comes out of its CXprotP override, the point is put back in service, and both the
“out of service” and the “override” flags are reset.
To override an output via BACnet, it is presumed that the priority array will be used, and clear all overrides
and flag the change appropriately on both sides.
All 1/0 blocks have an output labeled Override. This output is true any time the pointis “out of service” or
“overridden” via CXprotD. This way the point reflects the status of the data regardless of whether it is being
overridden via BACnet or CXprotP.
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HOW TO ENABLE A HARDWARE POINT VALUE (REMOVE MANUAL
OVERRIDE STATUS)

Removing manual override status from a hardware point (enabling) means that the point will once again
respond to hardware connections or strategy conditions.

If the override duration on a hardware point has been set to 1 hour or untilMidnight the point will be enabled
when the specified period has elapsed. However,

e If the override is identified as “HOA” you must use the switch on the Controller to disable it.
o if the override duration has been set to Continuous the following procedure must be carried to enable the
point:

Open the Override Point dialog by selecting Change Point from the Controller tab of the Ribbon or by clicking
on the Override button in the Livelog dialog, and select the point to be overridden.

Select the Off option in the Override Duration section of
the dialog,
Click the Change button to apply the change. g"e".ide j}gfﬁ " tHour
uration . .
Midnight { Continuous
Click the Close button to close the dialog.

If you opened the Override dialog from the Livelog dialog, then to see the new value of the point, click the
Restart button.

The next time the LiveLog scans that point, its new value will be displayed. The LiveLog window displays
the symbol q beside the value of points that have been changed.

Note: Double-clicking a point number in the LiveLog window places an asterisk beside it allowing it to be
monitored more effectively.
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CXprotP | Points and Point Values

HOW TO CHANGE THE VALUE OF A SETPOINT

The value of a set point can be changed using the Change Set Point Value dialog box, in a similar way to changing
the value of a hardware point.
The procedure for changing the value of a setpoint is as follows:
To open the Change Set Point Value dialog either:
1. Right-click on a setpoint module or the line and click Change Setpoint Value option from the context menu:

“Anakog Setpoint = o o ‘Abschitz Vahe
(}\‘sﬁmnwm T
I S P =
Show Point Route

a a1 Digital Satpaint : o C Convert Line to Connector
L Digital Setpoint S S o
----- - Simulation properties

Change Set Point Value |- o

..... . Change 5et Point Value

2. orclick on the Override button in the Livelog dialog:

[ Paintne | Point Hame | PointType | Value [ override | Time. ]
002 Heating Water Temp Analog 0.01 15:44:08

Qutside Air Temperature Analog 0.01

. Oneyqe Stop Scan Clear
The relevant Change Set Point Value dialog (analog or digital) will open:
Change Set Point Value Change Set Point Value
PointType  [Analog PointType  [Digtal
Point Mumber IZ— Point Number I]J—

Value | 0.00] Change I Valus | Off LI Change I

Status Status
’7 Received point value from controller ’7 Received point value from controller

Close | Close |

Enter a value for the point.

Value | 100 Change I

In this instance, a value of 100 is being is being entered for an analog

point.

A value of 0ff or On can be entered for digital points. value [OFf = [cheng=_]
The point will be set to the entered value when the Change button is Value [ 100 cha
pressed:

Click the Close button to close the dialog.

If you opened the Override dialog from the Livelog dialog, then to see the new value of the point, click the
Restart button.

The next time the LiveLog scans that point, its new value will be displayed. The LiveLog displays the symbol q
beside the value of points that have been changed.

Double-clicking a point number in the LiveLog window places an asterisk beside it allowing it to be
monitored more effectively.
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CXprotP | Points and Point Values

MANUALLY CHANGING A MULTI-STATE VALUE

As a tool to test a strategy, it is possible to manually set the value of one of the priorities in a Multi-state
Value’s priority-array when connected to the site.

e Thisisintended for testing only, and must be manually reversed when no longer required.
e  The Multi State Value module must be on the running strategy to change the value this way.
To change a Multi-state Value (MV):

Right-click on a Multi State Value module and select Change Multi State Value from the context menu.

@ MibSm=Vaks B
L= MSV 21 ’
B © Tt [ owx Gl
" |Numbser of States: 10; Default :

State: 1; State 1 Text: On; State 2
Text: OFF; State 3 Text: €

<" €3 Mukti State Val

Change Multi State Value

This will open the Change Multi State Value dialog:

| Change Multi State Value

PointType  |MultiState Value

Point Mumber IZ:L—

Present Value I 3: Open Get Present Value I

Priority Value m Change |

Priority IIG_:I, Get Value |
Clear Priority |

Status
’7 Received paint value from controller

Close |

Select one of the configured State Texts from the Value dropdown menu and specify a Priority to read from /
write to the priority-array property of the MV object.

To read the current value at the selected priority from the MV object, click the Get Value button.
To change the value at the selected priority to the specified value, click the Change button
To write NULL to the selected priority (i.e. to clear the current value) click the Clear button.

The Get Present Value button will read the present-value property and the current highest priority of
the MV object.

©ABB 2025 All Rights Reserved.
Subject to change without notice
SOLUTIONS.ABB/HVAC-BUILDING-AUTOMATION 100

MANO133 rev 29


https://solutions.abb/HVAC-Building-Automation

6

CxprotP | Creating Strategies

Creating Strategies

WHAT IS A STRATEGY?

An ABB Cylon® Field Controller interacts with HVAC and other equipment by varying its outputs in response to
inputs such as temperature, switch settings, air flow speed, etc.

The way that the controller’s outputs react in response to the controller’s inputs can be defined by the user.
The definition is called a ‘strategy’.

A strategy is the ‘user program’, stored in an ABB Cylon® Field Controller, which configures the controller for a
specific role in a BMS site. It can be described as the “implementation of a solution to a requirement on a
site”.

In CXprotD, a strategy is designed graphically using the algorithmic modules available on the modules panel. It
is saved as a strategy file on the Engineering PC and then downloaded to the controller for which it was
designed, where it tells the controller how to behave within the BMS site.

The simplest of strategies is made up of algorithmic modules, hardware, and virtual points. Strategies are
often more complex, however, and can also include time schedules, trendlogs, and alarms.

AN EXAMPLE OF A STRATEGY

The Problem

The heating system of a building is too costly to run constantly.

The Solution

The heating system should be switched off when the outside air temperature rises above a certain point (for
example 23°C). It should not be switched on again until the outside air temperature drops below another pre-
defined point (in this case, 18°C).

The Strategy

A strategy to implement this solution to the problem can be designed in CXprotP and downloaded to the
controller connected to the heating system, where it will be applied.

The strategy shown below uses the Hysteresis module to compare the outside air temperature to the two set
points defined in the module (in this case, these are set at 18 °C and 23 °C). If the outside air temperature is
greater than 23 °C, the H output is unset (off). If it is less than 18 °C, the H output is set (on).

The strategy is saved and then downloaded to the Field Controller connected to the heating system.

Analog Input El I Hysteress = Digital Output 5
Al Temperature I g - DO Heating Enable
Point € {J'J — l{JJ 3 Input Bctive High Eﬁﬁ Point vemde |
I~ oveme=@ = @000 Active Low [0 S )
S0 Onlevel: 2.00; OFf level: 4.00 '
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HOW TO CREATE A STRATEGY

To create a strategy, follow these steps:

e Select Site, BACnet Router, and Field Controller in the Site List and double-click to open its strategy:

File = Home  Controllr | gy ®
# Connet 3. | theom B Bsacnet points E
(4] & 5acret units B Menoger 4 Contiguration | [BY Grid Colour
200 U0 Reorder Strateqy Statrpause Stop Reset
[ select Al B eranals Rieoles 5 strategy Detalls et | ncre, Bl Save New B [/ sackground Colour

F Disconnect Bpaste
site Contraller o Strategy Macros Simulation Display

Download

2-2a BACnet P Favorites
222 001 - Network.

& 001 - 001 - UCUZ213v
=] 4]

B creste ol Qiogong | Bgene 0} New Connections

Constants

Controls.

02 CEMZ23 Functions
Device Instance Mumber; 22

Math

2o BACnet Serial
25 Sample Apps BACnet!

Schedules, Timers, and L
Setpoints, Inputs, and 0.

Al analog Input

AO analog Output

(7) analog Setpoint

3’.’ BACnet Analog

BACnet Analog Priority Array

E;' BACnet Binary

BACnet Binary Priority Array

DI obigital mput

DO pigital output

L' Digital Setpoint

Statistics »

VAV »
sibal

Virtuals

° Connected Apps BACnet (3), Remate - BACnet ——————}————— 100% OVR CAP NUM SCRL |

o If the selected Feld Controller does not already have a strategy, you will be prompted to create a new one:
convoner | s | ®

File = Home

& Connect ¥ | tEcos E F3, fasacnet points E B Create O n q) €, tagaing B3 Grid B3] New Connections
Foisconnea | & 5acnct Units PRy Manager » m € configuration | B Grid Colour
Download 24 1O Reorder trateay Startpause Stop Reset
Text Teminals Modules % Strateay Detsils el | Macros FRy Ssve New - [/ Background Colour

Contraller Strateay Macros. Simulation Display

Constants

& 001 - 001 - UCU13V
& 001 - 002- CBM24

Controls.

Functions
Math

Schedules, Timers, andL._.
Setpoints, Inputs, and 0...

3
»
»
»
3
»

Engineering Centre Al analog mput

AO
o There is no Associated Strategy with this contraller, Create a new Analog Output
rategy?
S () oo setpan
2% sacnet analog
.
N

BACnet Analog Priority Aay

E;' BACnet Binary
BACnet Binary Priority Array
DI pigita nput
DO oigital output

L' Digital setpoint
Statistics

»
VAV »
Virtuals »

° Connected to: Sample Apps BACNet (3], Remote - BAChet. ————— | 100% OVR CAP NUM SCRL 3

e Click Ok to open a blank strategy
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Contratr | Ststen

e Select a module from the modules panel
& e

He - e
# connan By fmcnarom m E!wm
T — uL:'.« mpe (LU Qu:mum L= B g

Clswect o e s 8 toteg Dot " | W % o e

Ste | Conbolle Clgbomd Stwenr Maeros
| eyt

Q, Leoging. o
@y contgunion  BP Grd Calowr

St Sop et

Smutation

8 Bacou®
& 001 etk
- o001 ucuszi
|1 oo ooz conane
2 BACnd Serl
rp

4 » e
° Connested 1 Samede Apps BACnet 2}, Remate - BACnet

e and place it on the drawing area

We - vems  Comrober | susens

# comea Rrcom
f— e

- Downiosd L] Strategy  View

[ Seect r....u.mu..'\?h--nw- el | Madros 3 e e
Site Controiler (I—lnu Macros

5 R EE S %%

me Sop Reset

Quiesone | Bpeea
Qqconngunton | BP e Coloue

Simudaion

P x

| oor ooz cone
B B4 et
B Sumple A BACast

< » s

° Connectea to: Sampie Apps BACNet (3, Remote - BAChet

>

CXprot? | Creating Strategies

[ pr—

Bnitaround Colour
Disalay

Favarnas
Constants

Contrals.

Functions

Ham

Schedules, Tiness, and L
Satpaints, Inputs, and O
Al i vt

AQ waiog Outpat

(2 analog setpomt
23 sacnet anakog
‘acrat Analag Proaty aray

23 went b
BACHt Binary Priorty Ay

I oignat input

DO pignal output

L ol sewoint
Statisics .
av e
ik v

P r——_ . s

[ r—

7 basaground Colour
oispiay

P @M 0@
Favortas v
Constants »
ontls '
Functions v
Hain v
Scheduies, Tmess,andL_ .
Sewponts, Inputs,and 0. v

Al ansiog Toout

AO anaiog output

€2 analog setpoit

23 sacoet ansog

‘BaCret Analog Proty Arsy

23 sacnetainay

‘BaGret Binary Pty sy

DI Oigtal gt

DO pighal output

L oignal sewaint

Statistcs »

av '

Vetsals v

r—r———. .. "I

o If the module represents a point you will be prompted to enter a name. Enter one and click Ok.

Hie o
¥ conneat
-

Contramr | Ststen

& - Eme

Dowetesd | |

annm m E Y creme
annm [
Sebact A1 ot T Moty 3 sty O " | o % Sre i

Ste | Conbolle Clgbomd Stwenr Maeros
| eyt

9 9

St Sop et

Smutation
'

Q, Leoging. o
@y contgunion  BP Grd Calowr

g e
oo oo -0z conne

2 BACnd Serl

T Smgle Apps BACha

Paint Name

paint bame [Femoerstuns

] oma |

4 » e
° Setup black updated

Connested 1 Samede Apps BACnet B}, Remate - BAChet

@

[ pr—

[ T———
Doy

Favarnas
Constants

Contls

Functions

Ham

Scheduies, Tiness, sndL
Setpoins, Inguts, i O
Al insiog Irgut
AQ anaog Output

() aoaion sewonn
%
23 oacnet naion

acret Analug Prosity Aay

23 owcnst by

BACHt Binary Priorty Ay

I oignat input

DO pignal output

L ol sewoint
Statisics .
av e
ik v

e a—— s

The module is now on the drawing area. It can now be moved, deleted, copied, or linked to other modules.
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Pl Home  Comtoler | Sustegy o]

foma d g DB &SR @R 8 % pu.. T

Schedubes, Timers, and L
Setponts, Inputs, and 0.

Downions | ) View | Add LD Reord SartPase Sop Reset
[73Seiect AN | |Modes| ot Termmnals Modules 6 Strategy Detaits " figin” | Macros [ Save New e . [ Background Colour
sme contonar | Cuppama sttagy wadior simustion Duspiay
Stelist W san \ | e 00 Modules s@
a§) St -
g BAChe P Favorites 5
-2 001 Network Constants »
T o0 - 01 - ucuzIsv
L= oo - 002 - comas Controls »
- g BAChet Sern Funcuons ¥
g Sample Apps BAChet
g Semple Apps BA Math b
»

Al aaalog tnput
AOQ 2alog output
(2 analog Setpoint

2% wacnet analog

BACaet Analog Priority Array
29 sacnetsinary

BACnet Binary Prioity Aray

DI pigital 1nput
DO pigial output
L pigital satpoint
Statistcs »
v »
Vituals »
s — Yy —
To operate on a module, it must be selected by left-clicking on it,
Lowersens.. O Al analog Input
:i::.:: Za:m AO analog Outout
Txponential . 6 () satiop Satpoe

Semsor type  PT1000
Unit < 8 et nalog

Avesgng 0

ty BACnet Analog Prionty Artay
o Poit  Anslog (1) T
U o O Wt By

BACnat Binary Priority Aay

or by dragging a selection box around the module symbol (or symbols)

5 on1-002- CBM2 Gontrols
-§g BACnet Serial Functions
@-Sg Semple Apps BACnet —
Schedules, Timers, andLL.
Setpoints, Inputs, and O

1995

Al analog Input

AOQ ialog Output
(Y mnalog setpoint

S3 Bacret tnalog

BaCnet Analog Priarity Aray

23 wacnetmnay

BACnst Binary Priorty Aay

DI pigital input

DO pigital output

Once a module has been selected, it can then be:

move by using the mouse to drag the module to its new

d location;

delet by pressing the [DELETE] key on the keyboard;

ed

cut by pressing [Ctrl] + [x] on the keyboard

copie by pressing [Ctrl] + [c] on the keyboard

d

paste by pressing [Ctrl] + [v] on the keyboard

d

Pasted hardware point modules may adapt some parameters to the destination point but retain others. For
example, an analog input configured as PT1000 when pasted to a UniPut™ will change to a voltage input but
retain the max and min limits (in the Advanced button) which for pT1600 could be min @ and max e, leading to
incorrect operation of the UniPut™.
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PLACE ALL THE REQUIRED MODULES ON THE DRAWING AREA AND JOIN THEM

Place other modules required to implement the strategy on the drawing area.

Modules must be positioned from left to right on the drawing area. Hardware inputs must go on the left side

of the drawing area, hardware outputs on the right. Between the inputs and the outputs, organize the
modules so that a signal flows from left to right across the strategy.

4 001_01.532 box
~
‘Analog Inpit 3 Hysteress 1 Dignal Outpin g
AI Temperature ﬂ DO Heating Enable
Paint 03 o & o [ Aavehgh@ O Eeom Overds 0
Overnds. | Actve Low
o On level: Z.00; OF feval: 4.00 C

Join the modules together as required, by placing the mouse pointer over module inputs or outputs

4 00101532 box
~
‘Analog Input 3 o Hysteress = C Digital Output T
Al Temperature o .g- o - DO Heating Enable
Pors £y o & Tt [ ctve Figh C C Foint Overnd= [0
Ovemd= 1| | Acivelow [
On level: 2.00; Off level: 4.00

and dragging to another modules output or input.

“Anakog Input EN o Hysterese = o Digical Output B
Al Temperature C C J o © DO heating Enable
BointCi—— | Inpat [ acive High [ I3 Poine Overide [0
Overrice [0 | aawvz Low 5
C © " [Onlevel: Z.00; Off kevel: .00 o

CXprotD displays lines between linked modules:

‘Analog Input Bl ) Hyseresis s o ) Digial Output 5
AI Temperature ﬂ Do Heating Enable
Paint (3 £ ] & Input \ Active High [ 5 Poine Ovemde [0
Overde [ | Acivelow [
o " [Onlevel: 2.00; OF level: .00

If you cannot see a line connecting the two modules, right-click on the drawing area and select Display Options
> Display Lines > Show All Lines from the menu that appears

|| Display Options 3 | Display Lines 3 Show All Lines | '
o Display Labels » Hide AF Lines .

Continue joining modules until all the required connections have been made.

4 001_01.532 P X

~

Heating Enable

On Jevel: 2.00; OFf level: 4.00
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Automatic point selection

When two unconnected modules are linked together, CXproHP automatically selects the next available virtual
point. This is the lowest numbered unused point. This number is entered in the two modules that are linked,
as an input and an output, and it is also displayed at either end of the connecting line. In the example below,
the number of the virtual point connecting the two modules is 1 and it is displayed at both ends of the

connection:
Analog Input El I Hysteresis 15
Al Temperature o J
Paint £2 {3'..1 j-{JJ 3 Input Actve High
Overmide @ Active Low [

On level: 2.00; OFf level: 4.00

If you cannot see the point number at either end of a connection line, click Module Setup from the Display menu.
right-click on the drawing area and select Display Options > Display Labels > Show Number from the menu that

appears
_‘| L
;“ Display Options L Display Lines r i R
1 | Display Labels 3 Hide
............ | Show Number
T o Show Mame
: E Show Value Only (simulation)
I v

=l ﬁ | | .....

When the output of a module which is already connected is connected to the input of another module, the
point number of this output will be written in the input.
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Selecting a connection line

To select a line connecting two modules, click the line with the left mouse button. Selected lines are displayed
with a green highlights. Selected lines can then be:

moved by using the mouse to drag the line to its new
location
deleted by pressing the [Delete] key on the keyboard

When a connection line is deleted, the point number in the input of the target module will be removed.

If this connection was the only one for the output of the source module, the point number will be removed
from there too. The point will now be available for other connections.

Naming a point

To give a point a name, select it and then edit the text in the Name property on the Properties pane.

I X | Properties o x |
Al < > 72 bigital Output [9 -]
B General Information =
Type Digital Output
Service Order 9
Name Heatin|
Synchronised Status Checking...
B Inputs —
Point Digital (9): false Heating En...
B Constants
Point type Output Digital
Low threshold 0
Hinh thrachnald as ;I
Name
This is the name of the module.
’m v

When finished, press enter and the name will be displayed on the module in the Drawing Area.

I X | Properties » A2
Al € > 7 IDigitaI Output [9] ~|
B General Information =
Type Digital Qutput
Service Order 9
Heating Enable Mame Heating Enable
Synchronised Status Checking...
B Inputs —
Point Digital (9): false Heating En...
E Constants
Point type Output Digital
Low threshold 1o
Hinh thrachnald as LI
Name

This is the name of the module.

I-AI Absohute Value o

The name can have no more than 24 alphanumeric characters. Spaces, commas, and full stops may also be
used. Each point in a controller must have a point name that is unique in that controller.
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Assigning a unit to a point

In the case of Analog points, the Units list box (which is displayed in Properties pane) contains a collection of
text strings, one of which will be displayed together with the point value.

To specify a type of unit for a point, select the line that represents it, and select a value from the Unit list.

I X | Properties L < |
alle > 2] |
. ' Point Details Analog (3) Temperature [C]
Number 3
bgier 3 = Type Analog
Al emperatre ) o o Value 000
} PO o CECTI ) Name Temperature
Ovemds Acti - =
G R (tht S ¥
o - B Display Properties i
Show Line Vears
Labels Months
Weeks
Days

Hours

Unit Min

ko E
Al Hm#;gﬂ:::#er This is the unit of messure for tHSec
_ o o . m/s

If the point is a digital point, select the required unit in the Low Unit and High Unit list boxes. The units of a
digital point are text strings, which are displayed instead of the digital values @ or 1.

I X | Properties A+ |
...... RPN | I § hd
...... P [=' Point Details Digital (9) Heating Enable [, ]
Mumber 9
Type Digital
Value false
...... _ . Marme Heating Enable
DO et crsie Low Unie
- G ] High Unit
. B Display Properties
""" Show Line

Labels

If the list does not contain the unit you require, additional application-specific units can be entered manually
in the c:\CxproHD\ (SITENAME) \SYSTEM \site.ini file. For details on how this is done, see Appendix :: Adding
units of measurement to the systemon page 207.

Additional units of measurement can also be added if points are defined using the shortcut method (see A
short cut to defining hardware points on page 79). When the tab (or comma) separated list of point
definitions is prepared, units of measurement which are not already defined in

C:\CXproHD\ (SITENAME) \SYSTEM \site.ini can be used. When the definitions are pasted to the Database
Interface, the new units of measurements will be added automatically to site.ini.
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CREATING STRATEGIES - SET THE VALUES OF THE MODULE'S CONSTANTS

Many modules can be configured by setting internal constant values. These are accessible in the Properties
pane when the module is selected. For example, the Timer with Constant Inputs module has the following

properties:
- % | Properties b |
= Tmerwih Gnemne. 5] 0 " || £ ¥ ? j
oo o
3 Trigger Cutput [ Type Timer with Constant Inputs
Service Order 16
Synchronised Status Disconnected
...... =]
""" Trigger Digital
- Reset Digital
=
...... On delay 10
------ Off delay 10
""" Minimum on time o
...... -
- Output Digital
Complement Digital
...... hd
> Properties  Page WNames Maodules

CREATING STRATEGIES - ADD EXPLANATORY TEXT IF NECESSARY

Text can be added to the drawing area to label parts of the strategy to explain the purpose of certain
modules, or groups of modules, within the strategy,

You can add text or edit text that is already in the strategy drawing. You can also delete, cut, or copy the text
in a strategy.

For details see How to add text to a strategy on page 69

HOW TO REORDER BLOCKS IN A STRATEGY

It is possible to change the order of blocks within a strategy, which can help to optimize the servicing
process.

From the Site List, right-click on the controller and select Strategy Operations > Re-Order Module Blocks

[y e s
&-8p PLOffice
i 552 001 - Network
i @I [
BB Sample Apps Bf =}
B2 001 - Wet 5
L -Em-c
....E’ 1112 -
-, 1113
....E, 1114 -
&=, 1115 -
....E, 1116 - Export Aspect Data

@I na2t- Update BACnet EDE Data
-, 1122 - Vromrarerarmere

Copy Strategy To

Strategy operations +|Ep Reorder Module Blocks

= Mnannn

This opens the Reorder Modules tab in the Strategy Details dialog:
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Strategy Details
Display
Mew Line
Strategy Blocks
Controller Limits
Resources

Paints Manager

BACnet units

1/0 Terminals

Reorder Modules

Highlighted modules are serviced based on time, and not service order,

Service Order | Module | ~ a

1 1- Comparator

2 2-BACnet Schedule A

3 3- Absolute Value

4 4 - Maximum LI
5 5-Analog Gate

6 6 - Limitto 0 or 100 LI
7 7-Rounding

8 & - Integer Constant

9 9-Real Constant

10 10 - VAV Differential Pressure

1 11-BACnet Schedule

12 12 - Holiday Schedule

13 13- Time Schedule

14 14 - Comparator

15 15 - Hysteresis

16 16 - Timer with Constant Inputs

17 18- Raal Canstant hd

[ ok | Concel Booly

The list shows modules in their Service Order.

Note: Some modules serviced based on a time schedule, not necessarily according to their Service Order. Any
modules in the list that are in this category will be highlighted.

Select a module in the list and use the buttons on the right-hand side of the dialog to change its position in

the list:

Move the highlighted block to the top of the list (Service number = 1)
Move the highlighted block up one position in the list

Move the highlighted block down one position in the list

Move the highlighted block to the bottom of the list

Highlight the selected block in the strategy drawing.

Repeat until the list is in the required order.
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HOW TO UPLOAD SETPOINT VALUES

It is possible for all of the controller values for all setpoints in a single strategy to be retrieved in a single
operation.

From the Site List, right-click on the controller and select Strategy Operations > Upload Setpoints

Site Navigation x
E_Q Sitez
E| East Hall
E‘ 001 - Metwork Fnill] ShratequiD | 22
& Open '001_01.532'
oo -opg | P 45
&5 HO Block 2 4 Break .
=| Local Metwark Copy Strategy To T T11
. CornmsControl Strategy operations Re-Order Module Blocks -
ucaz-om
: uc3z-n2 Show Globals [ssues Report “m |
002 - UCCanet Show Globals Table Compare Strategy To Controller r
-5 vt T
(- Bk, Sample Strategies | UPdate BACnet EDE Data T
T

This opens the Upload Setpoints dialog:

r ~
Upload Setpoints
Faint Name |Address |T pe / | Local | Caontroller |
¥a 1 Analog 0.00 0.00
[ aA 2 Analog 9.00 9.00
[¥laB 3 Analog 3.00 3.00
¥ Select/Unselest &l ‘ Update Selected | ‘ Close |
Ready

Select the points to be uploaded and click the Update Selected button

NAMING STRATEGY FILES

When saving strategy files, it is recommended that you use a name which indicates the site, the BACnet
Router number, and the Field Controller number.

For example, the strategy for the Air Handling Unit controller, which is Field Controller number 1 on the

Rooftop subnet (which is BACnet Router number 1) on the Office Block site might be named office 001-01
AHU.STG
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HOW TO OPEN AN EXISTING STRATEGY:

A strategy file can only be opened if it is Associated with a controller.
You can open a contoller’s Associated strategy in one of the following ways:

1. Double-click on the controller in the Site Tree

Site List

=] @ Sites
- o BACnet P

i-Fo BACnet Serial

5. 20 PL Office

¢ BB 001 - Network

. = EEEGE
B-Tg Sample Apps BACnet

E--_@_ 001 - Wet Systems
° B, 1111 - CT Single Pump DPS

3. Right-click on the controller in the Site Tree, and select the filename
Site List b x |

E--@ Sites
El-2a BACnetIP
2o BACnet Serial
25 PL Office
=3 001 - Network

heen '001_01.532' Ctrl= 0

Break
Copy Strategy To

Strategy operations 3

Export Aspect Data
Update BACnet EDE Data

™ T T T O T

1123 - VT Single Pump Speed

INONCNOROROROROONC

4. Select the controller in the Site Tree, and select Open from the File drop-down

File - Home Controller Strategy

[ hew Recent Documents e

[=r2pen o

1001_01.532
II] Save
%) save As 2 CACKproHD\,.\001_03VAV.532

save All
@ Footers

QI Page Size
jl Printer Scaling

?_a Print Setup
¥ Print
@ Licence Details
@ LClose
@Help (@ About X Exit
o 1B, 1713 - CT Single Pump Speed

Note: If the strategy for the selected controller is already opened, all of these options will be disabled (greyed-
out).

Note: If you want to open a different strategy file for a controller you must first remove the existing association,
then associate the controller with the required strategy.
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STRATEGY ASSOCIATIONS
WHAT IS AN "ASSOCIATED" STRATEGY?

Each of the Field Controllers in the Site List can have a strategy drawing file 'associated' with it, which means
that CXproP is aware of the filename of the strategy corresponding to that Field Controller. When a Field
Controller is selected, its associated strategy can be opened by double-clicking, or by selecting from the right-
click menu.

The icon representing the field controller changes when the strategy file is associated with it.

The relationships between controllers and strategy filenames for a particular site are stored in the file

C:\CXproHD\ [siteFolderName]\SYSTEM\associations.xml

Note:

CBXi controllers at the ‘network’ level can also have strategies associated with them.

CREATING ASSOCIATIONS

New strategies

When a new strategy drawing is created, a target controller must be selected. When that strategy is saved for
the first time, it is associated with the selected target controller.

Existing strategies - manual

Site List O x|
E@ Sites
f-To BACnetIP
5o BAChet Serial
C BB 001 - Network

Select
- N Ctrl=N
i o e @.f o Import Strategy
E-Ig Sample A
E|_C7]_ 001 -0

. S —————— EES

A strategy can be associated with a field controller by right-clicking on the Field Controller and selecting
"Select". A list of all existing strategy files that are eligible to be associated with the selected controller will be
displayed.

BREAKING ASSOCIATIONS

Associations can be broken using a toolbar or right-clicked popup menu option; the link between the Site
Tree Field Controller and the strategy drawing is removed.

Site List » B
- §) Sites
25 BACnetIP
B-2g BACnet Serial
-5 001 - Network
& 001 - 001 - UCU3213VAV
£ 2g PL Office
5-52 001 - Network
- =,
25 Sample App.

E= Open 001 01.532 Ctrl-0

| en
Copy Strategy To

Strategy operations »

Export Aspect Data
Update BACnet EDE Data

If an association is broken for an opened strategy drawing, then the strategy drawing will be closed and the
user will be prompted to save it if changes have been made. Breaking an Association allows the User to
associate a different strategy drawing to the Field Controller, using a toolbar or right-click popup menu
option on the Site Tree Field Controller.
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COPYING ASSOCIATED STRATEGIES

From the Site List, it is possible in a single operation to create a copy of the strategy associated with any Field
Controller node and associate that copy with another Field Controller node, as long as the target is of a
compatible controller type and does not already have a strategy associated with it.

Note: A strategy cannot be copied if it is open and has been modified but not saved (the user is prompted to save
the strategy so that the strategy can be copied).

To copy a strategy in the Site List interface:

1. Right-click on the source Field Controller node - i.e. the controller to which the existing strategy is
associated.

2. Inthe pop-up menu, select Copy Strategy To

B-3g PL Office
B2 001 - Network
E-Fo Sample Apj 7 Open 00101532 Ctr=0

Break

| CopyStrategy To

Strategy operations »

3. Inthe Copy Strategy dialog that appears, click on the Field Controller to which you want the copied strategy
to be associated
Copy Strategy “

[~ Copying Strategy '001_01.532' from

Site  [PL Office

Comms Controller 001 - Netwark

Field Controller (001 - 001 - CBM24

rTo

B-LI@Y Stes
- 15g BAChetIP
&-L15 001 - Network
L= (TR
&-[1%g BAChet Seiial
&-L152 001 -Netwark
L.O0S o - 001 - UCU321 vy

The Copy Strategy dialog displays the source Site, BACnet Router, and Field Controller node details as well as the
strategy that will be copied.

The To box contains a "tree" list of potential target Field Controllers, grouped by Site. Potential target Field
Controllers are those that:

e are of a Controller Type that is compatible with the source Field Controller Node
e do not already have an Associated strategy
e do not have a newly created Strategy

The next available Field Controller node is always selected on the source Site. If no Field Controllers are
available on the source Site then no Field Controller is selected and the Site Tree is shown collapsed (closed).

The Copy button is enabled when a Field Controller Node is selected. When it is clicked, a new strategy is
created and opened with the contents of the source strategy being copied, including the Database names
and Keypad Details. The copied strategy is then Associated with the Target Field Controller node.

IMPORTING A STRATEGY

The Copy Strategy To function applies to strategy files that reside in the current Site file structure. It is possible
that files which were associated with a specific folder have been copied to locations outside the Site folders,
and will not be found by the Copy Strategy To process. In that case, the Import Strategy function may be used.

To Import a strategy in the Site List interface:
1. Right-click on the target Field Controller node
The target Field Controller is the controller to which the Imported strategy will be associated.

2. Inthe pop-up menu, select Import Strategy .
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Site List O |
E!--@ Sites
E-Fo BACnetIP
E‘"'E_E BACnet Serial
-2 001 - Network
L=
E‘"'EE PL Office
E_@_ 001 - Mew Ctri=N
?....E, i Impantlategr
"'EE Sample £

Select

The system will scan for suitable strategies for import

Import a Strategy

l |
And display a list of the results.
Import a Strategy “
ok Cancel

It is possible that the list will be blank because a strategy file will only be listed if:
a. It does not reside in the current site.
b. It has the correct embedded site, BACnet Router address, and field controller address.
c. It is not already associated with any controller.

You cannot for example import a strategy from controller number 806 on BACnet Router 5 on a remote site
onto controller number 805 on BACnet Router 5 on the local site. Neither can you for example import a
strategy from controller number 806 on BACnet Router 5 on a remote site onto controller number 606 on
BACnet Router 2 on the local site.

i.e. The file to be imported must have originated on the same controller on the same site.

3. Select a strategy file and click OK. The strategy will be copied to the current site, and the copy will be
associated with the selected controller.

OPENING MULTIPLE STRATEGIES

CXprofD allows you to have several strategies open at once. Each strategy must be opened individually as
described above. Each strategy can be minimized, maximized, and arranged in a number of ways in relation to
the other open strategies.
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DOWNLOADING A STRATEGY

When you have created a strategy in CXproP, you must download it from CXprotP to the targeted controller
before it will function.

Note: When downloading a strategy to a controller, CXprotP automatically wipes the controller's memory and
sends set-up.

All downloads currently require a cycle of outputs, but by using this feature with certain modules, you can
change constants and get around the outputs issue

Note: The targeted controller should not be powered down for at least 40 seconds after a strategy write has been
initiated by any of the methods below.

To download a strategy to the targeted controller:

3. Open the strategy and connect to the controller
4. Download the strategy
Note: When you download a strategy to a BACnet controller from CXprotP, any configuration that has been set by

a separate B-OWS - e.g. an Alarm Recipients list — will be wiped. You must re-download the Alarm Recipients
list, and any other B-OWS specific configuration after the strategy download is complete.

Note: Downloads generally require outputs to cycle, butinvi.e4 and later, certain modules have a feature to
change constants without this cycling.

In these modules a button is available at the top of the modules panel to download any changes to the

Note:

highlighted constants parameters, without cycling the controller outputs:

Properties

a

£ 0> QE? IBooIean
=

Type
Service Order
Synchronised Status

(2]

Input A

=)

Input B

(2]

Input C

=

Input D

Boolean
6
Synchronised

Digital 37: false
Digital 38: false
Digital
Digital

=

Combination 1

()

Combination 2

=

Combination 3

()

Combination 4

A
B

=)
(R

Ninital ST falea §iinn Ranes Ohr

the strategy and controller.

Download of constants will only be possible when all other module parameters are synchronized between

The following modules may have their constants downloaded at run-time without causing a cycle of the

controller outputs:

Hysteresis e Raise Lower Driver Trigonometric Math e Bitwise Logic
Tuneable Hysteresis e Digital Constant Cooling Optimizer A e Duty Standby
Enthalpy e Long Timer Heating Optimizer A e Analog Select
Boolean e Minimum Off Timer Heating Optimizer B e Out Of Range
Forward PID e Holiday Schedule Deadband Variable e Equation
Reverse PID e Make Linear CBT Stat e Staging
Tuneable Forward PID e HX-Diagram Custom PID o Meter
Tuneable Reverse PID e Runtime VAV Actuator e Alarm
Real Constant e Damping VAV Flow Calculation .
Integer Constant e Rounding Analog Multiplexer
Digital Extract e Control Changeover Timer with Constant Inputs
Time Proportional Driver e BACnet Accumulator Digital Multiplexer
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Open the strategy and connect to the controller

Select the target controller in the Site List and open its associated strategy by double-clicking or selecting
Open from the File menu or right-click menu.

Connect to the controller by clicking on the Connect button in the Home tab of the Ribbon:

(=
File - Home Controller Strategy
Properties Modules E Strategy

’ G’ﬁ“‘ @ Copy
_‘a’ Disconnect Lﬁpaste vy Navigatiun Macros

i_iSelect All List Page Names @ Search
Site. Clipboard View

|:| Reopen

Download the strategy
Download the strategy to the targeted controller by clicking on Download in the Controller tab of the Ribbon

Controller Strategy

4‘ﬁlﬁicnmmunicaticuns li‘l Downloti F&Com
% Controller )E:EWipe Caontroller E Shov

¥ BAChet £ Auto Online

Confinuratinn

When you use Automatic Download, CXproP automatically deletes all previous points and strategies from the
controller as these could conflict with the strategy being downloaded. It then downloads the strategy and
sends the set-up (i.e. it informs the controller of the number of blocks it must service in the strategy).

While this is happening, the Downloading window is displayed.

Downloading *

Caontroller

Stategy iock: | |50

Analog Setpoint Values 339

Digital Setpoint values [N | 514
12

Bcnet poit conrio | N | 212

Sending BACnet data via file transfer...

Close | Abort I

The progress bar at the top of the downloading window shows the progress of the download, while the status
box (at the bottom of the window) tells which of the three stages in the download process (wiping the
memory, downloading the strategy or sending the set-up) CXprotP is currently completing.

The Downloading window also includes a Complete box, which displays the number of the block of the strategy,
analog point or digital point that is currently being downloaded. In the above example, the progress bar
shows that the download is 79% complete, the complete box tells us that CXprotP is downloading block
number 251 of the strategy and the status box tells us that CXprotP is busy downloading the strategy to the
controller.

Wipe the controller's memory
Wipe the controller’'s memory by choosing Wipe Controller from the Controller tab on the Ribbon.

e Cantroller Strategy

dﬁCvommL.|r1icatic-r1s tt Download F&.Compare
I%Crorﬂrc-ller ’EWipe Sntroller ESHOW Comp
¥, BACnet 21 Auto Online

Configuration {
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This opens the Wipe Controller dialog box, allowing you to choose individual parts of the controller memory to

be wiped
Wipe Controller “
I- Clear Strategy |- Clear Schedules
[ Ciear Points [” Clear Hardware Point:

I Clear Modem Strings
I Clear Keypad

[ Clear BACnet Data EACnet Options... |
Mumber of datalogs INo change VI

I~ Wipe Al

Current Status
’7 Idle

Wipe | Close |

Click Wipe to close the Wipe Controller box.

CXprotP will display a message to confirm that the controller’'s memory has been wiped. Click OK to close the
message box.
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How to check the controller type to which you are downloading

To find the type of the controller to which you are downloading, open the Strategy Details dialog by clicking on
Strategy Details in the Strategy tab of the Ribbon

r Strategy
[ Copy E - BACnet Points E E
[ Paste & 5Acnet Units
P Add /O Reorder  Strategy Viey
L.} Select All Text Terminals Modules ng:! StlateﬁDetalls Help Macr
Clipboard Strategy
Strategy Details X
Display Number | Type | A
New Li 1 Comparator
Mewline 12 BACnet Schedule
Strategy Blocks i ab::;zfnvalue
Controller Limits 2 ﬁ_ﬂ:{l“‘g (D}Ztre1m
Resources 7 Rounding
8 Integer Constant
Points Manager 9 Real Constant
10 VAV Differential Pressure
Reorder Modules " BACnet Schedule
12 Holiday Schedule
BACNet units 13 Time Schedule
14 Comparator
1/0 Terminals 15 Hysteresis
16 Timer with Constant Inputs
17 Not Used
18 Real Constant
15 Adder/Scaler v

[~ Show used blocks only

OK I Cancel Applp

Click the Controller Limits tab.

Strategy Details X

Display

Mew Line

Strategy Blocks
Controller Limits

Resources

Points Manager

Reorder Modules

BACnet units

1/ Terminals

Controller Type IC BX-BR8
Number of Modules per Strateqy | 1024
Mumber of Datalogs per Strategy l":;.‘—

Inputs Outputs
Universal Inputs 16 Universal Outputs
Digital Inputs 0 Digital Outputs
Analog Inputs 0 Analog Outputs

ol
(ol
ol

Variable 10 |16

o ]

Cancel |

Apply

In the example shown, the Controller Type box shows that the selected controller is a CBX-8R8 controller.
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Edit the strategy

Edit the strategy by placing and joining the required modules on the drawing area and editing their values
and units.

Download the strategy
When you have completed the strategy, you must then download it.

Connect to the controller by clicking on the Connect button in the Home tab of the Ribbon:

File - Home Controller Strategy

’ Coﬁed m Copy Properties

Modules

E Strategy

_@‘ Discnnect LﬁPaste Navigat\on Macros D Reopen
V' Select All Page Names @ Search
Site Clipboard View

Download the strategy to the targeted controller by clicking on Download in the Controller tab of the Ribbon

Controller Strategy

%Communications li‘l Download @Compare
%Controller ’E}Wipe Controller EShow Compare
% BACnet £ Auto Online

Configuration Cpe

A warning is displayed:

‘Warning: Downloading will wipe the controller and cycle the outputs. A
Continue? Llé.
[” Do not ask me again during current session. Ves | No |

The Downloading window will appear, to display the progress of the download.

Downloading x

Controller

Hardware Points _ IT
Strategy Blocks _ W

Analog Setpoint Values _ E
Digital Setpoint Values || G =+
BACnet Point Config ’ﬁlﬁ

Sending BACnet data via file transfer...

Close | Abort I

When CXprof? has downloaded all the blocks that you specified, it will automatically close.
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STARTING A STRATEGY (SENDING THE SETUP)

When the memory of a Field Controller has been wiped and the strategy has been downloaded to it, the
Controller must be told how many blocks are to be serviced. This is called the Setup of the strategy. Sending
Setup is also referred to as starting the strategy. If you are using Automatic download, CXprotP sends the
Setup automatically when you download a strategy to the controller. Otherwise, you must send the Setup as
described below.

Select the Controller in the Site Tree, and connect to it by clicking on the Connect button in the Controller tab of
the Ribbon

File - Home Contraller Strategy

’ onnect J’ﬁC:Jmmunicati»::ns tf Dow

j" connect IEliicmtmlle:r T Wipe
%, BACnet 2 Auto
Site Configuration

Open the Controller Configuration dialog by clicking on Controller in the Controller tab of the Ribbon

ne Controller Strategy
‘ﬁ Communications Itl Download
ct % Cut\guller ’ij Wipe Contr

¥ BAChet 4 Auto Onlin

Configuration

Controller Configuration “
Mumber Of Strategy Elocks To Semvice Send |
—Last Composed Strategy Last Modified Receive |
Time |1400:16 j Date |10/08/2018 j‘ ’7 Time |14:DD:1 & j Date |10/08/2018 j‘

User ID IO— User Name l—
Strategy ID IO— Drawing Reference I
Min Service Time IG‘—
Time Synchronisation Wait After IO—

 Current Status
Attention ! Error receiving setup.

Close I

The number in the Number of Strategy Blocks To Service box, X (which is automatically entered by CXprotP but can
be changed by the user), activates the first X blocks of the strategy in the Field Controller. This number, X,
must be greater than or equal to the number of the highest numbered block used by the strategy. Otherwise,
the parts of the strategy which occupy blocks with a higher number will not be serviced, and their point values
will not be updated, which may cause the strategy to fail.
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Note: If you cannot see how many blocks you have used in the strategy, open the Strategy Details dialog by clicking
on Strategy Details in the Strategy tab of the Ribbon

r Strategy
£ Copy E A g BACnet Points E E
[ Paste & BACnet Units
— View | Add o Reorder _ Strategy =~ Viey
{Tiselect All | |modules Text Terminals Modules & Strateﬁ[)etans Help Macr
Clipboard Strategy
Strategy Details X
Display Number | Type | ~
. Comparator
Mew Line 2 BACnet Schedule
[Smemmocs T 1D W
Controller Limits 2 m?g g‘:ﬁm
Resources 7 Rounding
8 Integer Constant
Points Manager 9 Real Constant
10 WAV Differential Pressure
Reorder Modules n BACnet Schedule
12 Holiday Schedule
BACHnet units 13 Time Schedule
14 Comparator
1/0 Terminals 15 Hysteresis
16 Timer with Constant Inputs
17 Not Used
18 Real Constant
15 Adder/Scaler v

[~ Show used blocks only

QK I Cancel | Apply |

The Strategy Blocks tab lists all blocks in the targeted controller. The highest block number that is marked as
used is the number of blocks the controller must service.

The Last Composed section of the Controller Configuration dialog automatically contains the current PC time and
date. If the strategy is uploaded later, this time and date will indicate when the strategy was started.

The User ID parameter allows the application engineer to enter a unique identifying character. If the strategy
is uploaded later, this number will indicate who started the strategy.

In the User Name field, the engineer can enter the name of the person that started the strategy and this can be
retrieved from the controller if the strategy is uploaded. A string of up to sixteen characters can be entered in
this field.

In the Drawing Name field, the name drawing can be entered. It is recommended that the name of the drawing
containing information relevant to the strategy is stored here. If the setup is uploaded from the controller the
drawing name will be displayed in this field.
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The effects of sending the setup
Sending the setup to a controller has the following effects:

e All blocks entered in the Number of blocks to service section will be serviced, even if they are not occupied by
modules. For example, if you entered 100 as the number of modules to be serviced, the first 100 blocks
will be serviced by the controller.

e Acontroller that is sent a setup with blocks to be serviced, but without any strategy, will not send any
output signals and will not read any input signals.

If a strategy is downloaded after setup is sent, the strategy is serviced immediately. This means the outputs
will receive values from the strategy immediately after downloading. It would be preferable to download the
strategy before sending setup since untested strategies can cause problems in devices connected to the
outputs if the output values are unstable or incorrect.

e Output points of modules that occupy serviced blocks take their values from the module.

¢ If the controller is running without a network (stand-alone), the green LED is constantly illuminated.

e If the controller is running on a fieldbus (connected to a BACnet Router), the green LED flashes with
regular pulses.

e Analarm appears on the monitor of the connected PC if the alarm feature is active.

e The keypad program, if one exists and has been downloaded to the controller, will be started.

TESTING A STRATEGY WITH SCAN MODE

It is important to test a strategy at various stages in its creation, to check for mistakes or faults in its design.

This is done by using Scan mode.

PREPARING TO TEST A STRATEGY

To test a strategy the following conditions must be satisfied:

e The strategy must be open (see How to open an existing strategy: on page 112).
e The strategy must have been sent to the controller (See Downloading a strategy on page 116).

Make sure that the downloaded strategy and the open strategy are the same.

e The strategy must have been started (see Starting a strategy on page 121).

HOW TO TEST A STRATEGY

In Scan mode, CXprotP allows you to view the changes in values in a strategy as the strategy is serviced in the
controller. This is useful for testing strategies and parts of strategies for correct operation. In Scan mode, the
point values of an uploaded strategy are read by CXprotP, displayed next to their respective inputs/outputs,
and updated in real time.

To activate scan mode:

e Open the strategy and Connect to the controller by clicking the Connect button on the Strategy tab of the
Ribbon

o Display the strategy's point and constant values (page 124)

e Set the Scan mode (page 124)

e Activate scan mode (page 125)

In scan mode, the variable point values of a strategy are updated in real time as they are serviced by the
strategy and displayed clearly in the module symbols on the drawing area. In the Rescale to 0 or 100 module of
the example above, the values of the 3 input points were changed to 19, 20, and 149.86, and its output was
changed to 100 as they were serviced by the strategy.

e Watch the changing values of the modules in scan mode to ensure they are being serviced correctly by
the controller.

©ABB 2025 All Rights Reserved.
Subject to change without notice
SOLUTIONS.ABB/HVAC-BUILDING-AUTOMATION 123

MANO133 rev 29


https://solutions.abb/HVAC-Building-Automation

CXprot? | Creating Strategies

How to Display the strategy's point and constant values

Display the point and constant values of the strategy by right-clicking on the Drawing Area and select Display
Options > Display Labels > Show Value Only (simulation)

: || Display Options r Display Lines 4 i o
B | Display Labels v Hide
) Show Number
Show Mame
Show Valﬁ Only (simulation)

Setting the Scan mode

CXprotP can scan either the current active strategy or all of the currently open strategies. To set this, open the
Applications Settings dialog by clicking Communications in the Controller tab of the Ribbon
Controller Strateg

| %Cummunicatiuns |

IE Controller

%, Bacnet

Configuration

Select the Scan Options tab in the dialog, and select either the Scan Active Strategy or the Scan all Strategies radio

button.
Application Settings x
Download Options [ Strategy Scan
(% Scan Active Strategy
Scan Options
 Scon ol Sk
Strategy Settings
— BACnet Properties
BACnet Configuration Time Between Scan (s) laﬂ—
Serial Port Connection

Commands

Livelog

oK Cancel Apply

Click OK to close the dialog.
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Activate scan mode
Begin scanning by clicking Scan in the Controller tab in the Ribbon.

J— S

Contraller Strategy

%Cummum(atimns | l:l Download F&Cumpare ‘%Versixm l__{ Board Diagnostics I ql | 1

% Controller )BWipe Controller E Show Compare % Time and Date E"_| Statistics ®
o O O Secan |Overridt
% BAChet lt] Auto Online Maximums @ Lock and Unlock Paint
Configuration Operations
. [ —

The CXproHP window will change to the CXproP scan mode window, hiding the Site List, displaying the Page
Names pane and disabling all of the Ribbon items except the Scan button

@
=] [ Lwetog setup =l
B 5 [ g S S
Testing Keypad
b x| [pageiames 8
A~ 4 % 7 ShowPage Humbers On Draving
Page Nomber | Page Nome

There are ne items to show in this view.

Fodlv

Verying Module 3... Connected to: PL Office 1], Remote - BACnet | { re— ] HuM

e To deactivate scan mode, i.e. to stop scanning the point values of the strategy, click the Scan button
again.

SUGGESTIONS FOR TESTING STRATEGIES

¢ If a number of modules are selected in the strategy when Scan mode is activated, then only those
modules will be scanned.

e The module to be tested must have been downloaded to the controller. That is, the Block number of the
module must be within the range of modules which were downloaded to the controller (see
Downloading a strategy on page 116)

e A strategy should be tested in small steps during the creation process. Simple faults such as selecting
the wrong module or joining to the wrong inputs and outputs can be difficult to correct in a finished
strategy. There is also the danger that faults can result in other faults appearing in different parts of the
strategy or in other controllers.

e At the end of the creation of a strategy, the whole strategy should be tested again. This prevents later
problems and time losses during the setting-up process in the site.

e The strategy should be checked module by module from left to right, starting with the hardware inputs
and finishing with the hardware outputs.

e Individual strategy parts can be functioning correctly themselves but cause problems when connected to
other correctly functioning strategy parts. For example, the direction of analog values may fall in the
range of @ % to 100 % or the range of 100 % to @ %. Digital values and their inversion may also cause
confusion.

e Test a strategy before copying it or using it in another controller. Otherwise, all copies of the strategy
will also have to be tested.

e Manually overriding hardware points allows simulation of each environmental situation to which the
strategy would be exposed.
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SECURING CBM DATA

Unlike other BMS controllers, in the CBM strategy information can be secured against accidental loss or
unauthorized modification by password-protecting the ability to view or edit strategy information and
system information.

HOW TO PASSWORD-PROTECT A RANGE OF BLOCKS IN A CBM STRATEGY

To lock a range of blocks in a strategy, select Lock and Unlock from the Controller tab of the Ribbon.

Controller Strategy

%Communications 4 Download P&Compare B version "?\Board Diagnostics C
(
%Controller @Wipe Controller @Show Compare %Time and Date %Statistics

S| SG
% BACnet It'l‘ Auto Online Maximums :.' LMKISN’ Unlock
Configuration Cperations

This opens the Lock and Unlock dialog

B

Lock and Unlock

Lock |
Enter Password ||
Unlock |

Current Status
Idle

Close I

Enter a numerical password (note: the Enter Password field will only accept numbers) and click Lock

&

Lock and Unlock

Lock
Enter Password I il —I
Unlock |

Current Status
Idle

Close I

The Lock Blocks dialog opens. Specify the start and end of the range of blocks that will be protected:

Lock Blocks

Enter Start Block I 12 3:
Enter End Block |m 3&

OK I Cancel |

Click OK to close the Lock Blocks dialog

When the lock command has been received by the controller a confirmation message is displayed in the Lock
and Unlock dialog.

All of the strategy blocks within the specified range are now locked, and cannot be accessed until they are
unlocked using the password set above.
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HOW TO ACCESS LOCKED STRATEGY BLOCKS

If a range of strategy blocks in a CBM controller have been locked, it is only possible to access, view, and edit
them by first unlocking them, using the password set during the locking process.

To remove password protection from a locked range of strategy blocks, select Lock and Unlock from the
Controller tab of the Ribbon.

Caontroller Strategy

J‘ﬁ(:ommunications |4_'| Download @Compare %Version ".-'.\Board Diagnostics r

'ﬁ Controller ’BWipe Controller E Show Compare % Time and Date |:.'_.| Statistics :

% BACnet lﬁt Auto Online Maximums L-EI Lockand Unlack &
Configuration Operations

This opens the Lock and Unlock dialog. Enter the required numerical password (set during the locking process)
and click on Unlock.

Lock and Unlock E
Lock |
Enter Password I """’1

Unkock |

Close I

Current Status
Idle

When the blocks are successfully unlocked in the controller, a message is displayed in the Lock/Unlock dialog.

The strategy blocks are now unprotected and can be accessed from CXproP as normal.
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HOW TO EXPOSE POINTS ON A BACNET SYSTEM

When the strategy has been configured for a controller that is part of a BACnet Site, the points within the
controller that are to be available to the BACnet system must be specified by selecting BACnet Points from the
Strategy tab of the Ribbon

oller Strategy

£ copy E A r.BhCn Pomts E H
IE| Paste .l BACnet Units
L — View  Add /0 Reorder Strategy = Vi
[TiSelect Al | podules Text Terminals Modules 1o Strategy Details Help Ma
er Clipboard Strategy
i A mma A s

The BACnet Points dialog opens, listing all of the points used in the strategy:

| BACnet Points P |
|
r~ Select BACnet Points
‘ BACnet | Export | Point Name | Point Addr | Point Type |
D Room Setting 5 Analog Setpoint |
] MaxHWater 28 Analog Virtual
O Adder/Scaler Block 19 Output 29 Analog Virtual |
O WeatherCom Block 2001 Inpu 30 Analog Virtual
D Heating Water Temp 2 Analog Input
D Temperature 3 Analog Input
O Alarm Enable 2 Digital Setpoint
[m} DigVirt_3 3 Digital Virtual
O Schedule MNo. 1 (On) 4 Digital Virtual
O Hysteresis Block 15 Active High 9 Digital Output
BACnet Point Usage ————————— Binary Unit String Usage
Maximum BACnet l224 Maximum Binary Unit l 37
Used BACnet i 10 Used Binary Unit ! 3
Available BACnet 214 Available Binary Unit ;29
Export Total ;0
i—Setpomt Limits
Max Unexposed Setpoint and BACnet 324 Unexposed io
Available Setpoints / BACnet Points 314

Resolve Duplicate Point Mames i

oK ! Cancel !

Tick the checkbox beside each of the points that are to be exposed, then click on OK.

In BACnet, the point name must be unique. In the ABB Cylon® BACnet system, they may not be unique, so

some duplicate names may appear in the list. If this is the case, click the Resolve Duplicate Point Names... button.

This opens the Resolve Duplicate Point Names dialog, where names can be changed.

The BACnet Points dialog also includes columns of the checkbox to identify points that should be included in
any export to ASPECT® / INTEGRA™ — see ASPECT® / INTEGRA™ Exporton page 202.
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HOW TO VIEW BACNET POINTS FROM A CONTROLLER

You can view BACnet points from a Controller by selecting Upload BACnet Points on the Controller tab on the

Ribbon
ne Controller Strategy
‘$ Communications ﬁ Download Pél Compare L%Version "T'\ Board Diagnostics | 1 | 1 a LiveLlog Setup |I=I
[ad % Contraoller ’;}W\pa Controller Show Compare % Time and Date E.j Statistics q ® * F‘g LiveLlog Report ’
o . O O Scan  Override Livelog T ———— Interfz
% BACnet £ Auto Online Maximums @ Lock and Unlock Point | P+ Upload %Cnet Pomts| Build
Configuration Operations Testing

This opens the Controller BACnet Points dialog. The points are automatically uploaded so that they can be
viewed, and the dialog shows the progress of the upload and the points that have been uploaded:

Uploaded BAChet Paints

Paint Mame | F‘oinlAddrl Paint Type ‘ Active Lnit | Inactive Unit

Statuz

Uploading BAChet point 41 of 225

| Cloge |
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Naming Objects

WHY OBJECTS ARE NAMED

Objects in the CXprotP system, such as controllers, points, time schedules, datalogs, etc. are given names to
make them more identifiable. For example, it is easier to recognize a datalog named “Water Supply
Temperature” than one named “datalog_1", which is the default name of the first datalog used inside a
controller, automatically given by the database.

RULES FOR NAMING OBJECTS

When naming an object in the system, the following rules should be remembered:
e Names inside a controller must be unique.
e Names can have a maximum of 24 characters.
e Allalphanumeric characters are permitted, except commas.
e If the name of an object in a controller is changed to a name that already exists in that controller, the
name of the original object will be deleted.

PROCEDURES FOR NAMING OBJECTS

The following list contains some of the objects in the system that can be named:
e Sites

e Field Controllers and BACnet Routers

e Points (both hardware points and virtual points)

e Datalog and Time Schedule modules

NAMING POINTS
Types of point

There are three main types of point in the CXprofP system:

e Ahardware point is an input or output of a Field Controller.

e Avirtual point is used to save internal information for a controller.

e Asetpointis a type of virtual point, but its value is constant, whereas the value of a virtual point is
determined by the strategy.

Hardware points, virtual points, and setpoints can be either analog or digital.

How to name points

Only hardware and setpoints can be named in CXprotP. Virtual points are identified by their block numbers.
The procedure for naming or changing the name of a set point is the same as that for a hardware point. A
brief summary of the procedure is presented below. (For a more detailed description of how to name a point,
see Defining hardware points on page 75)

e Open the strategy.

e Select the Point module on the drawing area that is to be named or have its name changed.

e Enter or edit the text in the Name field of the Properties pane.

e Choose Save from the File menu to save the changes made to the strategy.

The Database Interface module can be used to enter/edit/delete names of hardware points non-graphically.
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Virtual points which are placed in a strategy as digital setpoints or analog setpoints are points which are
controlled from outside the Field Controller. The name of such a virtual point should indicate how its value is
passed to it. The following table illustrates this:

Setpoint name How to set point value is controlled

Controlled by 3rd party block
Controlled by 3rd party block

Outair Temperature_LG

Room Temperature_WG
Set point_KP Can be changed via the keypad

Gain Factor_PC Can be changed via PC (B-OWS)

NAMING FIELD CONTROLLER TIME SCHEDULES

Controller Time Schedules are saved and serviced just like modules in a controller. Naming Controller Time
Schedules make it easy to locate them for editing, either using the PC, supervisor software, or a keypad.

How to name a Field Controller time schedule
The procedure for naming or changing the name of a Controller time schedule is defined below:

e Open the strategy.

e Select the Point module on the drawing area that is to be named or have its name changed.
e Enter or edit the text in the Name field of the Properties pane.

e Choose Save from the File menu to save the changes made to the strategy.

When naming the schedule, it is a good idea to indicate the module’s function. For example, if the module is
a time schedule for the heating system of the site, and is set for Monday to Friday only, the module might be
named “Heating Schedule (Mon to Fri)”.

NAMING DATALOGS

Datalogs are saved and serviced just like modules in a controller. The contents of a Datalog can be viewed and
analyzed using the Datalog Manager module. So that they can easily be identified by the Datalog Manager,
they are automatically given the same name as the point that they are logging. They are given this name
when the point is connected to the datalog. In the Reports program, datalogs can be configured and archived.

How to name a datalog
Datalogs are automatically named as soon as they are connected to a point:
Open the strategy that contains the datalog.

Damkg el

w Datalog_1

B YT

8 Digtal input

: Enable

5 Log trigger

" [Datzlog number: 1; Update

- |imenval: 300; Link: 0; Datakg
Trigger Options: Any Edger Dehat

1.00; Bxtended length: 0

Heating Enable

" [Onlevel: 2.00; Off level: 4.00

Join the datalog to a point by clicking on the point to be logged, and dragging to the Datalog’s input:
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Datakog
w Datalog_1

i

[ Enabke
Log trigger

Demlog number: 17 U

Triggar Options: Any Edge; Daks

" |1.00; Bxtendad length: O

imerval: 500; Link: 0; Datlog

Hysterass

o

On level 2.00; Off level: 4.00

Dignal Output
Hesting Enable

The name of the Datalog is changed to the name of the point and displayed in the Datalog module in the

strategy.

Al

Analog Input
Temperature

H

Datzlog.
w Temperatureh

e

'st.-wbg'mpm

8 Digtal input
C Enabl=
5 Log trigoer

)

O level: 2,00; O level: 4.00

Heating Enable

If you want to modify the name that is automatically given, you can edit it by selecting the datalog module
and editing the Name field in the Properties pane.

It is a good idea to give an indication in the name of what part of the site the datalog belongs to, but it is not
necessary to indicate in the name that the module is a datalog, as it will only appear in list boxes allowing the
selection of a datalog. Names that are given to only speed up the copying of strategies (for example, “Temp.
Channel 1”,“Temp. Channel 2”,“Temp. Channel 3”,...), and to save time for creating dynamic graphics, are not

helpful for the end-user.

Choose Save from the File menu to save the changes made to the strategy.
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Using Macros

MACROS - OVERVIEW

If your work in CXproHP involves creating the same or similar strategies repeatedly, you’ll find Macros useful
for reducing the time involved in these tasks. A Macro is a set of strategy modules grouped together into a
single unit.

MACROS AND MACRO TEMPLATES

A Macro Template is used to create a macro within a strategy. It is a definition of module types and
connections, and when it is inserted into a strategy a new Macro is created containing new instances of those
module types connected together to match the Macro Template.

e Each time a Macro Template is inserted into a strategy, a new Macro is created.

e Each Macro is an instance of a Macro Template, but a strategy can contain multiple Macros that are based
on a single Macro Template.

e Macro Templates can be stored, and copied between strategies and controllers.

e Each Macro can be configured and adjusted independently of the Macro Template used to create it.

e When a Macro Template is saved, it acts as a CXpro® module.

Example: An “Adder” macro.

An Adder/Scaler module accepts four inputs 2, B, ¢ and b, and operates according to the equation
Output = A*C + B*D
It can be made into an Adder, which operates according to the equation
Output = C + D
by ensuring that its 2 and B inputs are always set to 1. This can be done by connecting a Real Constant module
to the 2 and B inputs as shown below.

R Real Constant 12 AdderfScaler 15
~ N
Outpint A © prmmer ) Inpist & Outpu &
{uputs-s?_ : l?SInputB
Constant A: 1.00; Constant B: 1,00 &) Input C
— Beas

This combination of modules can be saved as a Macro Template and reused whenever an adder is required.

MACRO STRUCTURE

Macro Templates are stored in CXproHP in groups and sub-groups. A maximum of 10 Macro groups can be
created. Each Macro group can contain 20 sub-groups and each sub-group can contain up to 100 Macro
Templates. In total, 20 000 Macro Templates can be created and stored in CXprotP.

For example, you may want to store all Macro Templates relating to heat control strategies in a group called
Heat. This group may contain a sub-group called Boiler, which would contain Macros for boiler control
strategies, such as Optimizer, Heating Curve, etc.

MACRO DESCRIPTION (HELP) FILES

A Macro Description File is a Help file generated by the person who created the Macro Template and is
associated with the Macro Template (it is opened by right-clicking on the Macro button). It is normally used to
describe the function and usage of the Macro Template.

When a user right-clicks on a Macro in the Macro property window, CXprotP opens the editable description file
associated with that specific Macro Template. If none exists, CXpro opens a blank text file, which when
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saved will be associated with that Macro Template. This file can be used to provide documentation about
how the Macro should be used or to record history, author, or changelog details for the Macro Template.

The program used by CXprotP to open the history file, e.g., MS Wordpad, must be specified in the
C:\CXproHD\System\wn3000.ini file under uciéet.

HOW TO CREATE A MACRO TEMPLATE

There are a number of steps involved in creating a Macro Template:

Create the strategy.

Add modules to the Macro Template.

Select the inputs and outputs for the Macro Template and change their names if required.
Set names for each of the points within the Macro Template if required.

Choose a Macro group and sub-group and give the Macro Template a name.

Choose whether to insert the Macro Template into the active strategy as a Macro.

Save the Macro Template.

O Uk wnE

~

The following guide to creating a Macro uses as an example a typical strategy that you might want to save as
a Macro - a “weather compensator” strategy. As an exercise in creating Macros, you may want to follow this
guide, using the weather compensator as an example.

CREATE THE STRATEGY

Create the strategy or part of a strategy on which you are basing your Macro Template. (If you are forming
your Macro Template from an existing strategy, then open that existing strategy).

Example - Weather Compensator macro

For example, if you were to create a Macro Template from a weather compensator strategy, you would place
two Real Constant modules and two Rescale to 0 and 100 modules on the drawing area and join them as shown
below:

The third input of the first Rescale module (Rescale to 0 and 100) is to be the input of the Macro. It is marked
Outside Air Temperature in the diagram below.

The output of the 2" Rescale module (Rescale from 0 to 100) is to be the output of the Macro. It is marked Flow
Temperature Setpoint in the diagram below.

... . Weather Compensator
0 ... 20 °C Outside Air Temperature is mapped to a Flow Temperature Setpoint of 20 ... 80 °C

A=80, B=20 -
R Real Constant = 100 B Rescale from 0o 100 21
A=20, B=80 o Y N o
R Real Constant = Output A @ fg——————3]|E Lower Limit A oupt &) Flow
LAWY Output B 6 <) Upper Limit B Temperature
mm:’-@ﬁ- " |Constamt A: 80.00; Conswamt Bi 2... | 3 Input 'Se'tpoirit C
G2 Ol e (F1s)
Constant A: 20.00; Constant B: 2. " [E 190 Resczk o 0and 100 20 T
—n_a .
TTIE Lower LimitA Output
~{© Upper Limit B
(Outside Air Temperature (OAT)[® few
Rescales input temperature.
sothat 0 ... 20 °C becomes 0 ... 100
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SELECT THE MODULES FOR THE MACRO

The next stage in creating a Macro is to select on the drawing area the modules and any text that you want to
be included in the Macro. Selected modules are marked by red squares around their edges.

To select the modules for the Macro, you can drag the mouse from the top left-hand corner to the bottom

right-hand corner of the strategy to draw a box around the entire strategy so that each module and its inputs
and outputs are selected. It is not a problem if, when drawing the box, you included some unwanted modules
- they can be easily removed at the next stage.

‘Weather Cum ensator

0 ... 20 °C Outside Air Temperature is mapped to a Flow Temperature Setpoint of 20 ... 80 °C
A=80,B=20
R Real Gonstant = 100/-: Rescale from 0 to 100 2
A=20,B=80 v 0% a
R Real Constant Outpust A fy=—————rp{(S Lowsr Lim A Oupe & |Flow
~y Output B 69 € Upper Limit B Temperature
mM,q@ﬁ. : [Constant A: 80.00; Constamt B: 2. | [ Inpr Seq}omt
secsoi] —_ (F1s)
Constant A: 20.00; Gonstant 8: 2... ' B 100 Rescake woOand 100 3 o
—_ e e .
T € Lower Limit A Output (3
77]& Upper Limit B
‘Outside Air Temperature (OAT) © Input _
les-input-temperature ——— .
's0that 0 ... 20 °C becomes 0 ... 100 lk
. . Weather Cum?ensater . .
_[] 2[] °C Outﬁlde Alr Temperature is mapped to a Flow Temperature Setpomt of 2[] S[]_GC_
R Real Constant = 100" 8" Rescale from 0 to 100 21
N . L) .
Output A ) € Lowsr Limit A Ourput _Flow o
Output B €2 € Uppar Limit B Temperature
Constant A: 80.00; Constant B: 2. | 3 ot 'Setpomt
r———— :(FTS)

A0

b 100 RescalewoQandl00 2 |

T Lowsr Limi A

Output € o

‘Outside Air Temperature (OAT)|&® e

| © Uppsr Limi B |

Rescales input temperature

so that 0 ...

20 °C becomes 0

i00
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ADD THE SELECTED MODULES TO THE MACRO TEMPLATE
Select Create from the Macro section of the Strategy tab on the Ribbon.

er Strategy

@ Copy E A r BACnet Points E .n.
[ Paste & BAChet Units >
View Add /o Reorder . Strategy Start/Paus:
Modules| Text Terminals Madules b Strategy Details Help

Clipboard Strategy Macros

This will open the Add Modules to Macro dialog box, in which all of the modules that you selected for the Macro
Template will be listed.

Add Modules to Macro “

Modules Selected for Modules Added to
020 Rescale to 0 and 100 '
021 Rescale from 0 to 100 -
022 Real Constant

023 Real Constant
1025 Qutside Air Temperature (OA
< |

1026 A=20, B=20
1027 A=30, B=20

MNOTE: Hardware modules can not be conti z ‘
added to Macros. ontinue... ancel

A Macro cannot include hardware points, so if any were included in the selection they will not be listed in the
Add Modules to Macro dialog.

If you click the macro button or macro menu without first selecting the modules for the macro, you will be
prompted to do so with the following error message:

Cylon Engineering Centre [ > ]

I, Plesse select the modules for the macro,

Select the modules in the left list box that you want to include in the Macro by holding down the [Ctrl] key and
clicking each one with the left mouse button. The selected modules will be highlighted.

Add Modules to Macro “

Modules Selected for Modules Added to
020 Rescale to 0 and 100 > |
021 Rescale from 0 to 100
022 Real Constant
023 Real Constant
1025 Qutside Air Temperature (OA

1026 A=20, B=30
1027 A=80, B=20

MOTE: Hardware modules can not be Conti | z I |
added to Macros. ontinue.., ancel

For illustration, only the functional modules have been selected in this example. It is also possible to include
text in a Macro Template for clarity.
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Add the selected modules to the Macro Template using the following buttons:
» Add a selected module or several selected modules to the Macro Template
Add all modules to the Macro Template

Remove a selected module or several selected modules from the Macro Template

Vl
|/\'|'\.J'

. Remove all modules to the Macro Template

This Add Modules to Macro list box displays all the modules that have been added to the Macro Template. If you
add a module or modules that you later decide you do not want, you can remove that module or modules
from the Macro Template using the remove buttons (see above).

e

Add Modules to Macro H

Modules Selected for Modules Added to

020 Rescale to 0 and 100 020 Rescale to 0 and 100
Rescale from 0 to 100 021 Rescale from 0 to 100

022 Real Constant 022 Real Constant

023 Real Constant 023 Real Constant

1025 Outside Air Temperature [(OA

1026 A=20, B=80 < |

1027 A=80, B=20

NOTE: Hardware modules can not be

added to Macros. I | el |

In this example, all 4 modules of the weather compensator strategy are required for the Macro Template and
so they are added to the list box on the right. The text has been excluded in this case but could be included
for extra information.

Click Continue... when you have added the required modules to the Macro Template.
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DEFINE THE MACRO INPUTS, OUTPUTS, GROUP AND NAME (THE CREATE
MACRO DIALOG BOX)

Pressing the Continue... button in the Add Modules to Macro dialog will open the Create Macro dialog box:

Create Macro Pt
A
R Real Constant = 100 T Rescake from 010 100 25
. . ’\J . . . I
R Real Carstant = Ot A Oy 73| Lower Limiz A Outpt 63
Y C Outps B O f———T|@ Upper Lt B
Ot A A 0.00; B: 0.00 r=|® e
o8O .
A: 0.00: B: 0.00 B 100 Resalewo Dand 100 2%

. 80 .

2] Lower Limi A Outpt 6

'17 €3 Upper Limt B

@ Input
< >
—Macro Inputs/Outputs —Macro Grouping
I
| Inputs Outputs
Mame I
Group |Legacy Macros =
Click a Maodule node to add Input Click a Module node to add Output Sub Group IWet Systems -
Macro Manager... |

Macro Point Configuration | [~ Insert into strategy on save Save | Cancel

The Create Macro dialog shows the four modules that were added in the Add Modules to Macro box and allows you
to edit input and output names, create Macro groups and sub-groups and create a history file to record any
changes that may be made to the Macro Template later.
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Define the inputs and outputs for the macro
This step refers to the Weather Compensator example (see page 134).

When you click on a module output or an unconnected module input in the drawing area of the Create Macro
dialog, it is highlighted on the drawing area and added to the relevant Macro Inputs or Macro Outputs list at the
bottom of the dialog.

Create Macro Create Macro
: R Real Constant ™ W o R Real Constant 5 ) ;«Zu Rascale from 010100 3%
R Real Constant = Oupt A Q| | Lewer Limz 4] Outpur € R Real Gonetant = [ omwad - - @L:we.rmu| Cups
~~ ) Output B Q| P s Outpt B Q) |© Upper Lima 8|
MMAGE [Gonstant A: 0.00; Constant B: 0.00 0ot A Qe Constant A: 0.00; Gonstent E: 0.00
Output B €| Ouipet B S ey
[br\svar.vtm.ﬂ‘ﬂﬂ‘.c.blﬁtam B: Ilﬂll ¥ 100 Rascale o Oand 100 20 .ﬁ:r.\sramﬂzﬂ-‘?ﬂic.‘ansram B: non 100 Rescaew Dand 100
niL:wel Limz A Output
Upper Limit B
Input
< <
~Macro Inputs/Output: Macro Grouping ~Macro Inputs/Outputs Macro Grouping—
Inputs Outputs Inputs Outputs
003 Uppe Change Name Change Name - 003 Uppe Change Name 004 Ineu Change Name &
Gro i
Change Change Sub Gro Change Change Sub Grt
Macro Point Configuration [~ Insert into strategy on save Macro Point Configuration ™ Insert into strategy on save
Note: If you click on a connected input, an error message will be displayed: “Cannot select a module input that is
already connected to a line.”
Note: The number beside each module input is the Node number and does not relate to the module number.
Note: The default name for node 3 in the illustration is “Inpu”, but this can be edited - see Change input or output

label ifnecessary on page 140.

To remove an input or output that has been added to the Macro Template, click on it in the drawing area. The
input/output will then no longer be highlighted in the drawing area, and it will be removed from the relevant

Macro Inputs or Macro Outputs list.

You can rearrange the order of the inputs or outputs to the Macro, by clicking on an entry in the relevant
Macro Inputs or Macro Outputs list and dragging it up or down within the list.
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Change input or output label if necessary

By default, the text that will be displayed on the Macro module as a label for each input will be “Inpu” and for
each output will be “Outp”:

rII.l test
6 Inpu | o

but these names can easily be edited.

To edit a Macro input or output name, Outputs
select the input/output name in the

relevant list box

Type a new name in the relevant Name Outputs
edit box and press [Enter]. 005

Aninput or output label can have no
more than 10 alphanumeric characters.
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Name and group the Macro
In order to use a Macro Template that you have created, you must give the Macro Template a name, and
assign it to a Macro group so that it can be accessed from the Macro bar.

Macro Name
In the Macro Name box, enter a name for the Macro Template.

The name provided here will appear on the Macro instance when it is displayed on the drawing area. It can
have up to 63 alphanumeric characters.

In this example, the name given to the Macro Macro Grouping
Template is “WeatherCom”.

MName I WeatherCom|

Group | Cylon Macros hd
Sub Group |BACnet ~

Macro Manager... |

Note: The following names cannot be used when naming a macro, because they are used to indicate Inputs,
Outputs, constants, etc. internally within CXproHb:

pi (n) wheren =anumericvalue in the range 0-9

po (n) where n =anumericvalue in the range 0-9
sb

c (n) wheren=anumericvalue in the range 0-9
bc

When the Macro Template is named, choose a Macro group and sub-group for it

Macro Group and Sub-Group

From the Group box, select the group to which LSRR
the Macro you are creating will belong.
MName IWeatherCom
The Macro Group chosen for this example is G [cpton Macros %]
heating roup |Cylon Macros -
. Legacy Macros
Sub Group Cylon Macros

If no Macro Group exists, you must create a new
group (see How to create a new macro group
and sub-group on page 144 ) by clicking the
Macro Manager... button.

Macro Manager...

From the Sub Groups box, select the sub-group platieuping
to which the Macro Template you are creating
will be|ong Name IWeatherCom

) . Group Im
The sub-group chosen for this example is
. Sub Group IBoiIer Vl
Boiler.

Macro Managerg |

If no sub-group exists, you must create one (see
How to create a new macro group and sub-
group on page 144 ) by clicking the Macro
Manager... button.

Set names for all points in the Macro
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Note:

CxprotP | Using Macros

facility to edit the names of all the points in

When creating a Macro Template, there is a ‘ |
the Macro in a single interface. A Macro Point

Configuration button is available on the Create Macro Point Configuration

Macro dialog:

Clicking the Macro Point Configuration button Macro Point Configuration
opens the Macro Point Configuration dialog: ~Macto Details

Name [ WeatherCom
Group [cylon Macros

. . . Subgroup | BACnet
Simply enter text in the Name column against
each point and click the OK button. [ tum.. [ name Ipee [vatve _Tigh b iow tn.

8 Analog
B Analog
10 Analog
1 Analog
12 Analog

ARAAA

If the modules selected when creating the
Macro included any Setpoints, it is possible
to set labels for specific setpoint values

< >

This is different from setting the Input and Output names (labels) as described in Change input or output
label if necessary on page 140. Those input and output names are labels displayed on the Macro module; the
point names set here are the descriptive names stored for each of the points in the strategy.

CHOOSE WHETHER TO INSERT THE MACRO INTO THE ACTIVE STRATEGY

The Insert into Strategy checkbox allows you to | |
immediately insert a new Macro based on this
Macro Template into the active strategy.

r&lnser’c into strategy on save 5a

If you want to insert the Macro into the active
strategy, select this option before saving the
Macro Template.

SAVE THE MACRO TEMPLATE
To save the Macro Template, click the Save e i Y e ‘

button.
ve Sa{ve | Cancel |

The Macro Template is saved to the c: \CxproHD\Macros\ directory if it was created in a UCU or UC16 strategy,
orin the c:\cxproHD\UC32Macros\ directory if it was created in a CBM or CBT strategy. The group and
subgroup information is stored in the macro database.dpb file in the same directory.
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If you decide not to save the Macro Template, click the Cancel button to close the Create Macro dialog box
without saving.

When you save the Macro Template, an entry is added to the Macro pane:

Macros

Macras

I |

The Macro symbol is the bitmap that represents the Macro on the drawing area. (See Working with Macros on

page 151).

-] Legacy Macros

&[] Cylon Macros

E-F= Heating
E-F= Boiler

‘WeatherCom

[wm
‘a

Weatherlom

) DAT

Dmnd £

©ABB 2025 All Rights Reserved.
Subject to change without notice

SOLUTIONS.ABB/HVAC-BUILDING-AUTOMATION

143

MANO133 rev 29


https://solutions.abb/HVAC-Building-Automation

HOW TO CREATE A NEW MACRO GROUP AND SUB-GROUP

Macro Groups and Sub-Groups are defined in the Macro Manager interface.

Open the Macro Manager by selecting Manager from the Macro group on the Strategy tab of the Ribbon

Strategy
ff copy E T 5 BACnet Points E [ Create .t
L?j Paste .l= BACnet Units Mangger
- View | Add I/ Reorder _ Strategy | | View | _ r% tart
[TiSelect All | |Modules Text Terminals Modules T Strategy Details Help Macros| [ Save few
Clipboard Strategy Macros
or by clicking the Macro Manager... button on the Create Macro dialog
—Macro Grouping
Mame I
Group IConn Macros VI
Sub Group IBACnet Yl
Macro ManaEer... |
This opens the Macro Manager e (R
3 () viocros] roups I
W]ndOW : D Legacy Macros IéLE:aqMatms A
-] Cylon Macros [ cylon Macros Delete
Rename
To add a group, click the Add Macro Manager
i i Ei]viacos] roups |
button while the Macros root is BIEE S ]
selected in the explorer pane (left [ on tiacos [ Cyon Macros [ |
. . Rename
hand side of the window)
A new group appears in the Right- e e
; T Macros roups
hand side Group pane. . e ' |
[ cylon Macros [ Gyion Macros Delete
[ Heating I:% =
Type in a name for the new group.
Export Exit

To make a sub-group in the new group, first, make groups visible by clicking on the + sign to the left of the
Macros root.
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Click on the group under
which you want to make a
sub group.

Click on the Add button.

A new sub group appears in
the right-hand "Sub groups"
pane.

Type in a name for the sub
group.

You can view the subgroups
under a group by clicking on
the "+" sign to the left of the
group in the left-hand
explorer pane.

CXproHt | Using Macros

Macro Manager “
B Macras Sub Groups I g
&[] Legacy Macros
[ cylon Macros Delete
(R Heating|
Rename
Macro Manager E
BTG Macros Sub Groups [ Add
7 Legagy Macros [ eoiled
@] Cylon Macros Delete
[ Heating
Rename
Export Exit
Macro Manager “
=-fg Macos Sub Groups | Add
& Legacy Macros Boller
{7 Cylon Macros Delete
%Ea
®-[) Boiler Rename

To close the Macro Manager, click Exit.

When a new Macro group is created, it will be listed under Macros in the View menu. When a new sub-group is
created, anicon is also created for that sub-group and displayed in the Macro sub-group bar.
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HOW TO RENAME POINTS IN A MACRO TEMPLATE

Points can be renamed from the Macro Manager interface.

Open the Macro Manager by selecting Manager from the Macro group on the Strategy tab of the Ribbon

E T 5 BACnet Points E
&) Bacnet Units

Strategy

e
LT‘jPaste

[ Create .t

Mangger
- View | Add I/ Reorder _ Strategy | | View | _ r% tart
[TiSelect All | |Modules Text Terminals Modules T Strategy Details Help Macros| [ Save Mlew
Clipboard Strategy Macros
or by clicking the Macro Manager... button on the Create Macro dialog
—Macro Grouping
HName I
Group IConn Macros 'l
Sub Group IBACnet Yl
Macro ManaEer... |
Clicking on a Macro Template in the left-hand- Rz EEg =
side ‘Tree view’ pane of the Macro Manager BT e s oot e Tiee [ = |
displays properties of the Macro Template in E’S“.?A'Z’:ZE“ Momn D {DEFI0ES Tob4 45515 :;l
the right-hand pane. Ry e e
5 o - =
The Macro Name, Macro ID, User Created flag, and it o
the list of point names are displayed.
If point names have already been defined, then
an Edit Point Names button will be displayed on
. . . Export Exit
the right-hand side of the dialog.
If there is no point names list, then a Create Point Macro Point Configuration
Names button will be displayed instead. ~MagoDetails
. ) ) ) i Name | eatherCom
Clicking either button will open the Macro Point S
Name Prefix dialog, allowing point names to be subgroup [Boiler
edited for the current instance.
Num... | Name |'[xge Value | High U... | Low Un.,
13 Analog “C
14 Analog “C
15 Analog “C
) ) ) . 16 Analog “C
However, if this dialog is opened from the Macro 17 Analeg <
Manager as shown here instead of from the
Create Macro dialog, then when OK is clicked the
Macro Template is changed and any Macro
instances created afterward will use the
updated point names list.
< >
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HOW TO SET MACRO SETPOINT UNIT LABELS

In the Macro Point Configuration dialog, it is possible to set labels for specific setpoint values, so that a user can

for example select “Night” and “Day” for a digital setpoint, or “off”, “on”, “trip” and “switch” for an analog
point, without the need to know which numerical value matches each function.

To set an enumerated list for a setpoint, right-click on the Macro Point Configuration
setpoint in the Macro Point Configuration dialog and select [ Macte Detas ™
. Name | HtgFreeClg
Add/Edit Enumerates. e
. . . . . Subgroup | BACnet
Note:  This option is only available for setpoints.
Note:  This option will not be available when a Macro is being [tun. 'E,Z’sz 'L’ff.m,mm Lvese | thants, [ioutn
added to a strategy, or when a Macro instance is being oL e
edited within a strategy — in those cases when the Macro 1 e | AddEitunents |
Point Configuration dialog opens the user will be allowed only 45| Maktost ros snsiogsetpoint 1000 %
to select from an existing enumerated list, or to type a : FrecFroShifo; Aoalog Seipnint 000 %
value. 5 rerost b Anslog Selpaint 200 %
48 ClgFrost1_2Pos Analog Setpoint  0.00 %
51 ClgWarmUpPos Analog Setpoint  0.00 %
16 Analog *C
17 Analog *C
19 Analog “C
20 Analog C
21 Analog *C
22 Analog *C
23 Analog “C
25 Analog *C
26 Analog *C @
This will open the Setpoint Enumerates dialog. Setpoint Enumerates B

WValue Description ‘ Delete |

Enter a Value and Description pair, and click the Add button.
The Value/Description pair will be added to the list.

If an entry is made in error it can be removed from the list

by selecting it and clicking the Delete button. vawe[o peseptialon N
OK Cancel |

When the list is complete, click OK to close the Setpoint Setpoint Enumerates B
EnUmerateS d1alog' WValue Description ‘ Delete

0 Off

1 an

2 Trip

3

Value| 3 Description| Switch Add

Cancel
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Now, when editing the setpoint, the user can select

the required value from a drop-down list.

The setpoint value is displayed in the list with the text

description.

CXproHt | Using Macros

Macro Point Configuration

~Macro Details
MName | HtgFreeClg
Group | Cylon Macros
Subgroup | BACnet
[ Type [value © [Highu.. [Lowt~
4 ClgRange Analog Setpaint  40.00 %
33 HtgRange Analog Setpoint 40,00 %
2 |FreeRange | EN
7 HtgFrostStatPas Analog Setpaint %
13 HtgWarmUpPos Analog Setpoint %
46 HtgFrost]_2Pos Analog Setpoint %
5 DamperkinPos Analog Setpaint %
8 FreeFrostStatPos Analog Setpoint %
9 ClgFroststatPos Analog Setpoint %
14 FraeWarmUpPos Analog Setpoint %
47 FreeFrost1_2Pas Analog Setpaint %
18 ClgFrost1_2Pos Analog Setpoint %
51 ClgwarmUpPos Analog Setpaint 0,00 %
16 Analog “C
17 Analog =
19 Analog “c
20 Analog °C
21 Analog =
22 Analog C
23 Analog °C
25 Analag °c
26 Analos h
= prities s v
< >

Macro Point Configuration

- Macro Details
Name [ HigFreeCig
Group | Cylon Macros
Subgroup | BAChet
[mum... | Name [ Type [vawe © [Highu.. [Lowia
2 ClgRange Analog Setpoint  40.00 %
33 HtgRange Analog Setpoint 40.00 %
% | ]
7 HtgFroststatPos Analog Setpoint  100.00 %
13 HtgWarmUpPos Analog Setpoint  100.00 %
18 HtgFrost1_2Pos Analog Setpoint  100.00 %
5 DamperMinFos Analog Setpoint  10.00 %
8 FreeFroststatPos Analog Setpoint .00 %
9 ClgFroststatPos Analog Setpoint .00 %
14 FreeWarmUpPas Analog Setpoint .00 %
7 FreeFrost1_2Pos Analog Setpoint  0.00 %
48 ClgFrosti_2Pos Analog Setpoint .00 %
51 clgwarmUpPos Analog Setpoint .00 %
16 Analog c
17 Analog “C
13 Analog -
20 Analag c
21 Analog “C
2 Analog c
23 Analog “C
25 Aanalog c
26 Anala B
= pusie = v
< >

The enumerated list is saved with the Macro template and will be available in all instances of the Macro

created afterward.
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HOW TO TRANSFER MACROS FROM ONE COMPUTER TO ANOTHER

It is possible to use Macro Templates created on one PC on a different PC. They must be exported from the
PC on which they are created, and added to the 'host' PC system (i.e. the PC on which they will be used) as
follows:

EXPORT MACROS FROM THE PC ON WHICH THEY WERE CREATED

Exporting Macro Templates as follows puts each Macro Template in a separate file with a user-identifiable
name so that they can be easily identified and moved to the 'host' PC system.

Open the Macro Manager by selecting Manager from the Macro group on the Strategy tab of the Ribbon

E a1 gBACnet Points E
&) Bacnet Units

Strategy

o
LT‘jPaste

t'!__l Create .‘

Mangger
= View | Add /o Reorder _ Strategy | | View | _ r% tart
i_)Select All | |pjodules) Text Terminals Modules nﬁ Strategy Details  Help Macras r‘lﬂ Save New
Clipboard Strategy Macros

or by clicking the Macro Manager... button on the Create Macro dialog

—Macro Grouping

Name I

Group IConn Macros Yl
Sub Group IBACnet 'l

Macro ManaEer... |

Select the Macro group that Macro Manager
contains the Macro Templates TG Maaos s & [ oo
. [ tegagy Macros 4 pamping
you wish to export, & B Cylon Macros I enthoise Delete
B B-Dmg Dg Frost!_3 T —
select all of the Macro -5 cwon LIS sraafin
. . - [ B HwscCtrl
Templates within that group - Hsrcor % e
1 y OATResst
that you wish to export, 3 e O ontimer
[ OATReset %% Reset
i [ Optimizer SenAlmlog
and click the Export button. 3 oo Sl
~[ SenAlmLog 16 seqModule
[ SeqCtrl 1 sPiant
Al SeaMadule Lanlco B TRV
Exit
A Select Folder dialog will open. Select Folder

Select the location into which
the selected Macros will be
saved.

Current Selection

b LE Docu@ant;
> @ Down s
b Music

= | &l Pictures

= | @ Videos
4, 05(C)

Folder: Documents

Make Mew Folder
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ADD EXPORTED MACROS TO THE HOST PC SYSTEM

Once all required Macros have been exported, copy them onto the PC on which they will be used.

Open the Macro Manager by selecting Manager from the Macro group on the Strategy tab of the Ribbon

Strategy
@ Copy E - - r BACnet Points E [ Create .t
L?j Paste q= BACnet Units Mangger
o View | Add /o Reorder  Strategy = r]% Start
TiSelect Al | |Modules| Text Terminals Modules G Strategy Details Help By Save New
Clipboard Strategy Macros

or by clicking the Macro Manager... button on the Create Macro dialog

~Macro Grouping

Mame I

Group I[ylnn Macras 'I
Sub Group IBACnet 'I

Macro ManaEer...

Select the group and subgroup into which Meero Manager L
you wish to import Macro Templates, B e o e ! |
BB ovlon Macros &I

&[] BACnet —
“2iEm o

B weathercom

and click on the Import button.

In the standard Windows Open dialog. 3 Open |~ |
Multiple files can be selected by holding the © 1 L temp b Mocros v & | | SearchMacros »
[CTRL] key while clicking on each file. Organise New folder =- 0 @

|, sources A Mame - Date mo

|| temp

[C1A03m32 03/12/20
) ’::ta(hmants |_,A06.m32 h
Select the Macro Templates you wish to add i L WeathesCom.m32
and click the Open button. ). VitualMachines vl ?
File name: | "A06.m32" "A03.m32" v *m32 v
The selected Macro Templates will be Importing Macros [ x |

imported into the selected group.

Some of these macros have matching IDs to existing macros. These may have

|f the Macro Template all’eady eX'iStS on the already been imported previously. You can select which macros you would like to
. . impart anyway.
host PC, an alert box will be displayed |
Issue File

ldenpfyl ng the group and subgroup of any [Macra <AD3> has same ID as <AD3> in <UC32 Macros-»Ar Syst... A03.m32
duplicates. %Macm <A06> has same ID as <A06> in <UC32 Macros->Air Syst... ADG.m32

If you wish to import any of the listed Macro
Templates, tick the box beside its name
before clicking the OK button. This will create
a new Macro Template on the host PC, in
addition to the existing duplicate.

< >

Cancel |

I select Al

Note:  Each newly imported Macro Template will be named “x New Macro”, where xis the index of the Macro
Template in the list.

To change this name, select it in the Macro Manager dialog, and click the Rename button.

Once all Macro Templates have been added, they are available for use in the 'host' PC.
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WORKING WITH MACROS

To access the Macro groups and sub groups that exist in a site, click on View Macros in the Strategy tab of the
Ribbon .

ar Strategy

m Copy T E [ E r BACnet Points E [ Create

LﬁPaste .I= BAChet Units Manager
v WView Add ¥ Rearder Strategy Vi

[Tiselect Al | |Modules| Text Terminals Modules W& Strategy Details Help Majgs By Save New
Clipboard Strategy Macros

The Macros pane will be displayed on the right-hand side of the CXprot® window

Macros O x |

Macros

-] Legacy Macros
[ Cylon Macros
(-] Heating

Macros Prop.. Page.. Mod..

HOW TO INSERT A MACRO INTO A STRATEGY

Toinsert a Macro in a strategy, select it in the Macros pane and click in the drawing area (note the cursor
changes to the “Module Cursor” I during this process)

File ~  Home  Controller | Strategy ®
# Connect 3| thcon B B, s E Flaeate | & starypause 8, | BB cria O}
¥ bisconnect [Paste & 5acnet Units ByManager | O o B
Download | = View | Add o Reorder Strategy | View | _ o
L_jSelect Al IModules| Text Terminals Modules B@StvalegyDela\ls Help Macros rﬁ Save New 5l - U
Site Controller | Clipboard Strategy Macros Simulation Display
Site List e 001.01.532 | 001_01.s32WeatherCom | 001_01.s32Wea.. » X Macros N |
@) Sites ~ | @ Macros
S BACnet 1P &[] Legagy Macros
18 BACnet Serial 1 ©ylon Macres
2-52 001 - Network E+[ Heating
= 001 - 001 - UCU3213VAY EBB.“";; erc
&30 PL Office . eatherCom
5-& 001 - Network
=, 001 - 001 - CBM24
S0 Sample Apps BACnet
o
< > Macros Prop... Page .. Mod.
Strategy saved successfully. Connected to: Sample Apps BACNet (3), T Y 1
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- o
Ve Macra Point Configuration
)File - Home  controller | strate 6]
¥ Connect b | Gcopy || [MactoD: Point Name. j startpause €, | B crio B
A¥ Disconnect [FyPaste Name [Weathercom “This text will be prepended to b & B
Download each point name below,
Group [Tieating 7
o site Controller | Clipboard Gr Simuiation Display
| subaroup [Boiler
] [site List » x| [Maaes Ly <]
* | E-@) sites ~ | @ Macros
2, Bacneri Hum... | Name [ype [value [rignu... [ Lowun. [ Legacy Macros
&-2a BACnet Serial o ::::Zg < 3 Cylon Macros
-5 001 - Network 25 Analog < By Heating
B 001- 001 - UCU2213VA! 26 Analog - - Boiler
.8 Pl omee = naleg ke Weathercom
-5 001 - Network
), 001 - 001 - CBM24
2o Sample Apps BACnet
< >
|
oK > Macros Prop... Page... Mod.
Setup block updated o  —
File ~  Home  Controller | Strategy @
& Connect 1 (] Copy E 3 BACnet Points [ Create D startPause B, | B 6rid O
¥ Disconnect [FPaste & Bacnet Units [ Manager | ¥y & B
Download View | Add YO Reorder Strategy | | View | -
Modules| Text Terminals Modules i Stfategy Detalls ~ Heip | |Macros) [ Save New | %, -
Site. Controller | Clipboard Strategy Macros Simulation Display
Site List g 00101532 | 001_01.s32WeatherCom | 001 01.s32Wea..|b X | Macros 8
=@ - - : | | amees
So BAChetIP [ Legagy Macros
El-Eo BACnet Serial [ cylen Macros
=52 001 - Network E1F= Heating
& 001 - 001 - UCU3Z13VAY EB%“”‘:; e,
150 PL Office ‘eatherCom
B- 52 001 - Network
&, 001 - 001 - CBM24
S Ssmple Apps BACnet
|
< > Macros Prop... Page ... Mod..
Setup block updated. Connected to: Sample Apps BACnet (3), ~—— |, 100%

The Macro instance can be renamed, and its details viewed, through the Properties pane.

4 001_01.532 001_01.532:WeatherCom

001_01.53...| » > | Properties

tharCom
[ _omd®]

all< >

ra

? IWeath erCom

=]
MName WeatherCojn
Point Configura...
=]
=]
Internal Mo... Rescaleto 0and 100
Internal Mo...  Upper Limit B
Point De... | Analog
=]
=]
Internal Mo... Rescale from 0 to 100
Internal Mo... Input
Point De... | Analog
Name

The name of the macro.

> Macros  Properties  Page Ma.. Modules
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Note:

Note:

CxprotP | Using Macros

HOW TO VIEW THE MODULES IN A MACRO ("EXPANDING" A MACRO)

To expand a Macro, double-click on the Macro symbol on the drawing area.

9q 001_01.532 001_01.532:WeatherC
U H WeatherCom ’
P T _Ty=s|

CXprotP will open a new strategy for the Macro’s constituent modules.

4 001_01.532 001_01.532:WeatherCom 001_01.532:WeatherCom 001_01.532:WeatherCom Box
............................... &
Weather Comp t )
i0 ... 20 °C Qutside Air Temperature is mapped to a Flow Temperature Setpaint of 20 ... 80 °C ;
.............. aegEe20
""""""" R Re=l Gonstant = [f00 B Rescale from Qw0 100 33 |
asmesn ~ I e
R Riza] Conmtant = MM»\GK; ~————7& Lower Limit A Cupa ()
N Output B O fyer +=|E Upper Limit B
mw‘-“@j " |Constant A: 80.00; Conszant B: 2... " @ e
Output B ]
[Constant A: 20.00; Constant B: 2... b 100 RescaletoGand 100 32
a0
=7 Lower Limit A Outpun ()
........... '14:QUpperL'm'nB P
‘Outside Air Temperature (0AT)  [Opt | |~
............. Resoales Ut Temparatie T
............. cothat 0. 30 °C becomes 0 . P
............................... v
< >

The view settings for Lines and Point Numbers are saved with the Macro. They are not inherited from the
parent strategy. For example, if lines are not visible when a Macro is expanded, simply right-click on the
strategy drawing, select Display Options, and specify that lines are to be shown.

To distinguish between the inputs and outputs of individual modules and the inputs and outputs of the
overall Macro module red highlighting is used to mark the connection points of the Macro module. It also

provides the full path of the strategy file that it just created when expanding the Macro in the Window
menu.

Any changes made to a macro within a strategy will only affect the current strategy. The macro and all of its
module blocks are saved within the active strategy. To edit the macro strategy itself you must open the
* . etm file.
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CxprotP | Using Macros

HOW TO EDIT A MACRO

It is possible to edit an existing Macro Template or to re-save a modified Macro as a new Macro Template. To
do this, expand the Macro by double-clicking on the Macro symbol in the drawing area.

q 001_01.532 001_01.532:WeatherC
r' H WeatherCom
oo | e

CXprotP will open a new strategy for the Macro’s constituent modules.

4 001_01.532 001_01.: om 001_01 om 001_01. “om (3RS

~
i e AU CAUNCE COMpENSAtOr
0o 20 °C Gutside Air s mapped fo a Flow SEtpoint of 20w 80 °C ¢

‘Outside Air Temperature (OAT) 't
) ) ) ) ) 'Rescales input temperature
50 that 0'.. 20 °C becomes 0...100

Make any required changes to the component modules of the Macro by clicking on the symbol and editing its
properties in the Properties pane.

To save the changes select Edit Template from the Macros section of the Strategy tab on the Ribbon.

Strategy
Hcopy E T f5Beacnet Points EE [ Create
FyPaste & BAcnet Units Manager
View Add o Reorder _ Strategy
TiSelect Al | |Modules Text Terminals Modules b Strategy Details Help [ edit Te“ﬁ"“
Clipboard Strategy Macros

This opens the Create Macro dialog, but in this case, Macro Inputs and Macro Outputs cannot be added or deleted.
The input and output point names can be changed, as can the Macro Name, Group, and Sub Group.

Edit Macrs Template x

Tt PG
-
Gk
R W G G E
~ G
iy ™ G
T o osocnno
TSR Flow Betpoint a1 20 DegC OAT

[ )
Y — O rwan |
o et v
< >
e pre
Inputs Outputs
[
w w
o on w o
@ n awoup [iegsatiorsr =]
@ o 3]
004 RS Sub Group | Wet Systems. -
w w
© airs gt
Mact P contguation St canc

When all required changes have been made, click the Overwrite button to save the edits to the original
template. Alternatively, if you want to retain the original template along with the edited one, edit the text in
Name field to the name of the new template and then click Save New.

Note: This can also be launched when Macro is selected in the Macro Manager.
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Communicating with Controllers
COMMUNICATING WITH ABB CYLON® CONTROLLERS

When you are using CXproHP, you will need to communicate with the ABB Cylon® controllers on the site.

¢ You may need to send information to a controller such as a control strategy, a command to erase its
memory, details of its setup, etc.

e You may need to get information from a controller such as its version, current setup, and details of any
strategies it may contain.

e You may wish to view events within a controller, such as changes in values when a strategy is being
serviced. This can be done in Scan mode or by using the LiveLog menu option.

SENDING INFORMATION TO A FIELD CONTROLLER

When the strategy is ready to be downloaded, simply click the download button on the toolbar or choose
Download from the Communications menu and CXprotP will download the strategy and send the set-up
automatically.

WIPING A FIELD CONTROLLER'S MEMORY

Although it is no longer necessary to wipe the Field Controller's memory before downloading if automatic
download is enabled, it is still necessary to wipe the controller's memory before using it for the first time. If
you are not using automatic download, you must manually wipe the controller’'s memory before
downloading.

The effect of wiping a Field Controller’'s memory
Wiping Field Controller memory has the following effect:

e All blocks are deleted (the strategy is deleted).

e The functions of the site (valves, pumps, dampers, etc. controlled by this Field Controller, are no longer
available.)

e The number of serviced blocks will be set to zero. Field Controller Set-up has to be sent again.

e Allvirtual points are assigned the value zero.

e All hardware points are assigned the value zero.

e All outputs go to zero volts.

¢ Inputs do not read any signals from connected devices. This is true for manually overridden points too.

e The green LED on the Field Controller flashes rapidly. If the Field Controller is running without a network
(standalone), the flashes are regular. If the Field Controller is running on a network (connected to a
BACnet Router), the flashes are irregular.

e If the alarm feature is active, an alarm appears on the monitor of the connected PC.

o If a keypad program for that Field Controller exists, it will be deleted.

SENDING THE SETUP TO A FIELD CONTROLLER

If you are using Automatic Download, it is not necessary to send the setup to the controller after
downloading. Otherwise, the setup must be sent manually as described in Starting a strategy (sending the
Setup)on page 121.

GETTING CONTROLLER INFORMATION
HOW TO GET THE CONTROLLER VERSION

e Select the controller in the Site List
e Connect to the controller by clicking on the Connect button in the Home tab of the Ribbon:
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a :
File - Home Controller Strategy

’ Cuged m Copy

Modules Strategy

“a' Disconnect Lﬁ Paste MNavigation Macros I:‘ Reopen
i select All E Page Mames @ Search
Site. Clipboard View
Site List a B 4 Strategy1

E--@ Sites
B-Fg BACnetIP
{522 001 - Network

° & 001 - 001 - UCU3213V P
e Select Version from the Operations section of the Controller tab in the Ribbon.
ne Controller Strategy
%Communications It'l Download P&Compare %Velsiun "T'\Board Diagnastics
jd %Controller ’?}WipeController EShowCompare %Timeand Date 'ﬂstatistics
% BACnet Ii"l‘ Auto Online Maximums :.' Lock and Unlock
° Configuration Operations
°

CXproP will get the version from the controller and display it.

Version

Version UC32.86 7.6.9 05/05/16 Boot Ver.06.00

Serial Number CU12205068F
" Ecp

Close |

Click OK to close the Version window.
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HOW TO GET THE CONTROLLER SETUP
e Select the controller in the Site List
e Connect to the controller by clicking on the Connect button in the Home tab of the Ribbon:

a -

File - Home Controller Strategy

’ Cu@ed m Copy

.‘a' Disconnect Lﬁ Paste

[T Select Al

Properties Modules Strategy
Navigation Macros I:‘ Reopen
E Page Mames @ Search

Site. Clipboard View
Site List o x Strategy1

E--@ Sites
B-5o BACnetIP
i B-B2 001 - Network
. B 001 - 001 - UCU3213V P
e Select Time and Date from the Operations section of the Controller tab in the Ribbon.

Controller Strategy

Jﬁ Communications |4_'| Download E’é Compare E!,\«’ersion I.'l_\ EBoard Diagnostics
"E Controller h ’BWipe Controller E Show Compare % Time and Date E..h Statistics

% BACnet |4_'|‘ Auto Online Maximums :.' Lock and Unlock
Configuration Operations

CXprotP will get the Setup of the controller and display it.

Controller Configuration “
Mumber OF Strategy Blocks To Service I b Send |
[ Last Comp d Strategy Last Modified Receive |
Time [11:57:35 = pate [14/08/2018 = ’7 Time |11:57:35 — Date [14/08/2018 —

User ID I— User Name l—
Strategy ID Io— Drawing Reference I
Min Service Time IO—
Time Synchronisation Wait After IG—

r~ Current Status
Received setup from controller

Close I

Click OK to close the Time and Date window.
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HOW TO GET CONTROLLER STATISTICS

e Select the controller in the Site List
e Connect to the controller by clicking on the Connect button in the Home tab of the Ribbon:

File - Home Controller Strategy

’ CoEed: m Copy Properties | Modules Strategy
ﬂDisc- nnect LﬁPaste Navigation Macros I:‘ Reopen

Site. Clipboard View
Site List o x Strategy1
E--@ Sites
B-5o BACnetIP
i B-B2 001 - Network
° B0 001 - 001 - UCU3213V

e Select Statistics from the Operations section of the Controller tab in the Ribbon.
ne Controller Strategy

%Communications lﬁ Download |_'—’|1=|Compare E:Ij\c"ersion "T{Board Diagnostics
jus % Contraller ﬁjWipe Controller Show Compare % Time and Date '-_.j Statistics
ﬁ BACnet ﬁ Auto Onling Maximums "_5' Lock and URlock
° Configuration Operations

The Statistics dialog box, shown below, appears. The Statistics dialog box contains information that comes

directly from the controller - this information allows you to check the status of the controller.

Statistics

Enginesring Statistics | System Statistics | Seral Port Statisics |

Number of Resets Iﬂ

Number of Crash Detects o
Comm. Checksum Emors Iﬂ_
Number of Bad Blocks f—
Status

[~ WatchDog On
[~ Real Time Clock present

OK

The Statistics dialog box has three tabs — Engineering Statistics, System Statistics, and Serial Port Statistics .
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Engineering statistics tab

Statistics

Engineegg Statistcs. | System Statisics | Serial Port Statistcs |

Number of Resets 0 Clear
Number of Crash Detects 0
Comm. Checksum Emors 0

Number of Bad Blocks 0

Status

[~ WatchDog On
I” Real Time Clock presant

oK

Number of resets indicates how many times the Field Controller has been powered up and down
Number of crash detects the number of crash events detected since the strategy started

Comm. Checksum errors the number of data errors that have occurred in communications

Number of bad blocks the number of bad or corrupted blocks that have been detected in the strategy

Watchdog on This shows the current status of the “Watchdog” on the Field Controller - the box is checked if
the watchdog is switched on (a watchdog is a hardware component in the controller that checks if the
controller is serviceable. When the watchdog is off, the controller is not operating)

Real time clock present indicates if a real time clock is present in the Field Controller
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System statistics tab

This tab provides information on any problems the controller may have in servicing the strategy.

Statistics
Engineering Statistics  System Statistics ISeriaI Port Statistirsl
Last Reset
’7 |Inva\id |\n\rahd
[~ Setup Block
Mumber Of Blocks Servicing [0
Mumber of Bad Blocks |0
First Bad Block [0
Last Bad Block [0
0K |
Last reset Shows the date and time that the Field Controller was last reset

Set-up block indicates if the Setup block (the block in the controller that stores details of the number of blocks
in the strategy) is in place.

Number of blocks servicing shows how many blocks are servicing in the Field Controller

Number of bad blocks shows how many bad or corrupted blocks are detected in the Field Controller
First bad block The number of the first of the bad blocks (if any)

Last bad block The number of the last of the bad blocks (if any)
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Serial Port Statistics tab

CXprotP can display information about messages passing through the Field Controller's serial ports as

follows:
Statistics “
Engineering Statistics I System Statistics  Serial Port féﬁl‘ﬂics I
r Serial Port Type
Rec:
@ Subnet e
" Service Clear |
" Intemal Keypad
™ Bxtemal Keypad
- Total Number r Keypad Information —————————————
Bytes Received IU Ovemun Emors ID Unexpected Responses |0
Bytes Sent IU Framing Emors ID R Timeouts |0
Packets Received ID Parity Emors ID Resends [0
Packets Sert IO Standard Received Emors Packet Size NACKS |0
NACKS Received |0 ID— Undefined NACKS |0
NACKS Sert |0 Ereak Conditions r~ Broadcast Information ———————
ACKS Received Iﬂ ID Faults |0
ACKS Sent ID CRC Emors |0
Checksum Emors IU Packets Received OK |0
Packets Received |0

The first section of this panel, Serial Port Type allows you to select which of the four possible serial ports the
displayed information refers to.

Pressing the Receive button causes CXprotP to upload information about the selected port from the Field
Controller.

Clicking on Clear causes the Field Controller to clear its memory of port statistics for the selected port.

The information displayed is the number of each of the following messages that passed through the selected
serial port since the controller's memory was last cleared:

e Number of Bytes received

e Number of Bytes Sent

e Number of Packets received
e Number of Packets Sent

e Number of NACKs received
e Number of NACKs sent

e Number of ACKs received

e Number of ACKs sent

e Number of Checksum errors
e Number of Overrun errors

e Number of Framing errors

e Number of Parity errors

e Number of break conditions

This information can be used to diagnose low-level problems with the Field Controller's serial-port
communications, and this is usually done in consultation with ABB Cylon® Technical Support.
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HOW TO GET FIELD CONTROLLER DIAGNOSTIC INFORMATION

CXprofD has a facility to display information about the operation of the UC32 controller's hardware system.
This information referred to as 'board diagnostics' can be of use in troubleshooting unusual and low-level
problems on a ABB Cylon® site, and is intended for use primarily when communicating with ABB Cylon®
technical support.

Board Diagnostic information may be viewed by selecting Diagnostics from the Controller tab on the Ribbon.

Controller Strategy
*&Communications ﬁ Download @Compare E;Version "T{Board DiaTﬁcstics
Iﬁ(:ror'ltroller ’?}Wipe Contraller Show Compare %Time and Date 'ﬂstatistics
ﬁ BACnet Ii‘lt Auto Online Maximums :.' Lock and Unlock
Configuration Operations

This opens a display panel showing categories of information about the Field Controller's hardware.

Board Diagnostics
Battery Status Vector
Battery I WECTOR COUNT VALUE
DAC Reading for...
Ov switch to

[ Port Setup
Address

Baud Rate I >

[ Board ID Resistors

Main Board

Daughter Board

Ready

Clicking on the Receive button causes CXprotP to upload the relevant information from the targeted Field
Controller.

HOW TO GET FIELD CONTROLLER CONFIGURATION INFORMATION

Field Controller configuration information can be of use in troubleshooting unusual and low-level problems
on a ABB Cylon® site and is intended for use primarily when communicating with ABB Cylon® Technical
Support.

To view this information, select Maximums from the Controller tab of the Ribbon

Controller Strategy

%Communications |4_V| Download @Compare E;Version ".-{Board Diagnostics

Iﬂ(:or'ltroller ’ﬁjWipe Controller Show Compare %Time and Date 'ﬂstatistics

% BACnet Iﬁx Auto Online Maximums :.' Lock and Unlock
Configuration Operations

This opens a display panel showing the configuration of the Field Controller's hardware.

Maximums

Maximum Subnet Address I 63
Maximum Strategy Block I 1024
Maximum Number of Datalogs I 32

Maximum Keypad Program Size | 20003

Close
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HOW TO SET THE CONTROLLER TIME AND DATE

Select the controller in the Site List
e Connect to the controller by clicking on the Connect button in the Home tab of the Ribbon:
g s

File - Home Controller Strategy
’ Coged @ Copy Properties Modules Ezl Strategy

‘;”' Discdnnect Lﬁpaste Na\rigation Macros |:| Reopen
J— Site
L _iSelect All List Page Mames @ Search

° Site Clipboard View .
e Select Time and Date from the Operations section of the Controller tab in the Ribbon.
ne Contraller Strategy
“a Communications ﬁ Download I—?:I Compare E'a‘ufersion "._'.-\ Board Diagnostics
s %Controller ’QWipe Controller EShow Compare %TlmeandDa- e I;'_.|Statistics
% BACnet Ii‘l‘ Auto Online Maximums r‘n Lock and Unlock
° Configuration Operations

This opens the Time and Date dialog.
Time and Date

~Time and Date Send

: IH.'. . =1

Time |li:08:57 | System Time/Date | Receive |
|

Date |14mafzo1a =l

~Time Based On

" None
T EU
 us

" Use Paint o

[~ Current Status

Error receiving time and date from controller
Close I

In this dialog, you can check the time and date set in the targeted controller by clicking on the Receive button
(time and date are automatically received when you first open the dialog).

The Time and Date can be changed by typing a new date, by scrolling, or by pressing the System Time / Date
button, which sets the time and date to match the settings in the PC on which CXprotP is running.

The daylight saving time scheme can be selected in the Time based on the box on the Time and Date dialog:

o If the None option is selected for Daylight Savings, then the controller will not automatically adjust its
time to match conventional Summertime and Wintertime.

o If the EU option is selected for Daylight Savings, then the controller will automatically adjust its time
according to the standard European rules for Summertime and Wintertime.

o If the US option is selected for Daylight Savings, then the controller will automatically adjust its time
according to the standard rules used in the USA for Summertime and Wintertime.

e If the Use Point option is selected for Daylight Savings, then you can specify a point whose value will
determine Summertime and Wintertime.

If the time and date settings have been changed in the dialog box, they must be sent to the controller before they
will take effect. This is done by clicking the Send button:

Clicking the Close button closes the dialog box without sending or receiving further information.
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CHANGING THE ADDRESS OF A CONTROLLER (CBM ONLY)

CBM controller addresses must be set from software because there are no Address DIP switches on this type

of controller. To set a controller's address from CXprotp:

e Make sure that the PC, running CXprotD, is directly connected to the Field Controller’s service port.
e Make sure that there is a site set up in CXproHP with the PC connected to COM port:

Site Properties x

Name: |Senal Site

Directory: | SerialSite

Type of Connection for this Site:
(% Serial Connection
" BACnetIP

IP Address | 0 0 0 0 47808

Time to Live | 60 seconds

= AChet WA

oK Cancel

.
e Make sure that the directly connected controller is targeted in CXprotP’s Site List
|5i‘te List
E@ Sites
o BACnet IP
So BACnet Serial
E_E Campus block R
-2 001 - Network
.5 001 - 001 - CB
. =2 Pl Offire N@‘)
e Connect to the controller by clicking on the Connect button in the Home tab of the Ribbon:
[ ==Y
File - Home Controller Strategy
’Co nect @Copy Properties I Modu\es|Ez| Strategy
L”' D\s%nnect Lﬁpaste Na\rigation Macros I:‘ Reopen
o Site
L} Select All List Page Mames @Search
Site Clipboard View
°
e Select BACnet from the Configuration section of the Controller tab in the Ribbon
Contraller Strategy
%Communications It'l Download E’élCompare
% Controller ’mWipe Controller Show Compare
% BACnet 4 Auto Online
° Configur%on Op
¢ In the BACnet Configuration dialog, you can set the address for the controller
BACnet Configuration
Caontroller Config New
Controller [ 1 [ 1 [2d
Device Instance | 4 | 4 I
° Device Name joo7 - 001- cBmos  foo1 - 001 - cemos  [po1 001 - cBMO.
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10 Datalogs and Alarms
DATALOGS

Datalogs (Trendlogs) are a feature of Field Controllers that allows point values to be recorded over a period of
time. The recorded data can be later retrieved, displayed, and analyzed with the Datalog Manager module.

Analysis of logged data is often useful in optimizing the effectiveness of an ABB Cylon® site’s controllers and
strategies, and Identifying opportunities for energy savings.

THE DATALOG FUNCTION MODULE

The collection of point values in a datalog is implemented in a strategy by either the Datalog module or the
BACnet Trendlog module.

Datalog H
M Datalog_1

Analog i BACr=t Trend 4
Rl Ourside e -
Digital input ® Temperature Trend
Enable Digital input
Log trigger ) Analog input
Datalog numben 1; Update Enzhl=
interval: 900; Link: 0; Dataleg
Trigger Options: Any Edge; Delta: Log triggar
1,04; Extended length: 0 Datalog Trigger Options: Any Bdge

The content of a Datalog can be viewed with the CXpro? Datalog Manager, and the content of a BACnet
Trendlog can be examined by a BACnet supervisor. Their use in the strategy is identical.

RESTRICTIONS ON THE USE OF DATALOGS

The number of Datalogs (Trendlogs) permitted in a strategy depends on the type of controller in which the
strategy will be used.

Some controllers, such as the CBM24 can have up to 32 datalogs, with a maximum of 1024 entries per
datalog. Other controllers, such as the CBT12, have up to 6 datalogs, with a maximum of 1024 entries in each.
You can determine the number of datalogs that a particular controller can hold using the Maximums dialog
box, available from the Operations section of the Controller tab on the Ribbon menu.

STANDARD DATALOG SAMPLING PERIOD

Each standard datalog module can be configured with an individual time constant for sampling data. To
make the evaluation of datalogs easier it is advisable to use the same time period for sampling data in all
datalog modules. A sampling period of 15 minutes is suggested.

The period of time over which the datalog samples are equal to the product of number of entries (104 or 192)
and the sampling frequency. For example, a datalog module on a UC16PG with a sampling frequency of 15
minutes (900 seconds) will take samples for (192 X 15) minutes = 48 hours.

TIME STAMPED DATALOGS

A time-stamped datalog records the time and date at which a value was recorded, along with the value. A
logging interval is not set - instead, the value of the specified point is recorded:
e when the digital trigger point changes state
e when alogged digital point changes state
e or when alogged analog point changes state by more than a predefined amount from the last value that
was logged for it.
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There are several situations when such a datalog would be particularly useful. For instance, if you log the
value of a point with a conventional datalog and set the logging interval to 10 minutes, the value of the point
may change significantly and return to its original value over a period of 3 minutes, and that change might
occur during the 10 minutes when the datalog is not recording. If so, the event would not be logged at all. On
the other hand, if the logging interval was 30 seconds, the event would be recorded - but the datalog could fill
up and the event could be 'flushed' before it is viewed. If so, the event would also be lost. In both of these

cases, a time-stamped datalog could record data over the period of the event only, so that the necessary data
is recorded without the datalog filling up.

The other primary use of a time-stamped datalog is to log conditions that surround an event. For instance,
when a window is opened, the temperature of the surrounding area could be logged to see how it reacts.

DATALOG SAMPLING OF DIGITAL AND ANALOG POINT VALUES

Both digital and analog point values can be sampled. The datalog module has a digital input and an analog
input.

Arahs T = Do -

T Room
Room Temperature N TemperatureA

Point £ '1;1 —_— '.1] £ Anzlog input
g e TE T

Ovemide [§ Digital input
Enzblz
Log trigger
Datakeg rumber; 1; Update
interval: 900; Link: 0; Datalog
Trigger Options: Any Edge; Delta:
1.080; Bxtended length: O

Datakg
Digital Input N Valve 2094
D I Valve 209 o £ Analog input
o oy B e |
Oeme=@| 0 |DEnese
Datalog number: 2; Update
interval: 900; Link: 0; Datalg

Trigger Options: Any Edge: Deha:
1.00; Bxtended length: 0

Al

[

HOW TO DEFINE A DATALOG

To define a datalog, proceed as follows:

Select the Datalog module in the Modules pane

Modules LN : |

3

| =meeee e
Controls

IFumtmns

IMsth

IS(hedu\es, Timers, and Logic
ISEtDDIﬂtE, Inputs, and Outputs
:Ststlst\(s

‘ Alarm

% BACnet Alarm
f\‘ BACnet Trendlog
D Comment

|b Control Flags

123

Aw|v|w|v|>|~

Counter
N Datalog
Meter

® Real Time Clock v

Macros  Properties Page Na.. Modules

e

©ABB 2025 All Rights Reserved.
Subject to change without notice
SOLUTIONS.ABB/HVAC-BUILDING-AUTOMATION 166

MANO133 rev 29


https://solutions.abb/HVAC-Building-Automation

CxproHt | Datalogs and Alarms

and place it on the drawing area (note the cursor changes to the “Module Cursor” during this process)

1 ammsaz ' on sz e =@ 1 wmoan ! wose x| [Madies LN : |

Cantrols Cantrols
Funcions Functions

Math

Schedules, Timers, and Logic

Setpoints, Inputs, and Outputs

Math

Schedules, Timers, and Logic

Setpoints, Inputs, and Outputs

Alwlwlwlv =
dwlrlwlv =]

Statistics Statistics

A m A am

Ay sacnet am Ay sacnet am

[N Bacnet Trendiog N4 satnet Trendlog

(3 comment D comment

% control Flags % control Fags

:\,:|;| Counter ;u:u" Counter

I Datalog 1/ patalog

Meter Heter

v ® real Time dock “ v | @ real Time dock v

< d Macros  Froperties  Page Ma.. Modules < > Macres  Froperties Page Ma.. Modules

Select the datalog, and configure its properties

4 001_01.532 001_01.532 I % | Properties i x |
~ £ > ? IDatang vl
Anakog Input 1 Datakg 2 =
Al Room Temperature S W R Type Datalog
Poirt ) T O Anslog input Service Order 2
Overie [ o [EDelies Marme Room Temperatured
E E:b(l:gger Use point name  True
Datzlog number: 1; Update Synchronised 5t.. Checking...
Jintarval: 500; Link: 0; Datalog
er Options: Ary Edge: Dahet | &
L00: Extandad langth: 0 Analeg input  Analog (13: 0.00 Re...

()

Enable Digital
Log trigger Digital
Digital input  Digital

(|

=]
o o Datalog 5 Datalog number 1
DI I:;g‘nallzn‘;n : R w Value 2094 Lo Datalog type Analog
alve i
_ S = '“"a_hg_'"m Update interval 900
Paint [0 n] ™ Digital input .
= 0 o Y e o Leg trigger opti... Any edge
Log trioger Delta 1.00
Datzlog numbar: 2: Update Precision [}
[int=rval: 300; Link: 0; Datalog S
|Trigger Options: Any Edge; Dekta: oL Log trigger Time interval
1.00; Bxtendad length: 0

Extended length 0

Analog input
The analog value to be logged.

< > Macros  Properties  Page MNa.. Modules

Name

A datalog is automatically given the same name as the point to which it is joined but can be edited if the Use
Point name property is set to False.

Use Point name

If True, then the Name property matches the connected point and cannot be edited.
Analog input

This shows details of the point to be logged if an Analog point is connected

Enable

The Enabling Point is a digital point, connected to the “Enable” input of the datalog module, which restarts
the sampling process if its value changes from @ to 1. If this point is not connected, then the datalog samples
continuously. In typical applications, this input is not used.

Log Trigger

In Time-stamped datalogs, it is possible to record data when this trigger point changes. If the trigger point is
not connected, logging occurs according to the 'Minimum Change' parameter.

Digital input

This shows details of the point to be logged if a Digital point is connected
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Datalog Number

This shows the automatically-assigned number for the Datalog within the strategy.

Datalog Type

The type (analog or digital) of the point being sampled is shown in the Type of Point to Log.
Update Interval

This is the frequency of sampling (in seconds). By default, this is 900 (15 minutes) but can be edited in the
Properties pane.

Delta

If the datalog type is set to 'Time Stamped', and if the type of point being logged is analog, it is possible to
trigger a sample whenever the point value changes by more than a particular amount. This field specifies that
amount of change.

STARTING A DATALOG

A datalog is part of a strategy and is saved with the strategy. The example below shows a datalog module
linked to a strategy:

Analog Setpoint [ Comparator i Digital Outpurt 17
'.r}}. Frost Protection - |A:B DO giler Switch
[ Paint 7 — £ Inpt A Outpt {1'” {'1?‘] 5 Paint Ovamds
T D Input B Complament

I Dat= 7
1 M v hir
Al guméﬁlin lir ! B TemperatureA
Temperature ) € Analog input

Paint €3 frrs [ Digital ingun

Overicz [ [ Ensbls

Log trigger

Dataleg number: 1; Update

interval: 300; Link: 0; Datakog

Tripger Options: Amy Edge: Deha:

L.00; Extended length: 0

!

Datalogs are started along with the rest of the strategy in which they are contained, when the strategy has
been saved (see page 111), downloaded (see page 116), started (see page 121) and tested (see page 123).

If the block on which a datalog module is placed is downloaded again to the Field Controller, the sampled
data is deleted.
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VIEWING THE CONTENTS OF A DATALOG
This is done on a PC running CXprotD software.

The Datalog Manager program is used to view or print out datalogs, on screen or printer, as text or graphics.
To open s, click on the Datalog Manager icon in the Home tab of the Ribbon.

Home Controller Strategy

innect @ Copy -[IE | Properties  |[[E] Moduies|ﬂz| Strategy Help Q D m r’l m n
sconnect Lﬁ Paste = Mavigation | Macros | Reopen Strategies = Fh

— Site Configuration Database Datajog Site Backup MNB-Pro
L_i Select All List Page "h“‘95|@ Search Interface Mana2r Organiser
site Clipboard View Utilities

The Datalog Manager allows data from Field Controller datalogs to be viewed in a variety of ways:

e The data can be listed as text.

¢ Adatalog can be viewed as a graph.

¢ Information from multiple datalogs can be superimposed on one graph.

e The status of data points can be viewed in real-time.

e ‘Snapshots’ can be made of data from any set of analog points in a controller strategy.

For further details on the display and printing of datalogs, see the Datalog Manager manual.

Archived datalogs can be statistically evaluated by using programs like Microsoft Excel. This provides
valuable information about the operation of the site.
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ALARMS

Alarms are used in a BMS system to alert site supervisors/engineers to any difficulties that may occur on a
Site. The ABB Cylon® BACnet range supports BACnet Alarm notifications which can be made available to
BACnet supervisors such as Cylon’s Aspect™ UL.

The BACnet Alarm module is joined to a digital point (Binary Value). When the digital point has the value 1, the
BACnet Alarm module is activated. The Binary Value may indicate an error condition, for example, a sensor
going out of normal range or a fire alarm being activated.

Alarms can also be set up directly on BACnet points via standard BACnet protocol.

STARTING ALARMS

Alarms are parts of strategies and are saved with the strategies. The examples below show how alarm
modules can be linked to a strategy.

Alarms are started after the related strategies have been saved, downloaded, started, and tested.
EXAMPLES OF STRATEGIES CONTAINING ALARMS

Alarms - Example 1: Pump Trip Switch

Toillustrate the use of an alarm module in a strategy, this guide takes as an example a simple case where a
digital hardware input represents a trip-switch contact of a pump. Joining the digital input to an alarm
module means that an alarm will be generated if the pump goes off-line.

Digital Input 7] BACn=t Alamm s
DI Pump Tripswitch o Pump Tripswitch
Po'lmﬁ.,lz::l .{ZJEAIarm trigger |
Overnde [ " [Alamm on: 1; Notficton type: Al

Alarms - Example 2: Pump Trip Switch with delay

This case joins a digital virtual point (a delay of 60 seconds on the digital hardware input) to the alarm record
function module.

Digital Input EN = Timer with Consnt.. 7 | BACnzt Alzrm £
DI Pump TripswitchA o S “ DigVirt_1
Po'.mﬁm _{JJETﬁgger ou:pmml_ - lmmarmﬁgger|
Overnd= [0 [ Res=t Complement Alamm on: 1; Notifiation type: Al
" |ondelsy: 10; OFf delay: 10; Mimi. | T T T

Alarms - Example 3: Room Temperature Input

In this case, an analog input (room temperature) is joined to the alarm record function module and will cause
an alarm to be sent to the Alarm Handler program if the input value is not within the range specified in the
real constant module.

R Real Constant g B z Window Comparater | © % BACnet Alzrm m
N .y DigVirt_2
| MMACZ: - Lower i A Q.rlw'lrdtmEZ: 5 Alsrm trigger |
| Cutput B €3 3 €3 Upper limit B Tn window [0 o .q.larrn D.I'I: 1 Nn?ll:iﬁ.al:iu.n ty.pe:..lkl....
Constant A: 0.00; Constant B: 0.00 €3 Input C

Anzlog Input 4
AI Room Temperature
Point €3 [
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11 Simulation Mode

INTRODUCTION

A Simulation Mode is available within CXprotP, which allows the operation of a strategy to be simulated

without the requiring a controller to be connected. This is done, in most cases, by using actual Firmware code

to ensure the simulation is as close as possible to real controllers.

Simulation Mode is accessed through the Simulation section of the Strategy tab on the Ribbon

ler Strategy

@Copy . e r BACnet Points E . [3 Create .n. .ﬁ. % #ln! Logging i3
o =l
Lﬁ Paste I E .l= BAChet Units I Manager ’ . :‘ Configuration E
View Add [fe] Reorder  Strategy View Start/Pause Stop  Reset
[TiSelectAll | |Modules| Text Terminals Modules W Strategy Details Help Macros| [ Save New 1 seconds I;
Clipboard Strategy Macros Simulation
Clicking this button will start and pause the simulation for the current strategy. It is
b enabled only if CXprotP is not logged into the site. When the strategy is paused, the
Stari/Pause current simulation state is still visible on the strategy.
Clicking this button will stop the simulation and clear the simulation information
. from the screen. However, the simulation state will still be preserved, and pressing
Stop the Start/Pause button will restart from where it stopped.
Clicking this button will stop the simulation, clear the simulation information from
the screen, and clear any other simulation information for the strategy.
Reset
#h! Logging Clicking this button will enable or disable logging of data. When released, no point

logging will happen. When pushed, any point that has logging information set will
have its values logged accordingly.

t‘ Configuration Clicking this button opens the Simulation Configuration dialog.
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CONFIGURING THE SIMULATION

# Configuration

Several aspects of the Simulation can be configured by pressing the button the Simulation

section of the Strategy tab on the Ribbon. This opens the Simulation Configuration dialog.

Simulation Configuration ﬂ
—General configuration
Simulation Speed INgrma| LI
Display Progress As IRuntime ;I

— Current simulation configuration

Start time/date |17:46:‘|B j |14.r"05.:’2{!‘|8 j

Cancel |

THE SIMULATION CYCLE

The basic unit for simulation is a Simulation Cycle. This corresponds to approximately 1 second of runtime
on a controller. Some modules (Hardware, Globals, time dependent modules) will be processed a fixed
number of time during a cycle. Most of the other modules will be processed a number of times that depends
on the size of the strategy. The bigger the strategy, the less the modules will be processed.

Simulation speed

The Simulation can be run manually (“Step by Step”) where each click on the start button runs one Simulation
Cycle, or automatically at one of 3 speeds: Slow (once cycle every 5 seconds), Normal (one cycle per second)
or Fast (5 cycles per second).

Display Progress As:

The progress of the current simulation is displayed in the right-most section of the Simulation Toolbar. This
progress can be displayed as Runtime (number of seconds since the simulation started) or Date/Time
(current simulation date and time)

CURRENT SIMULATION CONFIGURATION
Start time/date:

When the Simulation Cycle is run, any time and date dependent modules — such as Time Schedules or
Datalogs/Trendlogs - will use a simulated time. The value used will be the time and date set in the Current
simulation configuration Start time/date field of the Simulation Configuration dialog, incremented by one
second on each Simulation Cycle.

This allows a strategy to be tested for unusual behaviors at specific times such as daylight savings time, year-
end, leap years, etc.

The value of this time and date will be displayed in the right-most section of the Simulation Toolbar if the
Display Progress As field is set to Date/Time.
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RUNNING A SIMULATION

When a Simulation runs, the labels at the end of lines will be updated to show the point values.

kg Satpoint o A-B Comparator 1
t Protection o -
Point £ = Input A Output e .
] 17 .
Input B Complement [ L
A = -
log Input Temperatursf
1tside Air - - -
5 | " Analog input
Ype Inpu Digital input
og,/Digital Type: Analog ™
tharad/Mitherad: Mitherad Enz

A green background means that the value is calculated by the simulation.

Ared background indicates that the value has been overridden by the user.

Note: Itis possible to add, update, and delete modules and lines while the simulation is running. The simulation
will take it instantly into account in its calculations.

LIVELOG

During a simulation, the livelog will display values from a simulation run so that it is possible to viewpoint
values from different parts of the strategy simultaneously.
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POINT PROPERTIES

The Simulation mode has two sets of point properties:
e one for input points that feed into the strategy (hardware inputs and Globals’ destinations),

e one for all the other points whose values result from the strategy’s internal calculation.

ACCESSING THE POINTS PROPERTIES

To open the Simulation Properties for a specific point right click and select Simulation properties. This can be
done on either Lines, Hardware |/O modules or connected nodes:

Lines

J0m parator 1]

Digital Outpat )

- po : ;
Output [ l . Boiler Switch
Complemant Eml — !

Convert Line to Connector

Datz 7| - - -
uﬁidﬁir . | Simulation properties
t

t

Hardware I/O modules

Al ousni

Temperature
Simulation properties

Connected nodes

N outsidgeRir
Tem peraturef
Anake inpat |
Hide lines

[E

[ Add Destination Connecter

Dl .

in Convert Lines to Connectars

T

Lt Simulgtion Properties
©ABB 2025 All Rights Reserved.
Subject to change without notice
SOLUTIONS.ABB/HVAC-BUILDING-AUTOMATION 174

MANO133 rev 29


https://solutions.abb/HVAC-Building-Automation

CXproHP | Simulation Mode

POINT VALUE OVERRIDE

In a point’s Simulation properties dialog you can specify whether the value for the point will be calculated by
the Simulation, or set to a fixed value:

Analog points:

Point calculated automatically:
Point Value | Point Logging |
All Points
{ [ Ovenide 0.00

|—In|:|ut points
= 1

Point is overridden and set to 18.5:

Poirt Valus | Point Logging |

Al Points
{ ¥ Overide 18.50

Input points

| P -

Digital Points:

Point calculated automatically:
Poirt Value | Point Logging I
All Points
’7 [~ Overide =

Input points
|— Ill___ _l

Point is overridden, and set to “off” (boolean o)

Poirt Value | Paint Logging |

All Points
’7 ¥ Ovemide r

Input points

| Y- 1

Point is overridden, and set to “on” (boolean 1)

Paint Value | Point Logging |

All Poirts
’7 W Ovemide rd

Input points
’7 INnne LI
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INPUT POINT OPTIONS

For an input point, a selection of options is available to simulate different types of inputs. For Digital points
there are two options, for Analog points there are 7:

Digital Input point options

Input points

INcne LI

Fixed
Periodic change

Fixed value

The point will have a fixed value throughout the Simulation run.

Value is “Off” for the whole Simulation run:

— Input poaints
[Fued =
Value: r

Value is “On” for the whole Simulation run:

— Input points
| Fixed ~|
Value: v

Periodic change
This option will change the value of the digital point during the Simulation run.

If the Random period box is unchecked, the value will change after the Basic Period specified:

Input points
IF‘eriodic change ;I
Random period r
Basic period |2 ISecs. j

If the Random period box is checked, the value will change after a random period which is less than the
specified Basic Period:

Input points
IF‘eriodic change LI
Random period 2
Basic period Iz Secs. LI

Analog Input point options:
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— Input points

Fandom Value ﬂ
Mone s

Fixed 7.00
Random Value [
Up {down) onby 1.00

Up (down) onby with limit
Up and down

Walues from File

None

The point is not assigned a value. The value will either be the last value that the point had, or zero if no
previous value existed.

Input points

e

Fixed

The point will have a fixed value throughout the Simulation run.

— Input points -

Fixed | 3
Value: I 10 g

=—Seriesl

17
25
33
41
49
57
65
73
a1
89
97
105
113
121
129
137
145
153

Random value

During each simulation cycle, the point will be assigned a random value between a given minimum and
maximum.

— Input pairts
Random Value LI | 1 ] | [

12 1
Min Walue: |5 0
8
Max Value: I-Iﬂ . T serest
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Up (down) only

The value will change in only one direction (up or down). Use a negative step limit to go down.

— Input points

IUp (down) anby ;I 160 -

140 /
Start value |5 120 /

[Fixed step = ° by

— Input points

IUp (down) anby LI 80 —~

70 /
Start value |5 © e

/ ——seriesl

Random step up to - I'I O
— N M e g0 ~00:

105
113
121
129
137
145
153

Up (down) only with limit
The value will go from a Start value to a Stop value.

~ Input points 120
|Up (down) only with it~ |

Start value |5 # //

Stop value I'H}D 3 : / —Seriest
20 /

/
|Foced step EE o

1 4 7101316192225283134374043464952555861646770

— Input points -
Chart Area
|Up (down) only with it~ | . (Charta)
Start value 80 /ﬁ

Stop value Imﬂ ® / ——Seriest
|3

N
/

1 4 7101316182225283134374043464852555861646770

Random step up to -

o
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The value will go up and down continuously between two limits either by a specified step (fixed or random)
with a specified period (specify the time to go from one limit to the other).

30

25

20

15

10

=—Seriesl

—Seriesl

— Input paints
Up and down -]
Start value 15
Stop value =
For up to o [Nore ]
| Foced step B E
— Input paints
|Up and down |
Start value 15
Stop value =
For up to o [Nore ]
ol o5
— Input paints
|Up and down |
Start value 15
Stop value B
For up to 1 [vins. ]

16

14

12

10

\ =Seriesl

Values from file

The point value will be taken from a datalog file — at each simulation cycle, the next value will be read from the

file.

This allows using real data such as a datalog of outside air temperature in the simulation. It also makes it
possible to repeat a simulation exactly if the input points from the original simulation have been logged.

— Input points
Walues from File LI

File |
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POINT LOGGING

Paint Value Point Logging |

I Mone

Time stamped logging

Poirt Value Point Logaing |

Time stamped logging -

File | ]
Sample interval Iﬂﬂﬂ

Datalog capacity 1024
(50-4096)

Any point in the strategy can be logged to a file. This can be used to review values after the strategy has run,
and analyze issues. It can also be used to feedback the value in another simulation (see “Input points
options”).

Note: Logging will occur only if both
1. the settings in the point Simulation properties dialog are set and

2
2. the logging button start/Pause is pressed in the Simulation section of the Strategy tab on the Ribbon.
This means that logging can be switched on or off during a simulation by clicking the logging button.
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12

Sites
OVERVIEW

A site is the name given to one or more controllers, optionally connected to a PC. The following are examples
of sites.

e A standalone Field Controller.

e One BACnet Router with a Fieldbus of one or more Field Controllers

e A network of BACnet Routers, each with a Fieldbus of one or more Field Controllers, connected to each
other via TCP/IP.

Sites are configured in the Configuration program.
Some common procedures carried out on sites include:

¢ Installing a new site on the PC (see page 181)
e Site backup (see page 181)

INSTALLING A NEW SITE ON THE PC

Toinstall a new site on a PC, the CXproHP must be installed already.

A new site is one which has not been installed on this PC before, and for which a backup from another PC
does not exist.

WHAT HAPPENS WHEN A NEW SITE IS INSTALLED

Installing a new site involves the following events:

e Site-specific directories are created on the hard disk.

e Site-specific information (information about network ID, telephone number, ID code, etc.) is entered in
the WN3000. ini file.

e The network size (the number of BACnet Routers) is specified.

e The BACnet Routers and Field Controllers are named.

Note: Do not manually make entries to the wn3000.ini when installing a site on the PC. All necessary changes will
be made to the wn3000. ini file by the Configuration utility.
HOW A NEW SITE IS INSTALLED ON THE PC
Installing a new site on the PC involves the following procedures:
e Naming the new site in the Configuration program.
e Entering the size of the site (number of BACnet Routers) in the Configuration program.
e Naming the BACnet Routers and Field Controllers in the Configuration program.
e If the site is not a remote site, it can be configured as the default site (see System Configurationon
page 30).
e Restarting Microsoft Windows and the CXprotP for the changes to take effect.
SITE BACKUP
Making a site backup means making a copy of all site-relevant data on the PC onto removable media such as
network, USB flash drive, external Hard Disk, or tape. A site can then be recreated on another PC running
CXprotP from this site backup.
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MAKING A SITE BACKUP

To backup a site, right-click on the site in the Site Tree, and select Backup Site from the context menu:

Lo e
=

Discover Site

Backup Site

Export ASPECT/INTEGRA Data
Create BACnet EDE Data

You will be prompted for a location to save the backup file:

=
410 v weaibae » G o »
Coguise = Newboider - @
i o e 5
P ke g
oo semaacn
& Socments st
& Dowmicats sy
= Bacseh
= sieum e
v
Help
mormce
si0REs
Syt
e syaen
- Tere
s Terpets
o Wierss
i
[
CanpLon e
File marm: | PL O O35 ]
sostype | CXpDsacep 100 5
~ e ok s Caneel

Select any suitable device or folder and click Save.
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RESTORING A SITE FROM A BACKUP FILE

To restore a site from a backup, right-click on the Sites node in the Site Tree, and select Restore Site from the
context menu:

Site List n @

=-§) ;ﬂ'

Discover Site

Import W7 Sites

[ Restore Site
o Lampus block R
m-Fn PL Office

II:IEIII:IlIEIIEIf-

r

Choose the required backup file and click Open:

5
A s ThsPC » Local Disk(C) > CiproHD - b (proH 2
Hew Folder S )
- Hame .

10020801
APPLBACN
Archive
BACHET®
BACHSER!
Bamaps
CAMPBLOR

& Eugene Peelo Help

I This PC PLOFFICE

30 Objeats STORES:

B Desicop Sronbokt

2 System

& Documents
Temp

& Downioads Templste:

& Music UCIMscros

=) Pietures Utiites

i Local Disk (1)

[ - .
Fie name: ] [CrorotD Backup OB~

Open Cancel

If no site with the same name exists, then the restored site is added to the system as a new site.

If a site by the same name exists, the user will be asked to choose either to overwrite the existing site or to
create a new site.

e Ifyouchoose to overwrite the site that has the same name, the existing site will be completely overwritten.
You will be asked to confirm that you want to proceed.

e If you choose to create a new site, you will be asked to enter a new name, and a new site will be added to
the site tree. The chosen name must be unique.

You can cancel the restore process at any time.
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SITE DISCOVERY

Strategy block data can be uploaded from ABB Cylon® controllers and re-assembled into an easy-to-view
layout. This is useful when you have a Site where you do not have existing strategy drawings or other
information.

The purpose of the discovery process is to determine all of the Subnets (i.e. a Fieldbus connected to a BACnet
Router) on a Site.

All Subnets are searched so that the integrity of the data passed between Subnets (e.g. wide globals)
remains intact. This happens even if you are looking for information on a single Subnet.

This process can be lengthy, so please ensure that sufficient time is allocated for it.

However, you do not have to upload all Subnets at one time. If you specify a Subnet Range for a specific
upload, you can retrieve the other Subnets at a later point in time.

The upload process is started from the Site Tree, either from the Sites Icon (if the Site is not already in the tree)
or from the relevant Site node.

IF THE SITE IS NOT YET CONFIGURED IN THE SITE TREE

Click on the Sites icon in the Site Tree, and select Discover Site

Site List 1 B2
9 =g Discover Site
BT

= Import V7 Sites
- 001 - UCU3213v
E L..= 001 - 002 - CBM24
E1-2o BACnet Serial
JE_E Sample Apps BACnet

This opens the Discovery Site Details dialog with all fields editable.

Discovery Site Details

Enter the details of the site you would like to discover below. For BACnet Sites with a
large number of devices, please ensure the Timeout value is large enough.

Site Detail Network Typ

Site Name € BACnet Serial
Site Directory ' BACnet IP

Site Number |4 (Next free: 4)

Device ID Range |1 to | 4194302

Wait Timeout (5) | 25

MSTP Netwark

Discower Cancel

Enter the Site Name and Site Directory directory.
If you do not want to retrieve all Fieldbusses on the Site, specify a Subnet Range.

Sites can be uploaded either through TCP/IP or through a serial connection. For TCP/IP connections, include
the IP Address and verify the port. Port 4950 is the default.

When configured, click Discover.
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IF THE SITE IS ALREADY CONFIGURED IN THE SITE TREE

If the Site is represented in the Site Tree —i.e. if it has been configured locally configured using the
Configuration Utility (CCConfig), click on its node in the Site Tree and select Upload Site:

Site List i x |
Sites

2o BAChet IP

2o BACnet Serial

'JE-E Campec kincl D
Discover Site L\\,

Export Aspect Data
Create BACnet EDE Data
E,, 001-001 - CBM24

E‘"'JE-_E Sample Apps BACnet
2. ™ A0t - Wet Sucternc

Discovery Site Details

Please ensure the information is correct for the site you would like to discover. For
BACnet sites, ensure the Timeout value is large enough.

— Site Details — Metwork Tyjpe ———————
Site Mame |Campus block R € BAChet Serial
Site Directory |CAI\-1PBLOR & BACnetIP

Site Number |5
Device ID Range ﬂ to 4194302

Wait Timeout (s) | 25

MSTP Metwork

Discover I Cancel |

The Discovery Site Details dialog will be displayed as before, but in this case, the Site details are not editable.

When configured, click Discover.
After the discovery process is started, the Site Discovery Progress dialog appears showing its progress:
Site Discovery Progress

Below is the progress of the discovery process. Please wait until this is finished before
attempting to communicate with another site or press cancel to finish the process early.

—Site Details Summary
Mame ’m “I-Am” Received Count ’B_
MNumber ,57 Properties Read Count ,07
Metwork |BAChet

~ Controller Discovery

Calling Whols on Network...

Reading Device properties...

Attempting to connect to site < Campus block R=... Cancel

If you click Cancel to stop the process, any uploaded information is discarded and not applied to the Site in

CXprotp.
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When the discovery has concluded, the discovered Fieldbusses /BACnet Routers are displayed in the BACnet
Explorer dialog:

BACnet Explorer - X

This Is the BACnet Explorer dialog. Below is the list of devices that were discovered. To edit any of the details double dlick on an item in the list. To begin reading in the object list of a device expand its node
In the Tree View.

Any newly discovered devices will be in white, Devices that have already been configured will be highlighted in Green or Red. Green means that the device discovered matches the addressing of the site
configuration. Red means there has been a clash between the device information discovered and the device ion in the site i i

NOTE: If BACnet NAT Routing is enabled on a router or CXpro, it is not possible to place MS/TP controllers under the correct BACnet routers.

Site Details
Name  Manual Demo Number of Devices |3
[¥]%2 Manual Demo Name [mac  Tmpe  [No.types [Modet  [instance [vendorio [msmenetwork [ipaddress |
B E! FBXi 915023 (915023) FBXi 915023 1 FBXI-X256 8 FBXi 915023 m 502, 503 192.168.6.25
@ 9 Object-List CBX Chris Desk 1 CBX-8R8 1 CBx 6000 m 502
T CBM Chris Desk1 2 CBM12 1 ucs2.12 3000 m 502
CIF Network 503

&[] Network 502

W Select/Unselect All

Rescan l
I™ Sort by Instance Number
Number of Devices found: 3 Cancel I

and any discovered sites are added to the Site List

Site List o B
&g CYLON A
@-5g Desk
@-Fo Disc Desk
@-2g disctest
@-$g FBViSite
&-Fo FBX Test
&-Fo FBXiTest2
@- g FBXiX43_BLANK
@-5g fud test
- g FUDReview
@-3g fudreview?
gin heatingOptimizer - Input Z
é-h MadisonOnsite
@-2g Manual
B-§g Manual Demo
=Rl
B ork 502

. B-5 Network 503

@-Fo newCBXIFUDTEST3

@-Fg NEWSITEL04

&gﬂ OptimizerinputZ
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FULL UPLOAD AND DOWNLOAD
DOWNLOAD

FBXi, CBXi and FBVi controllers with Firmware v9.1.0 and later have additional capabilities over previous ABB
Cylon controllers and are referred to as “Smart Routers”. One of these features is the ability to store the
strategies and configuration for the controller, and also support full upload and download of data for MSTP
fieldbus controllers.

When changes are made to the strategy of a selected Controller, and then the Connect button is clicked,

[

File = Mome  Controfier Strategy

"comﬁ ¢ 1 (71 copy [E E 3, ®geacnet points E B Create g O Q. Logging g

o Discottect [0 Ry & | @y Paste @ BaCnet units fy Manager 3 Qg Configuration

Downiosd Upload Audit | View | Add VO  Reorder Strategy | View | StartPause Stop  Reset Display
log | [LiSelectAl |modules| Text Terminats Modules " Strategy Details melp  Macros) [ £6t Template .

Site Controller Clipboard Strategy Macros Simulation Settings

s a 001_00.532

_(i”cmn«' (Ctren

$g FBxiTest
8-5g FBxTer
©-1g FBXDX48_ BLANK
@-3g fudtest
8-%g FUDReview
©-1g fudreview?
@-Fg heatingOptimizer - Input 2
@-Jg MadisonOnsite
&-Fg Manual
8-%g Manual Demo
& 53 rBXi915023
&P Network 502
8 ; Network 503
©-§g newCBXGFUDTESTS
&-Fg NEWSITEL.OH
@-1g OptimaerinputZ
@-Ho Sample Apps v2.0
©-3g Semple Apps v3.0 v

HNavigation L - |
CXprotP checks whether or not the controller is connected to a Smart Router —i.e. a router that supports full
upload and download of controller data.

If it is, then downloading will proceed as follows:

1. Click the Download button. it may be accessed from the Strategy tab or the Controller tab.

[
File -  Home  Controller  Strategy |
& Connect 3. 4. (f copy
.' Disconnect LJ u m Paste
Dwmt’d Upload Audit .
Log L. jSelect All
Site Controller Clipboard
Site List N

[ 8 Fuan -

2. The Audit Log dialog will open. The User field will be auto-populated with the current Windows user, but this
can be edited if required. An optional Comment (change message) may be entered, for example a description
of and justification for the changes made to the strategy. The timestamp is added automatically.

Audit Log
User ITara Date,Time |2022435«35 13:45:00
Comment
Recent Comments |
User | Date/Time | Comment
Tara 2022-05-05 13:44:44 test
Tara 2022-05-05 13:40:28 sec

B =

Note: By clicking the Recent Messages button you can reuse one of the 10 most recent messages to speed up entry
of the Comment (change message).
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3. Click the OK button on the Audit Log dialog to continue with the download process.
4. Next, the data currently held in the router is uploaded,

Download

wmmﬂum

Uploading blob from router...

Comparing uploaded strategy with strategy on PC...

N I

5. Then CXproHP compares the upload with the strategy on the PC to identify ‘breaking’ changes (changes
that would significantly impact the operation of the controller). For example new modules added to the
strategy might be considered ‘breaking’ changes, whereas changes to internal constants in a module
might be considered ‘non breaking'.

m If ‘breaking’ changes are identified, CXproHP will display a message informing the user that a
Full download is required, which will cause the outputs of the controller to cycle.

9 CXproHD X

Breaking changes have been found between the uploaded =
y k strategy and the strategy on PC. A full download must be
done.

g: D g will wipe the ¢ and cycle the -
outputs. Continue?
| ||

= If no ‘breaking’ changes are identified then a partial download will be carried out, where only
the changes are sent to the controller and the outputs are not cycled.

Note: During the conversion from CXproP vi.5 to CXprotP vi.6 and the upgrading CBXi/FBXi/FBVito v9.1.0, if
there is no upload file present then breaking changes cannot be identified — meaning that the alert will not
appear. Once there is an uploaded file to compare with the PC version of the strategy, then the breaking
changes alert will appear if appropriate.
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UPLOAD

FBXi, CBXi and FBVi controllers with Firmware v9.1.0 and later have additional capabilities over previous ABB
Cylon controllers and are referred to as “Smart Routers”. Features include the ability to store the strategies
and configuration for the controller, and also support for full upload and download of data for MS/TP fieldbus
controllers.

An FBVi controller will allow upload of its own strategy only.
A CBXi or FBXi controller will allow upload of its own strategy or upload of strategies from an MSTP network
controlled by it.

For example: If a site contains a mix of CBXi controllers some with v9.0.0 and a some with v9.1.0, only those
MSTP devices connected to the v9.1.0 CBXirouters will have the option to upload strategies. Any MSTP
controllers under any of the v9.6.0 CBXi routers will not have that option. Once those CBXi routers are
updated to v9.1.0, the MSTP devices connected to them will have the option to upload strategies.

Sample Update Scenario:

Update CBXi controllers on a Sitetov9.1.0 firmware
2. Run Discovery on the Site in CXprotP v1.6
3. CBXi controllers that were formerly at v9.0.8 and the MSTP devices under those controllers are now
recognized by CXproP as being capable of upload/download. However, in order to make the upload facility
available strategies must first be downloaded as follows:
a. When converting a site from CXprotP vi.5 to CXprotP vi.6 make sure that all setpoint values
have been saved to the PC copy of the strategy. To do this, right-click on the controller and
select Strategy Operations > Upload Setpoints.

b. After upgrading the smart router, download the strategy back to the controller. The facility
to upload the strategy back to the PC is now available.

If a fieldbus is controlled by a Smart Router, then the strategy and configuration of that controller and also all
MSTP fieldbus controller data can be uploaded as follows:

1. Right-click on the controller and select Upload Strategy or the Upload button, accessed from the Strategy tab
or the Controller tab.

| A [

File -  Home  Controller  Strategy | File -  Home  Controller  Strategy
A Connect ¥ 4 f copy & Connect B ications gy Download )W
¥ Disconnect R o [F) Paste ¥ Disconnect B Controller ty Upload By C
N 2 ~ o

Download Uplw Audit | O Al
log | L.]Selectan ® BACnet B Audlyog o
Site Controller Clipboard Site Configuration
Site List B | siteList o

2. Datais uploaded from the Smart Router.

Upload

Uploading from controler...

Uploading blob from router...

Comparing uploaded strategy with strategy on PC...
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3. CXproHP compares the upload with the strategy on the PC, and if there are differences, they are displayed
in the dialog below:

Site : Manual Demo  Comms Controller No.: 1 Field Controller No.: 0
Type Service Or... | Block Type | bitterence
Strategy Blocks 3 Absolute Value The block of type Absolute Value at address 3 on the strategy is not present
< I >
@ Shaw only blocks with differences € Show all blocks
PC Controller
~ ~
v v
< > < >
_cone |

o Ifthelisted differences can be overwritten on the PC, click the Continue button, and the
strategy in the PC will be replaced with the uploaded version.

o If the differences are such that you don’ t want the strategy on the PC overwritten by what is
on the controller, click Cancel and the strategy in the PC will be maintained, and can later be
downloaded to the controller.
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A

ABD

Dashboard

=" BACnet
£ IP Network

+)

| 24

O
.4
.4

RS 485 forts
Smart Router
" Devices
Platform
Captures
Diagnostics

Device name: FBXi Series 123456 192.163.1.2 & -

Devices (click row for details) <} refresh
Name Instance Network Address Status
001 - FBXi-X256 123456 500 192.168.1.2 v
CBX001 749283 502 1D:125 L

)| Sites

SMART ROUTER CONTROLLER REPLACEMENT (WEB PAGE)

Smart Routers (such as FBXi-X256, FBXi-X48 or CBXi v9.1.0 or later) can facilitate controller replacement
through the Router Web page, allowing an ABB MSTP controller to be easily replaced and restored of without

the use of CXprotP,

Devices List

In the Web UI of a Smart Router, an overview of the MSTP controllers connected to it is displayed by selecting

Smart Router > Devices from the left-hand menu:
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A.' Device name: FBXi Series 123456 192.163.1.2 &~
& Dashboard Devices (click row for details) % refresh
2" BAChet ¥ Name Instance Network Address Status
&% IP Netvork : 001 - FBXi-X256 123456 500 192.168.1.2 v
#) RS 485 Ports . caxool 749282 502 D125 v
A Smart Router
" Devices
O Platfiorm M
% Captures v
% Diagnostics M
For Smart Routers that have no strategies downloaded to them, no controllers will be listed.
If the Smart Router itself contains a strategy that has been downloaded, the router will be the first controller
on the list.
If any of the MSTP controllers that are directly connected to the smart router have downloaded their
strategies, they will appear on the list.
Overview information such as Device Instance, Network, Address and Status information for each controller is
displayed in this view.
If the Smart Router can communicate with a controller, a green checkmark is displayed in the Status column for
that controller.
If the Smart Router cannot communicate with a controllers, a red X symbol is displayed in the Status column
for that controller.
‘\I" Device name: FBXi Series 123456 192.166.1.2 &~
A& Dashboard Devices (click row for details) <* refresh
" BACnet ¥ Name Instance Network Address Status
s IP Network v .
9 RS 485 Ports v 001 -FBXi-X256 123456 500 192.168.1.2 v
Py « CBX001 749282 502 1D:125 x
Smart Router
%" Devices
Q Platform v
% Captures v
% Diagnostics v
If one of the controllers is replaced with a new one that is configured with the same MSTP address, a blue
download icon is displayed in the Status column:
‘\'I‘ Device name: FBXi Series 123456 192.168.1.2 & -
A Dashbosrd Devices (click row for details) <% rafrash
2" BACnet Y Name Instance Network Address Status
f: ::S':Z:v:rk T oor - s xes 123456 500 192.168.1.2 v
N orts CBX001 743283 502 IDA25 L
X Smart Router
%" Devices
QO Platform v
% Captures M
% Diagnostics M
(0]
[QN]
>
(W)
—
m
m
—
(@]
b
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Accessing a controller manually

To view detailed information about a specific controller (including the current and previously discovered
state of the controller, as well as relevant timestamps), and to backup/restore it manually, click on that
controller in the Smart Router > Devices list.

A'. Device name: 192.168.1.2
A Dashboard Configured Information i refresh
" BACnet
#a IP Network Instance: 749282

Name: CBX001
User ID: grosu
CXPro Created: ~ 2022-05-07T12:18:40+0300

#) RS 485 Ports
L. Smart Router

4 4 4 4 44

O Platform
% Captures Backup From Device: ~ 2022-05-07 05:18:56
% Diagnostics
Currently Discovered Previously Discovered
Instance: 749282 749282
Name:  grosu grosu
Serial: CX16749282C CX16749282C
Network: 502 502
MAC: ID:125 1D:125
Model: CBx CBx
Version:  CBx 9.0.0-A8 21-10-22 Boot Ver.03.03.04 CBx 9.0.0-A8 21-10-22 Boot Ver:03.03.04
Strat. Size: 2610 0
Date:  2022-05-07 05:48:27 2022-05-07 05:19:01

Status: Normal

# Restore to Device Restore the targeted controller to last saved configuration.

# Backup from Device Backup strategy and BACnet settings from device.

# Delete from Router Remove this CXPro configuration from SmartRouter.

There are 3 buttons at the bottom of this page:
1) Restore to Device

Clicking this button restores the state of the previously configured controller at the same MSTP
address . This would be used if a new controller was put in the place of an existing one, and the new
controller was assigned the MSTP address of the one it is replacing. Select the old controller from the
Smart Router > Devices list and click the Restore to Device button. The stored strategy and device data will
be restored to the new controller and the green checkmark will appear in the Smart Router > Devices list.

2) Backup From Device

The Backup from Device option allows the manual transfer of the device strategy and BACnet data
(including setpoints, k-factor etc.) to the Smart Router.

Note: This step is required in the case of a controller that has been commissioned while CXprotP is not
available on site. This could happen if, for example:

- A VAV was balanced using AeroBT or
- A BACnet program such as NBPro is used to change values in a controller strategy

If the controller is replaced at a later stage, the Backup from Device step will ensure that the
commissioned data (such as k-factor) will be available for the replacement controller.

If CXprofP is subsequently connected to the site, it can be updated by running the Batch Upload
command, and the saved setpoints will be uploaded to the strategy on the PC for backup.

3) Delete from Router

The Delete from Router option will delete the controller information from the Smart Router so that it will
no longer appear in the Smart Router > Devices list. The functionality of the controller will not be
affected, and it will continue to run the existing strategy file.

Note: This will delete the backup and will not be recoverable. Please ensure that the strategy has been
saved in CXprotb.
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BATCH UPLOAD AND DOWNLOAD
BATCH DOWNLOAD

It is possible to download multiple strategies from the PC to multiple controllers in a single action. To do this,

1. Right-click on a site in the Site Tree, and select Batch Download:

Site List g o
5-Sg CYLON A
ig Desk

to Disc Desk

Lo disctest

2, FBV Site

Lo FBXiTest

g FBXiTest2

fo FBXiX48_BLANK

Eo fud test

2o FUDReview

bg fudreview2

fg heatingOptimizer - Input Z

Lo MadisonOnsite

tg Manual

L2 Ry

= FBXi ¢ Discover Site
aFN Backup Site

| E-v'? N

- 8g newcBXi | Batch

@-2g NEWSITE' Batch Upload
@-3g Optimize

DREERERREEEEEEE8

Ubarade Firmware

2. Select the controllers for which strategies will be downloaded from the list of all of the controllers on the
selected site

Note: If a controller does not have an associated strategy it will not be displayed in this list

Select Devices X
Check \ Uncheck all kems under the selected node

Checkal | Uncheck Al |

- @) Sites
8

E Manual Demo
3 Fexi915023

3. When the required controllers are selected, click the Continue... button. The Select Batch Download Options
dialog will be displayed:

Select Batch Download Options

Download Options
Continue with if:
¥ strategy contains dsabled modules
™ Strategy contains obsolete modules
¥ Breaking changes found (Smart Routers only)
Warning: Breaking changes requires controllers to be wiped.
Warning: All controliers not under Smart Routers will be fully wiped.
FLX Configuration
If the controller FLX configuration differs from your local configuration
" Abort the download
(% Send the local configuration to the controlier
" Update the local configuration with data from the controller

Audit Log (Smart Routers only)

User dhris Date/Time | 2022-04-13 10:25:23
Change
Recent Messages
[oowicad ], | cnal” |

This allows you to define the conditions under which download would stop:

o Ifastrategy contains disabled modules (e.g. hardware points in the strategy for which there is
no corresponding physical FLX configured, or Modbus modules for which no Modbus device is
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selected), then the download will stop for that controller and download moves to the next
controller.

o If the strategy contains obsolete modules, then the download will stop for that controller and
download moves to the next controller.

o If “Breaking” changes are found, then the download will stop for that controller and download
moves to the next controller.

And to specify what should happen if extended I/O on FLX units is configured differently from what is
expected:

o Abort the download
o Send the I/0 configuration from the PC to the controller
o Leave the I/0 configuration on the controller, and update the PC configuration to match

If there is at least one Smart Router on the site, then there is also an opportunity to add a comment to
the Audit Log.

Select Batch Download Options
Download Options
Continue with download if:
[V strategy contains dsabled modules
¥ strategy contains obsolete modules
¥ Breaking changes found (Smart Routers only)
Warning: Breaking changes requires controllers to be wiped.
Warning: All controliers not under Smart Routers wil be fully wiped.
FLX Configuration
lfhmmmm\ts'amﬁﬂusﬁwmbdmﬁgum
€ Abort the download
& Send the local configuration to the controlier
€ Update the local configuration with data from the controler

Audit Log (Smart Routers only)

User | dris Date/Time [2022:04-13 10:25:23
|
Change | demo batch|
Recent Messages

[oowoad | concsl |

4. Click Download. Download will proceed for the selected devices, showing conflicts and if any of the ‘Continue
with download if’ in the previous dialog were unchecked, an error message will be displayed if the condition
is encountered.

Downloading Data...

Completed.

Processing 1 of [ 1 !:

Download Success for FBXI 915023 : Download success.

Close
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BATCH UPLOAD

It is possible to upload multiple strategies from multiple controllers on a site to the PC in a single action:

Note: If a siteis restored from a backup that was made when a specific Router’s firmware was earlier thanv9.1.0
and then a Batch Upload is carried out, the router will not be recognized as a Smart Router. In this case you
should either open the strategy and connect to the controller, or else run a Site Discovery. CXprotP will then
register the Router as a Smart Router and Upload/Download will proceed as normal.

1. Right-click on a site in the Site Tree, and select Batch Upload

Site List ag 001
6-3g CYLON ~
@£ Desk

8-$g Disc Desk
@-Fg disctest

B-2g FBViSite
6-3g FBXi Test
&g FBXiTest2
B-Fg FBXiX43 BLANK
@;BA

Q.

&

&

2

2q fud test

fg FUDReview

Lo fudreview2

[g heatingOptimizer - Input Z
Ig MadisonOnsite

tg Manual

L -
B8 FBXi 9" Discover Site
[cH ‘T“ Ne Backup Site

8- Ne

g newCBXiFl Batch Download
fg NEWSITEL | Batch Uple

Lo Optimizerl
[o Sample Ap
Ig Sample Ap Upgrade Sensors to Fusion Air

Upgrade Firmware

Upload is a feature of Smart Routers only, so when Batch Upload is selected for a site, CXprotP checks each
of the routers on the selected site and displays devices that are connected to a Smart Router in the Select
Devices dialog:

Select Devices X

Check \ Uncheck all Rems under the selected node

Check Al | Uncheck All
=} sm
e-%@
B FBXi 915023
B Network 502
L[JE3 cex Cheis Desk

L]% CBM Chris Desk1

This will show all devices under a smart router, whether they have a strategy or not, because they may still
have a strategy on the smart router.

2. Select the required devices:

Select Devices X
- Check \ Uncheck al items under the selected node

CheckAl | Uncheck Al

- §) Sies
[=R 2™ Manual Demo
E FBXi 915023
8-L1F Network 502

B3 CBX Cheis Desk
CBM Chis Desk1
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3. Click Continue. CXprotP uploads data from the router.

Uploading Data...

Completed.

eroceing [—5— of [—3 T

Upload Success for FBXi 915023 : The strategy has been uploaded.
Upload Success for FBXi 915023 | CBX Chris Desk : The strategy has been uploaded.
Upload Success for FBXi 915023 | CBM Chris Desk1: The strategy has been uploaded)

When complete, the selected controllers for which there were strategies on the Smart Router will have
Associated strategies even if they didn’t have any before.

Site Uist e |« 001.00.532 ' 001_1.01.532
&-2g CYLON ~
@-5g Desk
&g Disc Desk
&g disctest
@-2g FBVi Site
&£ FBXi Test
&5 FBXTest2
8-3g FBXiX48_BLANK
8-5g fudtest
&-2g FUDReview
&-3g fudreview2
£o heatingOptimizer - Input Z
82 MadisonOnsite

&-2g Manual
-2 Manual Demo
| -5 mxigss
B-F Network 502
-5 cx
L), CBM Chns Desk1
&G Network 503 175, Tonscay 3900 179
©-Ea newCEXFUDTESTS B
&30 NEWSITEL.04 0:00 - 17:00; Saturcay: 09100 -
@iﬂ OptimizerinputZ G 17:00; Sunday: 09:00 - 17:00
SepainT— =8

Setpoint values that are stored on the controller will also be saved back to the PC.

BATCH UPLOAD OF SET POINTS

To upload setpoint values from all controllers and update the local setpoint values to match, right-click on
the Site in the Site Tree and select Batch Upload Setpoint Values:

= 9 Sites
5o BAChet P
-5 001 - Metwork
B2 BACnet Serial
e

=R Degp

Discover Site

Backup Site

Batch Download
Batch Upload
| Batch Upload Setpoint Values

Bl Upgrade Firmware

This will open the Select Devices dialog.

Select some or all of the controllers on the Site:

r 5
Select Devices *
i Check % Uncheck. all items under the selected nade
Check Al | Uncheck Al
-] @Y Sites
REZE S Desk |
LI ceri4os1s1
5 rexione 313
+. B cexitosiat

Contirue. | Cancel
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Click Continue... to start a batch upload process.

CXproHD | Sites

When the batch process has completed, the status of each controller will be displayed as follows:

r . |

Uploading Data...

Completed,

Processing 2 of 2

Upload Success for CEXi 405151
lUp-Ioad Error for FEXi-B8RB 331131 : No Setpoints in strategy to upload.

Close |

VIEWING THE AUDIT LOG

Whenever data is downloaded to a controller that is under a Smart Router, the user has an opportunity to
record a comment about the change, allowing them for example to explain why the change was made.

The last 10 changes that were sent to the Smart Router can be viewed by clicking the Audit Log button which

is under the Strategy tab or the Controller tab:

B ¢ [ 2
File -  Home  Controller  Strategy | File -  Home  Controller = Strategy
# Connect é‘l '1] % () copy E | E & Connect B D ) wipe C |
¥ Disconnect Paste [ [ ¥ Dj troll ) Upload |
I Dowriosd Upised IR r@ Ivew | 20 *# Disconnect g Controller th Upload [ Compare
Log L.iSelect All | IModules| Te) % BACnet a Auﬁlog E73 show Compare ‘
Site Controller Clipboard Site Configuration Operat
Site List ol ¢ 00 Site List g 001_
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FIRMWARE UPGRADE

CXprotP can load firmware from a local file on the PC to one or more controllers. To do this,

1.

2.

3.

Right-click on a site in the Site Tree, and select Upgrade Firmware

E _,_nl CYLON ~

@-2g Desk
5o Disc Desk
a-Fg disctest
Qyzg FBVi Site
@-2g FBXiTest
&-Jg FBXTest2
m»i; FBXiX48_BLANK

B-2g heatingOptimizer - Input Z
@-$o MadisonOnsite
&-2g Manual

Discover Site
Backup Site
Batch Download
Batch Upload

g»h Optimiz Upgrade Sensors to Fusion Air

[Navigation ! Export ASPECT/INTEGRA Data

PSS VSN 2 N

select the controllers for which you want to upgrade the firmware.

Select Devices X
i Check \ Uncheck al tems unde the selected node

Checkal | Uncheck Al |

&.'Slu
i% FBXi 915023
Network 502

B8 BX Chris Desk
1.1, c8M Chris Desk1

Click Continue

CXproHp | Sites
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4. Select the .f1x files (for FLXeon controllers) or .bin files (for all other controllers) that represent the
required firmware.

Select Firmware Upgrade Options X |

[E— —
(g ,— (2] |—
[ e i
(0 I'— c ,_
BLaTezg
_' e £ Open X
c :
Lookin: [ CBX_FW - «®ckm-
4 * Name & Date modified v b
—— e | FBXi-FBVi-9.1.0-a1.flx 14/03/2022 14:04 fl
I [ Quckacoess 1 o FBVI-0.1.0-a2.f 24/02/2022 10:47 fl
74 ] FBXG-FBVi-9.1.0-a3 flx 03/03/2022 15:53 fl
Desktop | FBXI-FBYi-9.1.0-a4 fix 09/03/2022 11:44 |
- = | FBXG-FBVi-9.1.0-a5 ix 16/03/2022 11:02 fL
[ (o] | FBXi-FBVi-9.1.0-a6.lx 22/03/2022 1220 fl
(= Lbrares | FBXi-FBVI-.1.0-a7.fbx 25/03/2022 15:18 fL
@ | FBXi-FBVi-.1.0-a9! 07/04/2022 10:38 fl
- ) FBXi-FBVi-9.1.0-a10 12/04/2022 08:59 fl
e ] s PC | FBXi-FBVi-9.1.0-a11.fix 12/04/2022 1338 a |l
(2] ‘ | FBXi-FBVI-0.1.0-FUDBfix 16/11/2021 12:05 fl ‘
| FBXi-FBVi-9.10.-FUD10.flx 08/12/2021 08:38 FL |}
F8x bal
< >
I “
;d € Upgrade if controler version s older than: [ Fie name [FBxFBVS.1 0011 ~ |_No;... [
Fies of type [FLX Fies () =~ Cancel |1/
Ll = e
€ up [ — c r [
¥ Retan strategies on controllers ¥ Retan strategies on controliers.
& Restart each controller after each FW upgrade (% Restart each controler after each FW upgrade
" Delay controller restarts unti all upgrades completed € Delay controller restarts unt all upgrades completed
Configure Delays | cacel | Configure Delays | Cancel

5. Select whether all controllers will be upgraded (Always Upgrade) or just specific versions (Upgrade if controller
version older than:)

6. As firmware upgrade requires the controller to be wiped, specify if the strategy should be backed up
before the upgrade and restored afterwards by checking the Retain Strategy on controller box.
If Retain Strategy on controller is selected, it will be possible to select:

o whether each controller will restart as soon as its firmware is upgraded (Restart each controller
after each FW upgrade), or

o ifall controllers will be upgraded before any of them restart (Delay controller restarts until all
upgrades completed). This second option will significantly reduce the amount of network traffic,
saving time for the overall process.

7. When the dialog is complete, click Continue to download the Firmware.
To close the dialog without adding this Firmware Upgrade to the batch, click Cancel.

Note: When the firmware upgrade is run (i.e. when Actions > Run/Complete Batch is next selected) the Instruction
window will list any firmware upgrades as they happen. If Restart each controller after each FW upgrade was
selected, then the setup block sent with each restored strategy will restart the Controller. However, if Delay
controller restarts until all upgrades completed is selected, then the setup in each strategy will be set to @ blocks
and an extra Setup command will be sent at the end of the Firmware Upgrade process as shown below:

X H0  Fw Upgrade: CBT32¢x_7.57F (€] — [H] 002 - Cylon BACnet Router : 002 - 063 - UCU3213\
MK H1 Setup: “set [E) — [l 002 - Cylon BAChet Router : 002 - 063 - UCU3213\
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Upgrading Firmware...

FBXi 915023 Sending Firmware to FBXi Controller - Please Wait . . .

Processing [ 1 of [ 1

Close

Any errors or warnings will be displayed in the bottom part of this dialogue

Note: This upgrade can take a long time if there are large files to be downloaded.

When the upgrade is complete, the Router reboots, and a timeout is displayed for this:

Upgrading Firmware...

FBXi 915023 Waiting For Reboot - 32 Seconds Remaining...

Processing T of [ 1 [}

Close

Note: This can take some time, for example the FBXi device takes 65 seconds to reboot.

©ABB 2025 All Rights Reserved.
Subject to change without notice

SOLUTIONS.ABB/HVAC-BUILDING-AUTOMATION 200

MANO133 rev 29


https://solutions.abb/HVAC-Building-Automation

CXproHD | Sites

UPGRADE SENSORS TO FUSION AIR

Specific products (e.g. CBV-2U4-3T or FBVi-2U4-4T) which contain factory ‘canned’ strategies supporting
CBT-STAT sensors, can be automatically upgraded to support FusionAir sensors instead of CBT-STAT if
required.

1. Right-click on a site in the Site Tree, and select Upgrade Firmware

Site List > 8
&-2g CYLON ~
6-5g Desk
&-$g Disc Desk
&-Jg disctest
@-2g FBViSite
&g FBXi Test
&-Jg FBXiTest2
@-2g FBXiX48 BLANK
&-5g fudtest
61-2g FUDReview
@-2g fudreview2
@-5g heatingOptimizer - Input Z
63 MadisonOnsite
&g Manual
a5

=] F
| 8§  BackupSite

Discover Site

Batch Download
@G  BatchUpload

Bl newC e Fimwore

&-5g NEW!
&-3g Optir Upgrade Sensors to Fusion Air Iy
Navigation Export ASPECT/INTEGRA Data

Create BACnet EDE Data

Commission IP Devices
Commission MS/TP Network

Configure IP BACnet Device Properties

Edit Controllers
Delete Site
Properties

2. Select the devices to be upgraded:

Select Devices X
1~ Check \ Uncheck all items under the selected node

[ CheckAl | Uncheck Al |

2-§)Y Sites
B, e

]| S|

Note: If there are no relevant devices configured with factory strategies on the site, then nothing will be displayed
in this dialog.

3. Click Continue. Qualifying Strategies in the selected controllers will be updated to support FusionAir
sensors.
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ASPECT® / INTEGRA™ EXPORT

This feature saves data for a Controller, Fieldbus (Subnet), or Site into a JISON-formatted text file for import
into ASPECT® or INTEGRA™, allowing applications to be automatically configured in ASPECT®-Studio or
INTEGRA™ |T-8000.

STARTING THE EXPORT

To export a Field Controller, BACnet Router, or Site, right-click on its node in the Site Tree and choose Export
ASPECT/INTEGRA Data.

ACnet IP
ACnet Serial

Create BACnet EDE Data
Upgrade BACnet Units

If a Field Controller is selected, that controller’s information is exported to the ASPECT® / INTEGRA™ .5son
file, along with the parent network and parent site information as required to correctly import into ASPECT®
or INTEGRA™.

If a Fieldbus is selected, information for all controllers in that Fieldbus is exported along with the parent site
information as required to correctly import into Aspect.

If a Site is selected, information for all Controllers on all Fieldbusses within that site will be exported.

The points that will be exported will be those that are specified in the Export column of the BACnet Points
dialog. The BACnet Points dialog is opened by clicking on BACnet Points in the Strategy tab of the ribbon - see
How to expose Points on a BACnet systemon page 128.

BACnet Points x
- Select BACnet Poi

BACnet | Export | Point Name. Point Adar | Paint Type |

Room Setting 5 Analog Setpoint

a MaxHWater 28 Analog Virtual

a Adder/Scaler Black 13 Output 29 Analog Virtual

‘WeatherCom Block 8001 Inpu 30 Analog Virtual

=] Heating Water Temp H Analog Input

I?

Alarm Enable 2 Digital Setpoint

a Digyirt 3 H Digital Virtual

[u] Sehedule No. 1 (On) 4 Digital Virtual

a Hysteresis Block 15 Adive High 9 Digital Output

BACnet Point Usage [~ Binary Unit String Usage ————————
Maximum BACnet [a Madmum Binary Unit [32
Used BACnet [ Used Binary Unit E
Available BAChet [z Available Binary Unit Il
Export Total |
Setpoint Li
Max Unexposed Setpoint and BAChet [ 324 Unexposed 0]
Available Setpoints / BACnet Paints B
Resolve Duplicate Point Names
oc Cancel
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After exporting, set a name for the export file that you want. By default, it is set to the name of the Site. The
filename extension must remain as . json for easy import into ASPECT® or INTEGRA™.

= Save As ﬂ
T« CXproHD » CAMPELOR v & Search CAMPELOR el
Organise MNew folder 5= v [7]
| AITEMP A Name . "
;o ARCHIVE
|| APPLBACN - -
J dbase
0 Archive .
BACNETIP . DRAWINGS
N
. KEYPAD
|| BACNSERI . MACROS
.. Bitmaps - wrats
¥ ra
|| CAMPBLOR .
. STRATEGY v
.. ARCHIVE v < o
L RN Campus block R.json| v
Save as type: v
4 Hide Folders Save | | Cancel

After setting the filename, click Save.

The process will begin to export information. The Creating Aspect Data... dialog will be displayed to show the
progress of the export:

Creating Aspect Data...

001 - UC32netk. - 007 - UC3224
Processing: E of 12

001 - UC32netk - 012 - UC3224: Datalog block 14 has a connected point that is not named. -
001 - UC32netK - 012 - UC3224: Datalog block 131 has a connected point that is not named.

001 - UC32netk - 012 - UC3224: Datalog block 250 has a connected point that is not named.

001 - UC32netk - 012 - UC3224: Datalog block 251 has a connected point that is not named.

001 - UC32netK - 012 - UC3224: Datalog block 252 has a connected point that is not named.

001 - UC32netk - 012 - UC3224: Datalog block 253 has a connected point that is not named.

001 - UC32netK - 012 - UC3224: In path "/C/Aspect_v_Unitron/001_UC32netk/012_UC3224", "reset” is a reserved word
001 - UC32netk - 011 - UC3224: Datalog block 14 has a connected point that is not named.

001 - UC32netK - 011 - UC3224: Datalog block 131 has a connected point that is not named. v
nm - Hr?netk - 011 - 1HI5224- Natalon black 260 has a connected nnint that ie nob namead

£ >

Cloze |

For any errors or warnings encountered, you will see the network (Fieldbus) name, the name of the controller,
and the action that should be taken. Correct these errors in the appropriate strategy or configuration and
then start the Export process again.

You may stop the export process at any time and review the errors and warnings.

You may copy the errors and warnings from the dialog into a document or email.

When finished, click Close to complete the process.

IMPORT INTO ASPECT®-STUDIO AND INTEGRA™-PROPACK

Refer to MANO129 ASPECT®-Studio for details about importing the . json data into ASPECT®.
Refer to MANO140 INTEGRA™ ProPack for details about importing the . json data into INTEGRA™.

Launching CXpro"® from INTEGRA™-ProPack

When an export file from CXprotP is imported into an IT-8000, it is then possible to launch CXprot from the
INTEGRA™ Ul - targeting a specific controller for engineering or debugging.
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In order to do this, ensure you have CXprotP installed on your computer, and INTEGRA™ version 4.7 or greater
isinstalled on the IT-8000 or supervisor. Also, ensure that the CylonService is installed.

You must also have a copy of the CXproP project and strategies in CXprotP.

Note: The CylonService uses the site name and device instance numbers to locate the strategy in CXproHP, so you
must ensure that the site name in the INTEGRA™ station matches the site name in CXproHP. To verify or edit
the site name in the INTEGRA™ station, open the property sheet for CylonBacnetNetwork :

: Config : Drivers I CylonBacnetNetwork
Property Sheet
@ CylenBacnetNetwork (Cylon Baenet Netwerk)
[l status {ok}
(8 Enabled @ true
(i Fault Cause
L Health Ok [06-May-19 10:34 AM EDT]
© Alarm Source Info Alarm Seurce Info
L3 Monitor Ping Monitor
B Bacnet comm Bacnet Stack
B Local Device Local Bacnet Device [device:10000]
X Tuning Policies Bacnet Tuning Policy Map
[l site Name ProPack
W uploadonstart [ &
1 INTEGRA BacnetDeviceFolderINTEGRA

To launch CXprotD, right-click on the ABB Cylon® controller and choose Launch CXproHD:

er Cylon Bacnet Device Folder
 orivers Launch CXproHD

Cylon Bacnet Device (221 2 ]

Cylon Bacnet Device Folder

6 MiagaraNetwork
6 CylonBacnetNef
- Local Device
E Bacnet Com rigg S Cylon Bacnet Device e o c
Q Monitor

X TuningPolici

Views

Actions 1 Cylon Bacnet Device Folder

Cylon Bacnet Device Folder

2U4 3T Cylon Bacnet Device @ o c

I chill Mak E
c: = Make Template VAV Cylon Bacnet Device eoc
s CEX_8Rj

Edit Tags

A FirstFlonr it
CXprotP will open at the project and the last-saved strategy for the selected controller, allowing you to debug,
make code changes, and download it to the controller.

@ services L.idelect All | Mogules Tedt Terminals Modules 3 Strategy Details g
site Contraller | Clipboard Strategy
© orivers

L
oNlagaraNEtwurk ’.8 t

Site List 28 |« 002_01.532
6 cylonBacnethetwork
2-§) Sites
Bl Local Device £, 10020600
B Bacnetcomm 25 10020601
‘Anaiog Input 1
L monitor oo - Al SWTemp . .
X TuningPolicies = Fort O frrf————4
-2g BACnet IP . e (g Bl
I chiller @-Ea BACnet Serial
& CBX_8RE o-5g CBX8RE
A FirstFloor -2 Cylonlmport_1000
@-Fa NewSite
@ apps 2-2g ProPack
&) Files 558 cexi
i b, ceTizivav .
alette I R ok ot T
B2 &), cev a SWTSEPt
] 154 INTEGRA : > : :
D) cylonService | poin: & |———»_
E 2@ 5 coxars
3 cylonService Fmple Apps BACnet
B cylonBacnetNetwork
9 CylonBacnetDeviceFolder DI Digial Input 3%
| PmplStat
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Note:

Note:

Aero“" CONFIGURATION

Aero®T is a mobile application that allows users to commission Controllers, edit Setpoints, and view graphs for
tuning Site performance.

In order to use the mobile app, the Site must be configured to expose setpoints and points to graph, from
CXprotb,

This feature is only available for controllers that have External Flash.

Aero®" Configuration is only supported on controllers with Firmware Version 9.1.6 or greater.

From the Ribbon Bar under the Strategy Tab, select Configure AeroCT.

En =
File = Home Controller Strategy
& Connect 4 ' f {# copy E o g BAcnet Points E [ Create
’a’ Disconnect l—] |E|Paste .l= BAChet Units E Manager
Download Upload Audit — View Add I/ Reorder _ |Configure Strategy View — .
Log LiSelect Al Mogules Text Terminals Modules 1 Strateqy Details | aerocT Help Macros [ Edit Temp
Site Controller Clipboard Strategy Macros
Site List o 4 002_01.532 Configure AeroCT
EO Sites ~ Configure points and graphs to I
E.E 214 CBT D Sl expose in AeraCT r
28 chnn mosoi 123 [ Modulating EC Mator
This opens the AeroCT configuration dialog:
En AeroCT Cenfiguration *
Setpoints to Configure from AeraCT
Name | MNumber | Type | ~
inputCaonfig 1 Analog
[v] zonesp 3 Analog
occSPDeadband 4 Analog
unoccSPDeadband 21 Analog
standbyOffsetspP 28 Analog
sliderspansP 36 Analog
MET_ShedPercent 40 Analog
unitConfig 42 Analog
occCmd 63 Analog
SuppIyAIrsP B0 Analog o
Tuning Graphs in AsroCT
MName | Description | Add |
Counter
Tuning Example Edit |
Delete |
OK I Cancel

The list at the top of the AeroCT configuration dialog shows all of the BACnet exposed Setpoints in the strategy.
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By default, all BACnet exposed Setpoints in the strategy are set to be configurable in the AeroCT application.
However, you can select a subset of Setpoints to be configurable in the AeroT application by unchecking the
box beside any setpoint that should not be visible in Aero®.

This list supports multiple selection to easily check/uncheck groups of Setpoints.

TUNING GRAPHS

The second list in the AeroCT configuration dialog shows Tuning Graphs that can be viewed in the Aero®"
application. The Description field will show if there’s any issues detected with the Tuning Graph.

To define a Tuning Graph, click the Add button. This will open the Add AeroCT Tuning Graph dialog.

En Add AeroCT Tuning Graph pd

Name I

Points to Graph in AeroCT (0/10)

Name | Number | Type | A
[ strategyVersion 2 Analog Virtual
] cBTStat_Temp 43 Analog Virtual
] cBTStat_Humidity 44 Analog Virtual
] CBTStat_HeatingSP 45 Analog Virtual
[[] cBTstat_Coolingsp 4 Analog Virtual
[ activeCoolsP 45 Analog Virtual
[ activeHeatsp 50 Analog Virtual
[J zoneTemp 61 Analog Virtual
1 fanRuntime 68 Analoa Virtual v
Setpoints to Configure in AeroCT
Name | MNumber | Type | Description I ~
[inputConfig 1 Analog
[ zonesp 3 Analog
[ occsPDeadband 4 Analog E
] unoccsPDeadband 21 Analog
[ standbyOffsetsp 25 Analog
[ sliderspansp 36 Analog
[INET_ShedPercent 40 Analog
[ unitConfig 42 Analog W

[a]4 | Cancel I L

The Add AeroCT Tuning Graph dialog lists all BACnet exposed Virtual and Hardware points in the strategy. Up to
10 Points can be selected to Graph in the Aero®" application

The second list in the Add AeroCT Tuning Graph dialog shows the BACnet exposed Setpoints in the strategy.
Select any Setpoints that will be configurable for this Tuning Graph. You can also add a short description to
each Setpoint that will be visible in the AeroT app.

All Tuning Graphs require a name, which must be set in the Name box at the top of the Add AeroCT Tuning Graph
dialog.

When the Tuning Graph is configured, click OK to close the Add AeroCT Tuning Graph dialog and return to the
AeroCT configuration dialog

When all required points and setpoints have been selected, click OK to close the AeroCT configuration dialog.

To send the Aero®T configuration to the controller, carry out a Strategy Download.
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13 Appendix :: Configuring Units of Measurement
and State Strings

ADDING UNITS OF MEASUREMENT

Additional units of measurement may be added to the existing list of units in a site to allow for a greater
range of applications. Units must be added to the site.ini file in the c:\CXproHD\ (SITENAME) \SYSTEM
directory

Note: Before changing the site.ini file, make a backup copy (for example, site.ini.bak).

The site.ini file can be edited in a word-processing program such as Microsoft Windows Notepad, or
Microsoft Word. If you use Word to edit the file, make sure to save the file as a "Text Only" document.

HOW TO ADD UNITS OF MEASUREMENT TO THE SYSTEM

Make a backup copy of site.ini.
Open site.ini, using a word processing program.
Search for the [AnalogUnits] section if adding analog units, and the [DigitalUnits] section if adding
digital units.
Either
o edit one of the entries marked “spare”
(e.g. change UNTITS61="Sparel" to something like UNITS61="m/s")
or
o append the new units to the list of units
(for example, add something like uNTTS74="m/s" to the end of the list of analog units).
If you add to the list in this manner, be sure also to increment the NumberUnits parameter so that it
matches the final number of units. Ensure the number at the end of the units variable (e.g. un1Ts74) has
a number at the end that matches its place in the list of units.
Save the amended site.ini file.
Close and restart CXprotP, to allow the changes to take effect. The new units can then be selected from
list boxes for point configurations.
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EXAMPLE OF ADDING UNITS TO ANALOG UNITS LIST

Old analog units Bst:

Hew list after changing:

[Analoglinit=s]
MmbherThits=19

Titla="TT"
UNITE1=" "
UNITEZ=" %"
UNITEZ=" &#rH"
UHITZ4=" "C"
UNITSE=" Eits"
UNITS6=" g/kg"
UNITZ7=" Hz"
UNITEE=" ki dg"
UNITES=" kih"
UNITE10=" L/s"
UNITZ11=" Min"
UNITS1Z=" mV"
UNITS13=" Pa"
UNITE14=" Sek"
UNITE15=" Std"
UNITS16=" Wolt"
UNITE17=" har"
UNITZ18=" K"
UNITE15=" Ulr"

[Analoglinits]
MmberThits=£1

Title="TInit"

TNITZ1="
TNIT3Z="
TNITZZ="
TNITS4="
TNITZE="
TNIT36="
TNITZ7="
TNITZ2="
TNITZ2="
TNITZ10=
TNITZ11=
TNITE1lE=
TNIT313=
TNITZ14=
TNITS1E=
TNIT31l6=
TNITS17=
TNITZ18=
TNITZ13=
TNIT3Z0=
TNITEE 1=

v
(rH"
apn
Bitcs"
aikg"
Hz "
kj ag®
kI
Lrs"
Min"
i
Pa"
Bel"
Sod"
Tole"
har"
B
Thr "
mSs"

]-Ig'_.'r]II.B"

Note: Units are also listed in the C: \CXproHDCXpro#P\SYTEM\WN3000.ini. However, this file is for legacy
applications only and applies throughout the CXproHP system, and so must not be edited.

Note: Take care when editing site.ini not to change the section headings [AnalogUnits], [DigitalUnits], etc.

in any way, because this can cause errors in the CXprotP system.
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CONFIGURING STATE TEXT STRINGS

The State Text strings are strings that can be displayed in the front end to represent the value of a Multi-state
Value object. These strings can be configured (per strategy) as follows:

On the Strategy tab of the CXproHP Ribbon, click Edit State Text to open the Edit State Text dialog.

Strategy

L= Nl

ad Audit

(B 8 By v B [ ]

View | Add /O Reorder Configure Strategy = Vi

log | LiSelectAll |Modules Text Terminals Modules 5 Strategy Details AeroCT  Help | Ma
ler Clipboard Strategy
> K 001_00.532 @ Edit State Text

Edit the State Text strings for Digital |
points and Multi State Values on

r
this strategy

This dialog will show all State Text strings for the current strategy.

These strings are also used for the Low and High units of Digital Setpoints, Digital Hardware Points, and Digital
Virtual Points.

Strategy Details X
Display Text Add
| On
New Line D
1 Ger .
i
| strateoy Blocks
Controller Limits Faut
Trip
Resources Normal
Frost
Points Manager Run
Aam
Reorder Modules Enable
| Disable
| BaCnet units Fre
| . | Smoke
|| Mutti State value Text | | Reset
I Start
Heating
Cooling
Auto
| Manual
| Fai
| Lockout
| Max
| Mn
Low
Hah
State Text Used: |73 Avaisble State Text: [182
Note: These are also used for High/Low Unt text for Digtal points.
OK I Cancel

To add a new string, click the Add button.

To delete an existing string, select the string and click the Delete button
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Appendix :: File Management

FILE MANAGEMENT IN CXPRO"P

On a large site with multiple BACnet Routers where more than one engineer will be commissioning software
at any one-time file management becomes very important.

You must ensure that no one modifies the same strategies / global files that an engineer is currently
commissioning. To guard against this, we would recommend that all files are stored on a central computer
and only the files required for commissioning are copied onto the engineer’s laptop. We would also
recommend that each engineer is allocated a single BACnet Router to work on at any one time. At the end of
each day/commissioning period, the data files for the BACnet Router are copied back onto the central
computer.

The data files required to commission a single LAN are as follows:

C:\CXproHDCXpro#P\ [SiteName]\dbase \* Where *is the address
of the BACnet Router to
be commissioned.

All files under Where *** is the
address of the BACnet
Router to be
commissioned.

C:\CXproHDCXproHP\ [SiteName] \strat5\***

The same files should be copied back to the central computer at the end of each day/commissioning period.
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Appendix :: BACnet Explorers

CXproHP includes two utilities that facilitate the commissioning of BACnet Sites: the integrated BACnet Explorer,
accessible from the Ribbon and the Site Tree, and the integrated Discovery Tool, accessible from the Site Tree.

CxproHt | Appendix :: BACnet Explorers

It is also possible to use the separate legacy application NB-Pro, available from the ABB Library.

INTEGRATED BACNET EXPLORER

The integrated BACnet Explorer allows users to discover BACnet devices on their network, explore BACnet
Objects, and view and edit the BACnet Properties of each one. It can be used to discover a full network of

BACnet Devices or a single BACnet Device.

The BACnet Explorer can be launched from a button in the Ribbon Bar or from the Site Tree context menu.

ELRE @
Database Datalog BACnet —Settings
Interface Manager Explore|

¥y BACnet

[ strategies
@ Reopen Strategies

Utilities Settings

r’| BACnet Explorer
L]

Start BACnet Explorer.

Site List 2 @4

001_00.532

B-§) Sites

S0 BACnetIP
Bo BAChet Serial

Break Association

Uplozd Strategy

Configure Modbus Devices
Copy Strategy To

Batch Download
Upgrade Firmware

Strategy Operations

Export ASPECT/INTEGRA Data (router only)
Export ASPECT/INTEGRA Data (entire network)

Update BACnet EDE Data

Commission MS/TP Network

Commission this controller

BACnet Explorer - Network
BACnet Explorer - Device

a

This will launch the BACnet Explorer window and begin discovering the BACnet Devices on the network, based on the
BBMD settings.

i BACnet Explorer

stings | |

BEMD IP Address | 192.168.5.141 BEMD Port [ 47808

=

i

]

&) BBMD: 192,168,5,141:47808

Network: Local

() Paulina] FBVI 39044 (39044): (192.168.5,121:47

O FEXi 152002 (192_168_5_141) (152002) : (192.76¢

O FBVi 39040 - 91,0 (35040) : (192.168.,5.128:47580¢
O CBXi 935121 (939121): (192.168.5.214:47608)

3 FBVI 3061 (39061): (192.165.5.114:47608)

O FBVi 39077 (39077) : (192.166.5.130:47506)
(O FBVi 39164 (39164) : (192.168.5.116:47808)
O (Paulina) FBVi 39074 (33074) : (192.168.5.135:47
O (Chris) FBVi 39136 (39136) : (192.168.5.115:4730

&) (Chis) FBVi 35039 (39039) : (192.166.5.137:4780

O (Ronan) FBvi 39193 (39193) : (192.168.5.112:478
(O FBVi 39058 (39058) : (192.168.5.110:47808)

O (Ronan) FBVi 39162 (39162) : (192.168.5.134:478
O FBVi 39131934 (192_168_5_132) (39131) : (192

&) Unitron FEVI 39161 (39161): (192.168.5.133:476

O (Ronan) FBVi 391976 (39197) : [152.168.5.126:4
(O FBVi 18046 ftest) 3 (18046) : (192.168.5.127:478¢
O FBYi 33096 (39096) : (192.166.5.113:47808)

O (Paulina) FBVi 18025 (15025) : (192.168.5.109:47.

O (Chris) FBVI 39191 (39191 (192.166.5.16:4780

O (Vinit) FBvi 39195 (39195 :(192.168.5.125:4750¢
(O FBVi 39163 (47809) (39163) : (192.168.5.117:478(
O FBYi 35060 (35060) : (152.168.5.120:47808}

O FBVi 39089 9.3.4 (192.168.5.136) (39089 : (192.1

&3 (Ronan) FEvi 3912 (39192) : (192.168.5.122:476
7308

O Fevi 39122 (39122): (192.168.5
O (Ronan) FBVi 39059 (39059) : (192 111:478
O FBVi 39186 (39186) : (192,168.5.131:47808)

O Unitron FBVi 39030 (33030) : (192.168.5.138:478

) FETI.6T1-1UIR (302009): (182.168.5.154:47808)

Network: 506
O MATRIX-RTR (100} : (48)

Network: 503

O Cotsrs (749271) (749271): (1)

O ucs224 U4 (733254): 54)

O UC328 CU0B838078H (838078) : (78)
Metwork: 153

O UC323 CU0B833007H (833007 : (7)

- () UC3224 CU24809409) (809408) : )

O CET3T65R - (1143) (1123): (49)
O CBV-2U4-3T 905476 (905476} : (7€)
O UC32241C (818585) : (85)

O CBXi 939121 (939121) : (192.168.5.214:47808)
£ Device (&)
"y cenisezt
£ Analeg Value 2
@ Analog_setpoint 2
@ Analog_setpoint_3
£ Binary value (3)
W Digital_Sepoint_1
£ Calendar (61
£ File (10)
Iy FL¢ Firmware.
I Fusion Firmware
I strategy
Iy BACnet Data
CPro Commissioning File
Iy Application Firmware
Database
[ Notitication Class (15)
{5 MFG Debug (128)
{5 FLX Bus Configuration (450}
= Fusion Bus (467)
{5 Licence @69)
B Metwark Port (58)

Property

e
object-name (77)
object-type (79)
object-identifier (75)
present-value (35)
description (28)
status-flags (117)
event-state (36)
out-of-service (31)
wnits (117)
prictity-array (87)
relinquish-default (104)
current-command-priority (431)
time-delay (113)
notification-class (0-5) (17)
high-limit (45)
Tow-limit (59)
deadband (25)
limit-enable (52)
event-enable (35)
acked-transitions (0)
notify-type (72)
event-time-stamps (130)
cov-increment (22)
profile-name (168)
(AT) Auto-Clear Time to Live (49492)
(AP) Auto-Clear Priority (49423)
(AC) Auto-Clear Countdown (49475)
(5P) Save Priority Array Data Across Re.
event-detection-enable (353)
Current Command Priority (50000)
Overide in Effect (50001)
reliability (103)

[Property Count 33 /33

Value

Analog_setpoint 2
Analog Value

Analog Value (2}, Instance 1
0.000000

Unknown

normal

False
degrees_Celsius
NULL, NULL, NULL, NULL, NULL, NUL...
20.000000

o

0

0

0.000000
0.000000
0.000000

Alarm

01/01/0001 D0:00:00, 01/01/0001 00:00:.
0100000
Cylon-CBXi-D01

0

15

0

False

True

17.000000

False

No Fault Detected

The BBMD IP Address and Port used are displayed at the top of the BACnet Explorer window.
The discovered BACnet Devices are displayed on the left side of the window.

The user can select one of the BACnet Devices to read all BACnet Objects of that device. These are displayed in
the center of the window and are organized by Object type.

The user can select one of the BACnet Objects to read all BACnet Properties of that object. These are displayed
on the right side of the window. The BACnet Property values can be edited here.
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BACNET EXPLORER BBMD SETTINGS
The source of the BBMD Settings used by the BACnet Explorer depends on how the BACnet Explorer is launched:

e If launched from the Ribbon Bar or the root node of the Site List, it will use the System Level BBMD
Settings

e Iflaunched from a Site Node of the Site List, it will use the Site Level BBMD Settings. If BBMD is not
enabled at the Site level, it will attempt to use the System Level BBMD Settings.

e Iflaunched from a Router Node or a Device Node of the Site List, it will use the Router Level BBMD Settings.
If BBMD is not enabled at the Router level, it will attempt to use the Site Level BBMD Settings or Site
Level BBMD Settings.

DISCOVERY TOOL

The purpose of the Discovery Tool is to allow users to see all live BACnet devices, objects, and properties on
the network via CXprotP. It also allows some or all of the discovered objects to be added to an existing
Engineering Centre Site or allow a new Site to be created with the discovered objects.

For existing sites, this tool is used to compare the site configuration with the devices that are live on the
network. It is possible to change the present_value property of some objects.

BACNET EXPLORER

The Explorer is an extension of the Discovery Tool. It is available in CXproP by right-clicking on a BACnet Site
in the Site Tree and selecting Discover Site.

This opens the Site Discovery dialog, which is prefilled with the selected Site’s information:

Site Discovery

Please ensure the information is comect for the site you would like to discover.
For BACnet sites, ensure the Timeout value is large enough

r Ste Details
Metwork Type

Site Name IEasl Hall ' Serial Connection
SteDiectoy  [EASTHALL ¢ Uniron

£ BACret
Site Number |4 ¥ Femote Connection

 Uritron TCPAF
Address Range I = I‘”MSD2 & BACKetIP
Wait Timeout (s) |25
MSTP Network Nol

Discover I Cancel
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If the Discover Site option is selected from the context menu of the Site Tree’s root node,

x

A | aeal Mehaark

then the Site Discovery dialog will be blank and can be used to create a new Site.

Site Discovery
Enter the details of the site you would like to discover below. For BACnet Stes
with & large number of devices, please ensure the Timeout value is large
enough.
r Site Details
Metwork Type
Site Name || " Serial Connection
N " Uritran
Site Directory
I " BAChet
Site Number I * Remote Connection
Address Range |1 to [a194302 € Unitron TCP/IP
% BACnet IP
Wait Timeout (s) |25
MSTF Network No.l
Digcover Cancel

The Site Discovery dialog has the following fields:
Network Type
(If an existing Site is selected, this selection cannot be changed).

If a site is not selected, select a Network Type that will apply if you choose to create a site from the Explorer
during the current exploration:

e Network 1 for Serial and Modem Sites
e Network 2 for TCP/IP or BACnet Sites
Site Name
(If an existing Site is selected, this field will not be editable).

If a site is not selected, enter a new Site Name here. If you choose to create a site from the Explorer during
the current exploration, this is the name that will be used for it.

Site Directory

The Site Directory is automatically generated from the Site Name, but it can also be user-defined. Do not use
special characters in the Site Directory Name.

Site Number
(If an existing Site is selected, this field will not be editable).

If a site is not selected, specify a Site Number. If you choose to create a site from the Explorer during the
current exploration, this is the Site Number that will be used for it.
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Address Range

This can be used to limit the Discovery process. Only BACnet addresses within this range will be tested.
Wait Timeout (s)

This sets the length of time that the process will listen for I-Am responses during discovery.

Larger Sites require higher Wait Timeout(s) to explore the entire site (default 10 seconds)

Network

The user can choose a specific network to discover in this dialog box. If the user enters a network number,
only devices on that network will be displayed. Leave this blank if you want to show devices on all networks.

The Discover button will launch the progress dialog.

Below is the progress of the discovery process. Please wait until this is finished
before attempting to communicate with another site or press cancel to finish
the process early.

 Site Details Summary

Name I BACnetExplorer Online Devices 0
Number I 5 Current Device 0
Network I BACnet

i~ Controller Discovery

Calling Whols on Metwork. ..

I A=

Reading Device properties...

| [

Calling Whals on Metwork...

A Whols call is made, and then the system waits for the specified timeout (default is 10 seconds) after which
it reads the BACnet information for each Device that responded with an I-Am message. When this is
complete, the results dialog opens:

Cyion BACnet Explarel

 Site Details

Name I BACnetExplorer This is the BACnet Explorer dialog.
Number I L
Num. Devices I 9

[¥]$8 BACnetExplorer Name | mac | Def.Type | Types | Mode! | m | Vendor | Metwark | 1P Addr _
- Cylan BACnet Router - Chris (60 | CYlon BACnetRo... 1 CER 3 CylonBACnetR... 6000 171 0 192.168.6.78
H D i Object-List Unitron Slave UC... 1 UC32.248... 1 Unitron Virtual ... 1220 171 61000
Controller type U... 14  UC32.24B... 2 ucaa.24 1054 171 50000
Unitron Slave UC1(2) (1220 | Cylon BACnetRo... 2 CER 3 Cylon BACnetR... 49 171 a 192,168.6.40
Controller type UC32,24 (1¢ | Controller type U... 1 UC32.24B... 2 uc3a.24 6767 171 51
i Controller type U... 2 UCU12BAC. 2 ucu12 3752 171 51
2 [FS cyonBAChetRouter 8. (48) | CynBachetro... 3 CER 3 CylonBACnetR... 141077 171 0 192.168.6.35
163 Object-List 001-UC3224BA.. 1  UC32.24B... 2 uc32.24 141078 171 51
2 UCUL2BAC.. 2 ucuiz2 141079 171 51

[#]= Controller type UC32,24 (57 | 992~ CFT12
Controller type UCU12 (375
Cylon BACnet Router 49 (14107
16 Object-List

001 - UC3224 BACnet (1410
[¥]= 002 - cBT12 (141079)

T F——
I select all devices to add to Sit Rescan Network Add Selected Devices to Site Close

Number of devices found: @
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The results dialog contains two panels:
e Theleft panel contains a tree view list of the BACnet devices and objects discovered.
e Theright contains information regarding the selected device or object.

It is possible that not all devices would be discovered during the specified Wait Timeout(s)., so if necessary you
can re-scan the network for further devices by clicking the Rescan Network button. The Site Details dialog will
open again so that the settings for Address Range, Wait Timeout(s) and Network number can be adjusted. Devices
that have already been discovered will be skipped, so that further devices may be discovered even if none of
the settings are changed.

The tree view is similar to the existing site list in other applications. The site is the root node of the tree,
followed by the routers and then devices under those. Under the device nodes, there are other nodes in the
Object List. Expanding this will show each object read in from the parent device.

As an extension of the Site Discovery Tool, the Explorer allows devices to be added to the Site specified in the
top left corner of the CXproHP BACnet Explorer dialog (which may be an existing site or a new site that will be
created when devices are added).

To add devices to the selected site, check the box beside each required device in the Site Tree and click on
the Add Selected Devices to Site button. To quickly select all of the discovered devices check the Select all devices to
add to Site box beneath the Site Tree. Non-ABB Cylon® devices will be added as virtual controllers and have a
CXprotP address of 131 or above.

When the root of the tree view is selected, the right panel contains a list of the BACnet devices found, along
with: device name, MAC address, vendor ID, model name, IP or MSTP Address, Network, and estimated Controller Type.

ﬁﬁon BACnet Explore [P )

rSite Details ]
Name BACnet Explorer This is the BACnet Explorer dialog. Below is the list of devices that were discovered. To edit any of the details double dick on an
item in the list. To begin reading in the object list of a device expand its node in the Tree View.
Number 9 Any newly discovered devices will be in white. Devices that have already been configured will be highlighted in Green or Red.
Green means that the device discovered matches the addressing of the site configuration, Red means there has been a dash
Mum. Devices |8 between the device information discovered and the device information in the site configuration.
]
Name | MAC | Type | No. Types | Model | Instance | Vendor | Metw... | IP Addr
') Cylon BACRet Router 49 (3000) | Cylon BAChetRo... 1 CBR 6 Cylon BACnetR... 3000 171 515 192,168.6.4
. ; Controller type U... 4 CBT13VAY 1 ucuis 2221 171 515
s Object-ist Cylon BACnetRo... 3 CBR B Cylon BACnetR... 49 171 77 192.168.6.3
Controller type UCU13 (222 | Controller type U... 1 CaM24 1 uc32.24 141078 171 77
: Cylon BACnet Router 45 (43) UCU12CT12229... 2 CET12 1 ucuiz 141079 171 77
(@ Object-dist
Controller type UC32.24 (14
- UCU12 CT122290324 (1410
< m | LR n | +
¥ Select all devices to add to Sit= Rescan Metwork. | Add Selected Devices to Site I Close |
™ Sort Objects By Instance Number
Number of Devices found: & /4

There is also a column (No. Types) which shows the number of possible ABB Cylon® controller types this device
could be.

ABB Cylon® devices are initially set as a CBM24 controller type, but this can be changed in the Controller
Properties dialog. The ‘Type’ of a non-Cylon® device cannot be changed in the Controller Properties dialog, but if
they are added to the Site, they will appear as CBM24 in CXprotP, and this can be changed in the
Configuration utility (CCConfig).

To open the Controller Properties dialog, double-click on the device in the right-hand panel.
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—Controller Details

Name I Controller type UC3224
Model I UC32.24
Address I 1

Possble Types  [cBM24 ~|
Device Instance I 141078
MNumber

OK I

I —Controller Details

Narne I BASRT-B
Model I BASRT-B
Address I 4

Possible Types I 3rd Party ;I

Device Instance 1920
Number

OK I Cancel |

You can then change the Name, Type, Address, and Device Instance Number before adding them to the site.

Note: This will only change the name of the device in the database on the PC, it will not change the name on the
device itself.

When the device node of the tree is expanded or double-clicked, the object list of that device will be read in.
As each object is received from the device it will be added as a child to that device node. At this stage, the
right-hand panel will display the object list with a column for object ID, object type, object name, and present value
and this list will be populated as objects are read in.

"Cylon BACnet Explores

~Site Detai
— I—EACnetﬂdnrer This is the BACnet Explorer dialog.
Number 5
Num, Devices | 10
[¥] 55 BACnetExplorer » | ObjectName | Object0 [ Object Type [ value
[#]52. cylon BAChet Router - Chris| | | Uritren Siave UC1 (2) 1220 (8) Device 0.00
T 1.17 analog 17 (2) Analog Value  0.00
] object-List 1.18 analog 18 (2) Analog Value 0.0
=8| Unitron Slave UC (: 1.19 analog 13 {2) Analog Value  0.00
~ ] unitron Slaveuct (; | | 1-20analog 0 (2) Analog Value  0.00
1.21analog 21 (2) Analog Value  0.00
@ 1.17analg (17) 1.22 analog 2 (2) Analog Value  0.00
~[] @ 1.18 analog {18) 1.129 digital 129 (5) Binary Output ~ 0.00
1.130 digital 130 (5) Binary Output  0.00
1.13 analog (19}
os oo (19) 1,131 digital 131 {5) Binary Output 000
~[J@ 120zndog (20) |2 |1 132 digital 132 (5) Binary Output 0.0
] 1.21analog (21) 1,133 digital 133 (5) Binary Output  0.00
16 1222080 22 1134 digital 134 (5) Binary Output  0.00
[J@ 1.129 digital (129)
16 1130 digital (130)
-] @ 1.131digital (131)
I8 1132 digital (132)
-] @ 1.133 digital (133)
I 1.134digital (134)
~[¥] = controller type UC32.24
4[] @@ controller type UC3
+[] @ BACnet RTC Trendic
[ BAChetRTC Trendic
B [#]=2 cylon BACnet Router 49 (43]
16 object-List <
Ll Fe—T—| ’
I™ Select all devices to add to Site Rescan Network Add Selected Devices to Site I Close
Successfully read Object list from Device

When an object is selected in the tree view, the properties of that object will be read from the device and the
right-hand panel will contain the properties and values of that object.

From the results dialog, the user will be able to change the present value property for some of the objects.

Note: To refresh a specific object, right-click on that object.
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CHECK AGAINST EXISTING DEVICES

When using the BACnet Explorer on an existing site, any discovered devices must be checked against those
that have already been configured. This is done by comparing the Device Instance Number of each
discovered device against the Device Instance Number of any devices on the site configuration already.

For any discovered devices that have the same Device Instance Number as a device on the PC, there will be a
comparison made between the MAC address discovered and the CXprotP address.

e If these match, the device will be highlighted in the list in green to signify that the devices match. A
matching device cannot be edited.

e If they do not match, then the device in the list control will be highlighted in red to alert the user to this
mismatch. The user will be given a choice to resolve the mismatch

e If the Device Instance Number does not match any other ID on the PC, then this discovered device will not
be highlighted and will be left white. Non-matching devices can be edited.

CHANGING THE PRESENT_VALUE PROPERTY

The present value can only be written to commandable BACnet objects. Commandable objects always have
the ‘present_value’ property and two additional properties — Priority Array and Relinquish Default.

e Analog Output, Binary Output, and Multi-State Output objects are always commandable.

e Analog Value, Binary Value, and MultiState Value objects can be commandable, but this is decided by the
vendor.

To change the present value of a commandable object, double-click on the present value property in the right
panel. If the object has the required properties, this will open the Change Present Value Dialog:

Change Present Value Dial

Below is the Priority Array of the Pricrity | Value
selected object. To change a I ty I I
value, select the checkbox and O 1 MULL
enter the new value. Leave the D Z MULL
value blank or set to "™MULL" if
3 MULL
you would like to relinguish this 0
value. O 4  nmow
O s MULL
— Object Details E g :3::::
Device ID 1054
evice 5
Object Name |Analog O 9 nmo
O 1w mow
Object Instance I 10 O u NULL
Object Type | (DAndogoumpe || |0 12 nuw
O 13 now
Present Value I 12.57 O 14 MULL
15 12,567
16 2.5
Change Selected Valuss | Close |

The table on the right-hand side of this dialog shows the current priority array of the object. To change or
relinquish the value, you must select the checkbox beside the relevant priority index. By selecting the
checkbox, you can edit the value at that array. To relinquish that value, clear the contents in the box or set it
to “NuLL”.

When the Change Selected Values button is clicked, the value for any priorities whose checkbox is ticked will be
sent to the BACnet object. This will update the priority array on the device and to show this, the list items,
present value and priority array,in the Explorer dialog will be updated too.
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NB-PRO

NB-Pro is a generic commissioning environment for BACnet controllers. Using NB-Pro, users can setup and
configure devices to create control programs and strategies for building automation systems, including ABB
Cylon® BACnet. For details see MANO122 NB-Link & NB-Pro.

Note:  For NB-Pro to work with CXproHP, you must open the Settings menu NB-Pro and select Network Configuration. In
the Network Configuration dialog, select the Remote IP radio button in the Communicate Via: section so that NB-
Pro does not attach to the BACnet UDP port of the PC as this would block CXprotP. Also, register NB-Pro as
a foreign device on a CBR on the network by entering the CBR’s IP address in the Network Configuration dialog’s
BBMD Device field.
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Commissioning Controllers with CXproHP
HOW TO CONFIGURE A CONTROLLER’S BACNET SETTINGS

When a Field Controller is first commissioned, its address must be set by connecting CXprotP directly to the
controller by RS232 link (Service Port). If points on the controller are to be exposed on a BACnet network, or if
CXprotD is to communicate with the Field Controller by BACnet Tunneling, then the Field Controller's BACnet
address (Device Instance Number) must also be set.

These device settings, and others, can be set from CXproHP as follows:

Some parameters can be set over Ethernet connection, but Controller Address and Baud Rate can only be set
when the Engineering PC is connected to the controller by RS232 link.

In CXprofD, select BACnet Configuration from the Controller tab of the Ribbon

ime Contraller Strategy
J’ﬁCommunications |-4_'| Download E’élCo
ect IEController ’ﬁjWipe Controller EShu
% BACnet & Auto Online

Confignh?tion

n

This opens the BACnet Configuration dialog, which defines how the Controller will communicate on the BACnet
network, and how it will communicate with CXpro for configuration over BACnet.

In this dialog, each current value and the proposed new values can both be displayed at once. Defaults can
also be automatically generated.

BACnet Configuration ﬂ

Controller Config Mew
Controller [ 1 —
Device Instance [ esem —
Device Name coi.oot.cem24 [[
Site [ 4
Comms Ctrl I | 1 ’—
MS/TP Max Masters ’7
APDU Timeout —
MS/TP Baud Rate -

Use Config Values
'Rea ding from controller...
Close

Only Device Name, Router Address, and MSTP Max Masters will be editable when the Engineering PC is connected
over Ethernet. In order to edit the other parameters, it must be connected by RS232 serial link.
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The parameters that define how the Controller communicates on the BACnet system are:

Device Instance
Enter the required BACnet address (0 —4194303).

The number set here in the Field Controller (when connected serially) must match the Device Instance
Number set in CXprotD.

Device Name
Any descriptive text.

Tunneling Properties: Site and Comms Ctrl

All of the ABB Cylon® controllers throughout the BACnet system must have the same CXprofP “Site
Number”.

In the Device Properties dialog set the Site and Comms Ctrl matching the position of this Controller in the Site
defined in CXprotP.

MSTP Max Masters

This must be equal to or greater than the highest address used on the BACnet MS/TP fieldbus, because this
controller will not pass data to devices with addresses higher than this. The optimum situation is that this
value is set in all devices to exactly the value of the highest address on the fieldbus. (1 - 127)

It is recommended that you address your controllers consecutively starting at 1, with the MAX Master value
matching the Maximum Controller address value. For optimum efficiency, there should be no gaps in the device
addresses.

APDU Timeout
(0 ... 60 seconds) this value should be left at its default unless there is a problem.
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COMMISSIONING A RANGE OF CONTROLLERS QUICKLY (Mass COMMISSIONING)

CXprotP includes a utility to quickly commission the MAC, Max Masters, Device IDs and Names of ABB Cylon®
controllers.

This utility is available through either the Commission MS/TP Devices and the Commission MS/TP Network options.
The IP device option is only available at the Site level, and configures only CBXi, FBXi and FBVi controllers.

To open the BACnet comissioning utility, right-click on a Site or a Router in the Site List:

Site List L < MR 001_02.:532 Site List r B |4 001_02.532
2 &Y Sites B @) Sites

i ) ) i Zo 10020801

2o BACnet P

20 BACnet Serial
JE.E Campus block R
Zo PL Office

Zo BACnet Serial
JE.E Campus block R
o

Discover Site Netwo

Backup Site Export ASPECT/INTEGRA Data
Update BACnet EDE Data

Export ASPECT/INTEGRA Data

Comn-li'sion BACnet Devices

T Al -

Create BACnet EDE Data

Cnl'nmission BACnet Devices

N .

The devices must be configured within CXproP before they can be accessed by this utility.

For IP comissioning (i.e. if the Commission BACnet Devices dialog was opened with the Commission IP Devices
option), then in order for controller parameters to be editable, discovered devices must first be associated
with configured devices as described in How to Associate devices on page 228.

If launched from a router, only the devices on that subnet will be pinged. If launched from the site, all devices
on the site will be pinged.

Commission BACnet Devices

AJ_I Devices Serial Mumber ‘ Metwark | MAC Device ins... ‘ Mame ‘ Max Masters | Strateay Type
- CBV US - Integral Actuator CX16744168C 515 1 4000 CBX Chris Desk 50 CBV US - Integral Actuator
CU12142008F 515 30 3001 CBM desk test 127 Strategy ID: O

—Offline / Misconfigured Devices
Serial Mumber | Metwark | MAC Instance (PC) | Instance (Ctrl) | Name | Type (PC) | Type (Ctrl) ‘ Strategy Type | Izsues
515 3 001-003-CB... (CBMO3 Strategy ID: 0 Offiine
515 2 001-002 - CBX... CEX-8R3 Strategy ID: 0 Offiine
< >
Reconcile Issues |

Rescan | Timeout (s) |5 Close |
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When pinging is complete, the Commission BACnet Devices dialog is displayed:

Commission BACnet Devices

All Devices Serial Number | Network | MAC | Device ins... | Name | Max Masters | strategy Type
CU12142008F 515 30 3001 CBM desk test 127 Strategy ID: 0
Apply |
—Offiine [/ Misconfigured Devices
Serial Mumber Network | MAC Instance (PC) ‘ Instance (Ctrl) | MName | Type (FC) | Type (Ctrl) | Strategy Type ‘ Issues
515 3 3443 001-003-CB... (CEBMO8 Strategy ID: 0 Offline
515 2 4000 001-002-CBX... CBX-8R3 Strategy ID: 0 Offline
Device instance does not
€ >
Recondle Issues |

Rescan I Timeout (s) |5 Close |

The upper-right pane of the Commission BACnet Devices dialog lists all of the devices configured in the CXproP
Site that have been successfully discovered on the BACnet network.

The lower pane of the Commission BACnet Devices dialog lists devices that are configured in the CXprofP Site but
have not been successfully identified on the BACnet network. Devices that partially match the CXprotP Site
configuration are highlighted in red — for example, a device has been found that matches the MS/TP Network
Number and MAC Address of a configured device, but the Device Instance Number does not match.

If you want any of the devices highlighted in red to be included in the Commissioning process, tick the
checkbox to the right of red highlight. When all such devices have been selected, click the Reconcile Issues
button.

The configuration of the device in the CXprotP Site will be updated to match the corresponding discovered
device, and the device listing will move to the top-right pane:

Commission BACnet Devices
Al Devices Serial Number | Network | MAC | Deviceins... | Name | Max Masters | strategy Type
- CBY US - Integral Actuator CX16744168C 515 1 4000 CEX Chris Desk 50 CEV UUS - Integral Actuator
CU12142008F 515 30 3001 CBM desk test 127 Strategy ID: 0
—Offline / Misconfigured Devices
Serial Number Network ‘ MAC Instance (PC) | Instance (Ctrl) | MName | Type (FC) | Type (Ctrl) | Strategy Type | Issues
515 3 3443 001-003-CB... CBMO8 Strategy ID: 0 Offline
515 2 i 001-002-CBX... CBX-8R8 Strategy ID: 0 Offfine
< >
Recondile Issues |
Rescan | Timeout (s) |5 Close |

If reconciling might create duplicate IDs, the conflicting offline devices are renumbered to a value above
4000000 to ensure that they will be unique.

If no match is found for the MS/TP Network Number and MAC Address of a configured device, that device is
listed in the lower pane as offline, marked with a grey background and cannot be included in the Reconcile
Issues process.

To retry pinging offline devices, click the Rescan button on the bottom left of the dialog.
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The upper-left pane of the Commission BACnet Devices dialog shows categorized devices found organized by
strategy ID.

E L IRRTE T E TR T SR LN S

.':. M
Dhual Chuct VAV 12

Fan Cod =

RTU 12

1

This groups devices by the type of strategy they contain (e.g. single or dual duct VAV, or RTUs, Fancoils, etc),
so that common properties can be edited together.

Clicking on All devices will show only the properties that are common to all devices of MAC, Max Masters, Device
ID, Name, Serial Number, and strategy Type.

Clicking on a strategy type in the left-hand pane means that additional parameters common to that strategy
type will become available in the right-hand pane:

Seral Numbar MAC Max Masters Device ID Name Type Input Corfig Output Config
123456 1 127 12341 VAVST386 137 43 18
12345672 2 127 12342 VAVST388 137 43 18
12345673 3 127 12343 VAVST3%0 137 48 18
12345674 4 127 12244 VAVST392 137 43 18
12345675 5 127 12245 VAVST394 137 43 18
12345676 6 7 12348 VAVST3%6 137 43 18

Each of the fields can be edited individually.

However, it is also possible to copy a single value to multiple controllers at once, so that device types that are
installed identically - for example, VAVs — can be configured in bulk very quickly (similar to copy & pasteina
spreadsheet program).

When appropriate, editing a single field will be assisted by a properties window that indicates what the
setting value will mean:

Serial Mumber MAC Max Masters Device |0 MName Type Input Con Output Corfig
! 12345671 1 127 12341 VAVST386 137 48 18

12345672 2z 127 12342 VAVST™™" T - .
12945673 3 197 12343 yavg] VA 86 Config Properties
12345674 4 127 12344 VAVST Awillary heat True
12345675 5 127 12345 VAVST Control Method ~ Standard
12345676 3 7 12346 VAVST

Control Method

This is the control sequence applied to this

VAV

Apply Cancel

When all of the fields have been configured, click the Apply button, and the full set of edited parameters will
be sent to all controllers. A progress dialog will be displayed, indicating progress and highlighting any

failures:
Progress
Serial N MAC Max Masters Device ID Name Progress
12345671 1 127 12341 VAVST386 Complete
12345672 2 127 12342 VAVST388 Controller write failure.
12345673 3 127 12343 VAVST330 Complete
12345674 4 127 12344 VAVST332 In Progress
12345675 5§ 127 12345 VAVST334
12345676 6 7 12346 VAVST396
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NTP Time sync enable/disable

To enable or disable NTP Time Synchronization on an IP Controller, right-click on the controller in the Site Tree,
and select Commission IP Devices from the context menu:

Site List A |« 00
B Sites

2q BACnet P

25 BACnet Serial

QL pm
25
E

Discover Site

Backup Site

Batch Download
Batch Upload
Batch Upload Setpoint Values

Upgrade Firmuare
Upgrade Sensors to Fusion Air

Export ASPECT/INTEGRA Data
Create BACnet EDE Data

Commission IP Devices

ommission etworl

Configure IP BACnet Device Properties

BACnet Explorer - Network
In the Commission BACnet Devices dialog, set NTP Enable to true or false as required.

Commission BACnet Devices (=] X

All Gevices If the CXproHD name and the controller name do not match: © UssCxproMDName % Use Uploaded Contraller Name
Serial Number Version 1P Address Port Device ins... | CXproHD Name Uploaded Name: Desaiption Location NTP En. Strategy Type

[FBXi915023c 9.3.5 192.158.6.25 47308 915023 FBXi 915023 FEXi 915023 es rma—| Strategy ID: 123

e L |

Port status change

To configure the RS-485 Ports on an IP Controller, right-click on the controller in the Site Tree, and select
Configure IP BACnet Device Properties from the context menu:

Site List - 4 001

i E o Sit
5 | iscover Site
=8 Backup Site
& Batch Download
£ on Batch Upload
2o Ser Batch Upload Setpoint Values

Upgrede Firmuware
Upgrade Sensors to Fusion Air

Export ASPECT/INTEGRA Data
Create BACnet EDE Data

Commission IP Devices

Commission MS/TP Netwark

I Configure IP BAChet Device Properties I

BACnet Explorer - Network

This will open the Configure IP devices dialog, where the current port status is displayed in the Port Configuration column.

Configure IP Devices o x

If the CXproHD name and the controller name do not match: £ Use CiproHD Name %' Use Uploaded Controller Name: ShoHide Colurrs |
SerialNumber | Version | MAC [ Hostname | P Netork | DHCP | 1P Address [ UDPPort | subnetMask | [ Primary DNS | Secondary.... | Port Configuration Device ins.... | Description i
FEXi915023c 9.3.5 0 1c:57:f... 500 false bt 47808 0 1921 8.8.8.0 4444 { TP, 76800,5021, 12 Hon, 76800, 553] | 915023 Test I

Rescan | Timeout () |5 Close
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Clicking on the Port Configuration column will open a dialog allowing the Port Type, Baud Rate, and Network Number
to be configured for all IP Devices.

Serial Port Configuration

Serial Number
915023

Port 2 Baud Rate | Port 2 Network No.
502 MNone 76300 503

FBXi 915023

115200

cares

MS/TP Address change

To change the MS/TP Address of an MS/TP device, right-click on the device in the Site Tree, and select
Commission MS/TP Network from the context menu:

Site List o g |4 001,
B--@ Sites

i-8o BACnet IP
5 BACnet Serial

10 i
) % Discover Site
i B Backup Site

Batch Download

2o 0N Batch Upload
2o Sen Batch Upload Setpoint Values

Upgrade Firmware
Upgrade Sensors to Fusion Air

Export ASPECT/INTEGRA Data
Create BACnet EDE Data

I Commission M5/TP Network I I

Configure IP BACnet Device Properties

This will open the Commission BACnet devices dialog.

Enter the MS/TP Address in the MAC column.

Commission BACnet Devices a x

All Devices If the CXproHD name and the controller name do not match: " Use CXproHDName % Use Uploaded Controller Name

| serial Number | version | Metwork | MAC | Deviceins... | CxproHD Name | Uploaded Name | Description | Location Max Masters | Baud | strats

CX16744168C CBX 9.3.5... 6000 ... Plant Contraller Location not se... 125 38400 (5)
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Baud rate change

To change the Baud Rate of an MS/TP device, right-click on the device in the Site Tree, and select Commission
MS/TP Network from the context menu:

Site List g3 |« 001

- Sites

S5 BAChet P

Discover Site

Backup Site

Batch Downlead
Batch Upload
Batch Upload Setpoint Values

Upgrade Firmware
Upgrade Sensors to Fusion Air

Export ASPECT/INTEGRA Data
Create BACnet EDE Data

I Commission MS/TP Metwork l\ I

Configure IP BACnet Device Properties

This will open the Commission BACnet devices dialog.

Select the Baud rate in the Baud column.

Commission BACnet Devices [m] X
AllDevices If the CXproHD name and the controller name do not match: " Use CXproHD Name & Use Uploaded Controller Name
Serial Number | Version Network | MAC | Device ins... | CoroHD Name | Uploaded Name | Description Location Max Masters | Baud Strate

CX16744168C Cl 5. 6000 16 L. 1 Plant Controller Location notse... 125
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CONFIGURE A SINGLE CONTROLLER

In addition to Mass Commissioning, it is possible to configure an individual controller without re-running. This
can be useful if for example a mistake was made on a few controllers during Mass Commissioning, or if
circumstances change and a small number of controllers must be changed.

To commission a specific controller, right-click on it in the Site Tree, and select Configure this Controller.

CXprotP attempts to communicate with the controller, find its serial number and read its strategy ID. If
CXprotP cannot communicate with the controller, a warning will be displayed and the dialog will close.
Otherwise, CXproHP will show a Config Properties dialog:

VAVST386 Config Properties

Auillary heat True
Cortrol Method ~ Standard

Control Method

This is the control sequence applied to this
VAV

When the properties are set, click the Apply button to send the configuration and close the dialog.

Note: If strategy ID is not known, only device name, ID, and a few other properties are editable. e.g. for IP Device:

Commission Device
Serial Number | Version IP Address | Port Device ins... | Name | Desaription Location Strategy Type I
FBX915023C  8.3.0-a10  192.168.6.25 47808 915023 FBX 915023 Not Set Not Set Strategy ID: 0
Apply I Cose

If strategy ID is known, user can edit the configuration point values in the same way as for mass
commissioning. e.g. for MS/TP Device:

Commission Device

Serial Number ‘ Version ‘ Network ‘ MAC | Device ins... | Name ‘ Description ‘ Location ‘ Max Masters | Strategy Type ‘ Input Heating ‘ Cooling ‘
CX16744168C CBx 8.0.1... 502 8 6000 502 -001-CBX... PlantController Locationnotse... 127 CBT14Rooftop US Strategy 0 H

oo |
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CONFIGURE IP BACNET DEVICE PROPERTIES

CXprotP includes a utility to quickly configure BACnet properties for IP devices. To launch this utility, right-
click on a Site in the Site List and select Configure IP BACnet Device Properities

S,

S LB
B-Zo Des Discover Site
% Backup Site
5-Fo daf
[ Export ASPECT/INTEGRA Data
| Create BACnet EDE Data

o

! Eln
2

Commission IP Devices
Commission M5/TP Metwork

sHIM 3 2

=z

Cenfigure IP BACnet Device Properties

Eln II;II:I b
8

Edit Controllers
Delete Site

K
£

Properties

#
=0
o
=
m

The utility will scan for all CBXi, FBXi and FBVi devices on the selected network.
Note: The devices must be configured within CXproH? before they can be accessed by this utility.

When scanning is complete, the Associate IP Devices dialog will open:

Associate IP Devices

[~ Site Device:

- Discovered Devices

Serial Number | Version | MAC Hostname | IPNet... | IP Address | UDP Port | Device ins... | Name | Description | Location Mame [ Devic... [Type [ Associated
CEXi915023C 83010 OcicS7if. CBN91S02.. 500 192,166,625 47808 915023 CBXIS15023  NetSet Not Set CBXiS15023 915023 CBX false

003 - Network 45785  FBXi-X256 false
004 -FBVI-2U4... 12545 FBVi-2.. false

Assaciate
- Assodiated Devi
Serial Number | Version | MAC Hostname | IPNet... | IP Address | UDP Port | Device ins... | Name | Description | Location [ Associated ]
There are no items to show in this view.
Delete Assaciation
Rescan | Timeout (s) [ 10 cancel

The Site Devices panel on the right lists all of the relevant IP devices configured in the CXproHP Site that have
been successfully discovered on the BACnet network.

The Discovered Devices panel on the top left lists all of the relevant devices that have been discovered on the
network

The Associated Devices panel on the bottom left lists any Discovered Device that has been associated with a
configured Site Device.

HOW TO ASSOCIATE DEVICES

To associate a Discovered Device with a Site Device, select a device in the Site Devices list and a device in the
Discovered Devices list and click the Associate button. Alternatively, you can drag the Site Device and drop it over
a Discovered Device.

Once this is done, the discovered device is moved to the Associated Devices list. The device on the Site PC is
updated with the Device Instance of the physical devices.

The MAC address will be stored in the site configuration as the key, so associations are maintained if the tool
is run again.
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Associate P Devices

- Discovered D

Delete Association

~Site D
Serial Number | Version | MAC [ Hostmame [ 1PMet... | 1P Address | UDPPort | Devieins... | Name [ Desaription [ Location ]
003 -Network 45785  FEXiX256 false
004-FBVI2UM.. 12545 FEVi2.. false
There are no items to show in this view.
Assoriate
4D
Serlal Number [ Version | MAC [ Hostname [ 1PMet... | 1P Address | UDPPort | Deviceins... | Name [ Desaiption | Location [ Assodated ]
CBNS1S023C  B.3.0HI0 OcilaS7f.. CBXS1S02.. S00 192.168.6.25 47808 915023 CBXIS15023  NotSet Not Set CBXi915023

Rescan | Tmeout (5) [ 10
==

Cancel

When all required devices have been associated, click OK to open the Configure IP device dialog where the IP

Properties of Associated devices can be edited.

Configure IP Devices

[m} X

Serial Number | version MAC [ Hostname | 1P Network | DHCP [ 1P Address UDP.... | SubnetMask | D Primary NS | Secondary... | Device ... | Name Desaription Location [ strategy Type
CBNSIS023C 830410  0claS7f. CEXS1S02. 500 T D 192166625 47808 2552552550 1921686253 0.0.0.0 0.00.0 915023 caxi 915023 Not set Not set Strategy ID: 0
< >
~Offine D

Name Type | Network | Device instance

003 - Network N5 3 785

004 - FBVI-24-4T FBV-2UAAT 4 12545

Rescan | Timeout(s) [10

Close

The list on the bottom shows the unassociated or offline devices.

When the properties are set as required, click Apply to send the changes to that controller.

©ABB 2025 All Rights Reserved.
Subject to change without notice
SOLUTIONS.ABB/HVAC-BUILDING-AUTOMATION

229

MANO133 rev 29


https://solutions.abb/HVAC-Building-Automation

ABB CYLON CONTROLS

Clonshaugh Business & Technology
Park

Clonshaugh

Dublin 17

Ireland

Tel.: +3531245 0500
Fax: +3531245 0501
Email: info@cylon.com

©ABB 2025 All Rights Reserved.
Subject to change without notice



	1  ABB Cylon® Building Management System
	Hardware Components
	Routers
	I/O Field Controllers
	PC
	Connections between hardware components

	Software Components
	CXproᴴᴰ modules

	CXproᴴᴰ – Overview

	2  Basic tasks
	Starting CXproᴴᴰ
	The CXproᴴᴰ Interface
	The Ribbon
	The Quick Access toolbar

	Connecting to a Field Controller
	Opening Strategy files
	Navigating a multi-page strategy
	Labeling the pages within a strategy drawing

	Finding an element in a strategy
	Zooming and Navigating the drawing area
	Changing the display
	Modifying the Drawing Area (Grid settings)
	Modifying display colour settings
	Saving Files
	Saving a new file
	Saving changes to an existing file
	Saving more than one file

	Printing
	Including a footer in a printed strategy
	How to edit the footer that will appear with the strategy when it is printed:

	Altering the print set-up
	Printing a file
	Changing the size of a Printout
	Fitting a Strategy to a page size when printing.

	Closing files

	3  System Configuration
	System Configuration definitions
	What is meant by “System” during configuration?
	What is a “Site”?
	What is meant by “Network”?

	Configuring Sites
	Defining the contents of a site
	Site Properties / Add Site Dialogs : Site Information section
	❖ Name
	❖ Directory

	Site Properties / Add Site Dialogs: Selecting the Network for connection to a site (Type of Connection)
	❖ Serial Connection (RS232)
	❖ BACnet IP

	Editing the number and names of controllers on a site
	❖ Adding Networks to a Site
	❖ Adding Field Controllers to a Site
	❖ Editing Controller information
	❖ FLX I/O modules
	❖ Modbus devices
	Configuring the FBXi, CBX or CBXi’s Modbus RTU port
	Adding and Removing Modbus Devices
	Accessing Modbus points in the Strategy

	❖ Removing a Controller from a Site
	❖ Adding Multiple Controllers
	❖ Sorting the Controller List
	❖ Saving the changes made in the Edit Controllers dialog



	Configuring Serial Port Connection
	Configuring Strategy Defaults
	Configuring BACnet Communications
	Configuring BBMD
	What is BBMD?
	How a BBMD operates
	Setting a BBMD in CXproᴴᴰ
	BBMD Parameters
	❖ System-level BBMD parameters
	❖ Site-level BBMD parameters
	❖ Network-level BBMD parameters



	Configuring Site CommunicatIons (Commands)
	Command Settings
	Profiles:
	❖ TCP/IP Profile:
	❖ Default Profile:



	4  Using Modules
	Modules - Overview
	Accessing Modules
	Placing a module on the drawing area
	Selecting modules on the drawing area
	To select more than one module on the drawing area:

	Move, Delete, Cut or Copy a module or modules on the Strategy drawing area
	Moving modules
	Deleting modules
	Copying modules on the drawing area

	Tool Tip Data on Modules

	Joining modules in a strategy
	Notes on joining modules
	Module connection points
	How to join modules
	How connections are represented
	Move existing lines
	Connectors
	Add a Source Connector
	Adding a Destination Connector
	Deleting Connectors
	Quick Searching for Connectors
	Jumping from a Destination Connector
	Jumping from a Source Connector

	Convert Lines to Connectors

	Viewing Point properties
	Viewing BACnet properties
	Viewing Module BACnet Properties
	Viewing Device BACnet Properties


	How to add text to a strategy
	How to change text that has been added to the strategy drawing

	Virtual modules
	Placing Virtual modules on the drawing area
	Rules for connecting to virtual modules
	Numbering virtual modules
	Virtual modules in macros


	5  Points and Point Values
	What are points?
	What are blocks?
	Block Numbers
	Point Numbers
	Defining hardware points
	How to define hardware points
	Defining Hardware points – Target the controller
	Defining Hardware points - Place the module on the drawing area
	Expandable I/O – Hardware Points on CBX + FLX devices

	Defining Hardware points - Save the hardware point definition
	Connect to the controller
	Download the hardware point definition.

	Summary of procedure for defining hardware points
	Point numbers for inputs and outputs
	A short cut to defining hardware points

	What are UniPuts™?
	Configuring the Field Controller’s Inputs and Outputs
	How to open the "I/O Terminals" dialog.
	Changing the configuration of a UniPut™ or Universal Input
	Example: Configuring Analog Input module properties
	General Information
	Constants
	Outputs


	Viewing used blocks
	Viewing the list of blocks
	Viewing the blocks associated with each point


	Keeping CXproᴴᴰ and Controller strategies in Sync
	Strategy Compare
	Compare Process

	Strategy Synchronization
	When a module properties are edited:
	When a strategy is closed following a partial download:
	When Scan Mode is enabled


	Reading Live point values (LiveLog)
	Configuring Live Log
	Running LiveLog
	LiveLog - Scanning Definition
	Strategy Target
	Scanning definition
	Override Status


	Manually Overriding Point Values - the Override Point dialog
	Overriding points
	Using the Override Point dialog:

	How to Enable a hardware point value (remove manual override status)
	How to change the value of a Setpoint
	Manually Changing a Multi-state Value

	6  Creating Strategies
	What is a strategy?
	An example of a strategy
	The Problem
	The Solution
	The Strategy

	How to Create a Strategy
	Place all the required modules on the drawing area and join them
	Automatic point selection
	Selecting a connection line
	Naming a point
	Assigning a unit to a point

	Creating Strategies - Set the values of the module's Constants
	Creating Strategies - Add explanatory text if necessary

	How to reorder blocks in a Strategy
	How to Upload Setpoint Values
	Naming strategy Files
	How to open an existing strategy:
	Strategy Associations
	What is an "Associated" Strategy?
	Creating Associations
	New strategies
	Existing strategies - manual

	Breaking Associations
	Copying associated strategies
	Importing a Strategy

	Opening multiple strategies
	Downloading a strategy
	Open the strategy and connect to the controller
	Download the strategy
	Wipe the controller's memory
	How to check the controller type to which you are downloading

	Edit the strategy
	Download the strategy

	Starting a strategy (sending the Setup)
	The effects of sending the setup

	Testing a strategy with Scan Mode
	Preparing to test a strategy
	How to test a strategy
	How to Display the strategy's point and constant values
	Setting the Scan mode
	Activate scan mode

	Suggestions for testing strategies

	Securing CBM data
	How to password-protect a range of blocks in a CBM strategy
	How to access locked strategy blocks

	How to expose Points on a BACnet system
	How to View BACnet points from A Controller

	7  Naming Objects
	Why objects are named
	Rules for naming objects
	Procedures for naming objects
	Naming Points
	Types of point
	How to name points

	Naming Field Controller time schedules
	How to name a Field Controller time schedule

	Naming datalogs
	How to name a datalog


	8  Using Macros
	Macros - Overview
	Macros and Macro Templates

	Macro structure
	Macro Description (Help) Files
	How to Create a Macro Template
	Create the strategy
	Select the modules for the macro
	Add the selected modules to the Macro Template
	Define the Macro Inputs, Outputs, Group and Name (the Create Macro dialog box)
	Define the inputs and outputs for the macro
	Change input or output label if necessary
	Name and group the Macro
	Macro Name
	Macro Group and Sub-Group

	Set names for all points in the Macro

	Choose whether to insert the macro into the active strategy
	Save the Macro Template

	How to create a new macro group and sub-group
	How to rename points in a Macro Template
	How to Set Macro Setpoint Unit LaBels
	How to transfer macros from one computer to another
	Export macros from the PC on which they were created
	Add exported Macros to the host PC system

	Working with Macros
	How to insert a macro into a strategy
	How to view the modules in a macro ("Expanding" a macro)
	How to Edit a Macro


	9  Communicating with Controllers
	Communicating with ABB Cylon® Controllers
	Sending information to a Field Controller
	Wiping a Field Controller's memory
	The effect of wiping a Field Controller’s memory

	Sending the setup to a Field Controller

	Getting Controller Information
	How to get the Controller version
	How to get the controller setup
	How to get controller statistics
	Engineering statistics tab
	System statistics tab
	Serial Port Statistics tab

	How to get Field Controller Diagnostic information
	How to get Field Controller Configuration information

	How to set the Controller Time and Date
	Changing the address of a controller (CBM only)

	10  Datalogs and Alarms
	Datalogs
	The datalog function module
	Restrictions on the use of datalogs
	Standard Datalog sampling period
	Time Stamped Datalogs
	Datalog sampling of digital and analog point values
	How to define a datalog
	Name
	Analog input
	Enable
	Log Trigger
	Digital input
	Datalog Number
	Update Interval
	Delta

	Starting a datalog
	Viewing the contents of a datalog

	Alarms
	Starting alarms
	Examples of Strategies containing alarms
	Alarms - Example 1: Pump Trip Switch
	Alarms - Example 2: Pump Trip Switch with delay
	Alarms - Example 3: Room Temperature Input



	11  Simulation Mode
	Introduction
	Configuring the Simulation
	The Simulation Cycle
	Simulation speed
	Display Progress As:

	Current simulation configuration
	Start time/date:


	Running a Simulation
	Livelog

	Point properties
	Accessing the points properties
	Lines
	Hardware I/O modules
	Connected nodes

	Point value override
	Analog points:
	Digital Points:

	Input point options
	Digital Input point options
	Fixed value
	Periodic change

	Analog Input point options:
	None
	Fixed
	Random value
	Up (down) only
	Up (down) only with limit
	Up and down
	Values from file



	Point logging

	12  Sites
	Overview
	Installing a new site on the PC
	What happens when a new site is installed
	How a new site is installed on the PC
	Site backup
	Making a site backup
	Restoring a Site from a backup file

	Site Discovery
	If the Site is not yet configured in the Site Tree
	If the Site is already configured in the Site Tree

	Full Upload and Download
	Download
	Upload
	SMART Router Controller Replacement (web page)
	Devices List
	Accessing a controller manually
	2) Backup From Device


	Batch Upload and Download
	Batch Download
	Batch Upload
	Batch upload of set points

	Viewing the Audit log
	Firmware Upgrade
	Upgrade Sensors to Fusion Air
	ASPECT® / INTEGRA™ Export
	Starting the Export
	Import into ASPECT®-Studio and INTEGRA™-ProPack
	Launching CXproHD from INTEGRA™-ProPack


	AeroCT Configuration
	Setpoints To Configure
	Tuning Graphs


	13  Appendix :: Configuring Units of Measurement and State Strings
	Adding units of measurement
	How to add units of measurement to the system
	Example of adding units to analog units list

	Configuring State Text strings

	14  Appendix :: File Management
	File Management in CXproᴴᴰ

	15  Appendix :: BACnet Explorers
	Integrated bacnet explorer
	BACnet Explorer BBMD Settings

	Discovery Tool
	BACnet Explorer
	Network Type
	Site Name
	Site Directory
	Site Number
	Address Range
	Wait Timeout (s)
	Network

	Check Against Existing Devices
	Changing the Present_Value Property

	NB-Pro

	16  Commissioning Controllers with CXproᴴᴰ
	How to Configure a Controller’s BACnet settings
	Device Instance
	Device Name
	Tunneling Properties: Site and Comms Ctrl
	MSTP Max Masters
	APDU Timeout

	Commissioning a range of controllers quickly (Mass Commissioning)
	NTP Time sync enable/disable
	Port status change
	MS/TP Address change
	Baud rate change
	Configure a single controller

	Configure IP BACnet Device Properties
	How to Associate devices



